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БЛАГОДАРНОСТИ

Приступая к написанию благодарностей, я окончательно оценил для себя недостатки работы автора: никогда 
не остается времени, чтобы поблагодарить всех тех, кого хотелось бы.
Прежде всего, я хочу поблагодарить свою восхитительную жену Калебру. Немногим из нас удается встре-

тить человека, который бы вдохновлял, вселял надежду и с которым, в конце концов, было бы приятно находить-
ся рядом. Калебра - именно такой человек. Она мой лучший друг, советчик, руководитель и деловой партнер. 
Однако и это еще не все: Калебра - лучшая в мире мама, ее прекрасные качества нашли отражение в нашем сыне 
Джордане. Она даже не представляет, насколько мы с сыном ценим ее.

Я хочу поблагодарить своего соавтора, Терри Уайта, за то, что он согласился написать вместе со мной книгу. 
Терри знает об InDesign больше, чем любой другой известный мне человек, поэтому именно его я хотел видеть в 
роли соавтора настоящей книги. Однако Терри - не просто эксперт по InDesign. Он очень талантливый человек, 
полностью посвящающий себя делу, которым занимается, поэтому я горжусь тем, что мне довелось работать 
вместе с ним,

Также следует поблагодарить свою «домашнюю команду» из KW Media Group, которая постоянно оказы-
вала мне поддержку. В частности, я хочу выразить благодарность творческому директору Феликсу Нельсону; 
редактору Ричарду Териолю; техническим редакторам Крису Мейну и Полли Райншельд, а также выпускающему 
редактору Ким Гебриэл. Отдельное спасибо Барбаре Томпсон, Дейву Кормену, Дафне Дерки и Дейву Дамстре. 
Благодарю всех их за ту неоценимую помощь, которую они оказали за все время работы над настоящим про-
ектом. Я также хочу поблагодарить своих хороших друзей и деловых партнеров Джима Уэркмена и Джин А. 
Кендра, моего брата Джеффа за все, что он сделал, а также за то, что он - важная часть моей жизни. Спасибо 
и тренеру Джо Гиббсу - он снова начал тренировать команду Реаэйпз, которая после этого стала играть намного 
лучше. Отдельной благодарности заслуживает Кэти Сайлер за тысячу мелочей, которые она для меня сделала, 
тем самым значительно упростив мою жизнь.

Большое спасибо Стиву Вайсу, Ненси Руензел, Скотту Коулину, Ким Ломбарди, Гари Полу Принсу, а также 
всем сотрудникам издательства Peachpit за их помощь, а также за то, что позволили мне написать книги из серии 
Voices That Matter.

И, конечно же, спасибо Богу и его сыну Иисусу Христу, что всегда слышали мои молитвы, а также за то, что 
благословили меня и мою семью, которую я безгранично люблю.
— Скотт Келби

Мне бы никогда не удалось принять участие в работе над подобным проектом, если бы ни помощь друзей, 
семьи и сотрудников. Поскольку для того чтобы поблагодарить всех тех, кто этого заслуживает, не хватит и 

всей книги, прежде всего следует сказать спасибо своей жене Карле, которая поддерживает меня во всех начи-
нания; моим двум дочерям Айле и Сале; моей сестре Пэм, которая всегда помогает мне решать всевозможные 
проблемы, и, конечно же, моим родителям.

Я также хочу поблагодарить всех своих друзей, менеджеров и сотрудников из компании Adobe, в том чис-
ле Сью Шчин, Линн Грилло, Адама Пратта, Майка Ричмэна, Колита Смита, Стива Уотли, Ною Иделл, Ашивини 
Джамботкар, Гари Косимини, Лайзу Форрестер, Тима Коула, Джиллиану Кост, Райя Ливингстона, Диану Олсон, 
Пегги Снайдер, Рассела Престона Брауна, Дейва Хелмли, Джима Рингхама, Рика Борстейна, Донну Зонтос, Лай-
зу Авалос, а также группу менеджеров, отвечающую за продажи в Северной Америке, и группу разработчиков 
InDesign.

Также следует поблагодарить всех моих друзей из сообщества Macintosh за постоянную поддержку на про-
тяжении многих лет, особенно Стива Возняка, Сэнди Кей, Кэлвина Карсона, Мию Сассер, Майка Эрлоу, Мэри и 
Джозефа Грей, Камелу 3. Робертсон, Ширли Касснер, Читу Хантер, Лори Отри, Лесу Снайдер, Филлис Эванс, 
Дейвида Сайма, Леонарда Мазерова, Квеси Охене Акуил и Пианкхи Блаунта.

И наконец (хотя, конечно же, не в последнюю очередь), я хочу выразить огромную благодарность Скотту 
Келби и всем сотрудникам KW Media Group за предоставленную возможность совместной работы над проектом. 
Я также благодарю всех пользователей InDesign во всем мире.
— Терри Уайт
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ОБ АВТОРАХ

Скотт Келби - главный редактор журнала Photoshop User (и один из его со-
здателей), журнала Capture User, выпускаемого компанией Nikon, а также журнала 
Mac Design Magazine. Скотт - президент Национальной ассоциации профессионалов 
Photoshop NAPP (National Association of Photoshop Professionals), а также президент 
компании KW Media Group, Inc., которая занимается изданием и проведением учеб-
ных курсов.

Скотт – автор таких книг, как «Хитрости и секреты работы в Photoshop CS», 
«Справочник по обработке цифровых фотографий в Photoshop CS», а также со-
здатель и редактор серии книг Killer Tips, выпускаемой издательством New Riders 
Publishing. Кроме того, Скотт написал три замечательные книги о компьютерах 
Macintosh и соответствующих программных продуктах: «Mac OSX Jaguar Killer Tips», 
получившую немало наград «Macintosh... The Naked Truth» (выпущены издательством 
New Riders Publishing), а также «Mac OSX Conversion Kit: 9 to 10 Side by Side» (вышла 
в издательстве Peachpit Press).

Свою первую программу - Kelby’s Notes for Adobe Photoshop (позволяющую по-
лучить ответы на 100 наиболее часто задаваемых вопросов о программе непосредс-
твенно при работе с Photoshop) - Скотт представил в 2003 году.

Скотт – директор по обучению Adobe Photoshop Seminar Tour, технический ди-
ректор PhotoshopWorld Conference and Expo: докладчик на различных торговых вы-
ставках по графическим продуктам. Он участвовал в создании видеороликов и DVD 
со сведениями о работе с Adobe Photoshop, а с 1993 года занимается подготовкой 
пользователей Photoshop.

Более подробные сведения вы найдете на Web-узле www.scottkelby.com.

Терри Уайт - менеджер по техническим ресурсам компании Adobe Systems Inc., 
настоящий поклонник технологий. Он любит компьютер и любые технические “штуч-
ки”. В компании Adobe работаете более семи лет и прекрасно знаком с линейкой 
Creative Professional программных продуктов компании Adobe. Терри - менеджер по 
техническим ресурсам, отвечающий за североамериканский регион. Он возглавляет 
группу разработчиков профессиональных настольных издательских систем, средств 
авторизации Web, а также инструментов для работы с цифровым видео. Терри рабо-
тает в компьютерной индустрии более 18 лет, является основателем и президентом 
MacGroup-Detroit - крупнейшей группы пользователей Macintosh Мичигана. Кроме 

того, Терри ведет собственную колонку в журнале Mac Design Magazine.
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ЕСЛИ ВЫ ВДРУГ ПОДУМАЛИ, ЧТО
ЭТО ВВЕДЕНИЕ, ТО ВЫ ОШИБАЕТЕСЬ

Потому что в настоящей книге введения нет
Мы не говорим, что во введении нет никакой надобности. На-

стоящей книге введение просто необходимо. Однако по определен-
ной причине мы решили все-таки этого не делать. Почему? Потому 
что столкнулись с некоторыми философскими проблемами, решая 
которые, мы, два взрослых мужчины, нарушили традиции. Однако 
основная причина состоит все-таки в том, что введения никто не 
читает. Никто. Ни вы. Ни мы. Никто. Даже сейчас вы не читаете 
введение.

Так почему же авторы все-таки пишут введения?
Потому что их заставляют это делать издатели. Это чистая 

правда. Авторам приходится писать введение, хотя даже компа-
ния-издатель прекрасно понимает всю бессмысленность этой за-
теи. Более того, из-за того, что никто из авторов не хочет писать 
введение, а в компании-издателе его никто не хочет читать, очень 
часто введения готовятся в самый последний момент, в них могут 
(в это даже страшно подумать) закрасться ошибки.

А зачем вообще в книгах введение?
У нас нет ни малейших соображений по этому поводу. Напри-

мер, во введении автор может рассказать читателю, как правиль-
но читать книгу. Поскольку мы подозреваем, что вы знаете, что 
после прочтения страницы необходимо переходить к следующей, 
а какое-то введение писать все-таки придется, мы решили расска-
зать вам, чем же эта книга отличается от всех остальных.

Чем настоящая книга отличается от других?
Итак, в настоящей книге собраны советы, и ничего более. 

Советы, которые помогут вам работать в InDesign CS быстрее, 
эффективнее и, самое главное, более увлеченно. Вы не найдете 
подробных сведений о проверке документов на сервере рабочей 
группы или же о настройке параметров зоны переносов (мы знаем, 
что вы немного опешили, поскольку эти две темы представляют 
большой интерес). Вместо этого мы решили предложить вашему 
вниманию комбинации клавиш, советы и приемы работы, которые 
помогут вам работать как минимум в два раза быстрее. А чем быст-
рее вы выполняете свою работу, тем большую ценность представ-
ляете как для своих клиентов, так и для организации.

А нужно ли вам работать быстрее?
Абсолютно верно. Следующий вопрос.

Действительно ли так важно работать быстрее?
Это очень важно. Никто не хочет выбирать сложный способ. 

Медленный способ. Разочаровывающий способ. Ваше время очень 
важно, и если вы научитесь эффективно работать в 1п0еадп, то 
сможете уделять больше времени разработке различных макетов, 
изучению новых возможностей; в конце концов, вы сможете прос-
то чуть дольше отдохнуть. И в этом вам поможет настоящая книга. 
Если в большинстве книг небольшое количество советов можно 
найти во врезках, то в настоящей книге нет ничего, кроме полез-
ных советов.

СОВЕТ

Это совет во врезке. 
Подобные советы можно 
найти в любой популярной 
книге о Photoshop. Без них 
материал книги многое те-
ряет. Вы держите в руках 
книгу, в которой нет ниче-
го, кроме советов
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Что такое врезка?
Это один из тех серых прямоугольников, в верхней части которых 

можно увидеть слово “совет”. Советы во врезках имеют несколько недо-
статков. Во-первых, их всегда мало. Во-вторых, в них содержится всего 
несколько строчек текста. В настоящую книгу мы включили несколько со-
ветов, дополненных графическими изображениями, благодаря чему они 
стали более понятными и менее скучными.

А что такое советы знатоков?
“Для создания надписи воспользуйтесь инструментом Туре”. С техни-

ческой точки зрения это совет. Но это обычный, рядовой, скучный совет, 
который назвать советом знатока никак нельзя. Совет знатока должен 
производить впечатление.

Подходит ли настоящая книга именно вам?
Если вы дочитали до этого раздела, то настоящая книга вам опреде-

ленно подходит. Однако, если у вас возникли какие-то сомнения (вы не 
уверены в том, нужна ли вам книга без введения), мы боимся, что вы на-
ходитесь в опасности воспользоваться преимуществами такого подхода 
- в таком случае настоятельно рекомендуем приобрести книгу, которую вы 
сейчас держите в руках.

Итак, как же я приступил к работе над книгой
Материал настоящей книги не напоминает классический роман. Ско-

рее, он организован так, чтобы работу с книгой можно было начинать с 
любой главы, причем сразу применять полученные знания на практике, 
тем самым значительно расширяя свой опыт работы с InDesign.

Минуточку! Еще одно замечание!
На самом деле это все. Теперь переверните страницу и приступайте к 

изучению советов!
Ждем ваших отзывов!
Вы, читатель этой книги, и есть главный ее критик и комментатор. Мы 

ценим ваше мнение и хотим знать, что было сделано нами правильно, что 
можно было сделать лучше и что еще вы хотели бы увидеть изданным 
нами.

Мы ждем ваших комментариев и надеемся на них. Вы можете при-
слать нам бумажное или электронное письмо либо просто посетить наш 
№еЬ-сервер и оставить свои замечания там. Одним словом, любым удоб-
ным для вас способом дайте нам знать, нравится или нет вам эта книга, 
а также выскажите свое мнение о том, как сделать наши книги более 
интересными для вас.

Посылая письмо или сообщение, не забудьте указать название книги и 
ее авторов, а также ваш обратный адрес. Мы внимательно ознакомимся с 
вашим мнением и обязательно учтем его при отборе и подготовке к изда-
нию последующих книг.

Наши координаты:
e-mail: info@williamspublishing.com
www: http://www.williamspublishing.com

Адреса для писем из:
России: 115419, Москва, а/я 783
Украины: 03150, Киев, а/я 152

СОВЕТ

Вы только посмотрите 
на эту врезку! Вы обратили 
на нее внимание, не смот-
ря на то, что уже знаете, 
что это точно не совет. 
Если вы всегда обращае-
те внимание на врезки в 
надежде получить хоро-
ший совет, обязательно 
приобретите настоящую 
книгу.
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Поскольку мы тратим немало вре-
мени на навигацию по документам. нам 
удастся сэкономить его, если навигация 
будет осуществляться как можно эф-
фективнее. На что можно будет пот-
ратить дополнительное время? Можно пойти раньше

ИЗМЕНЕНИЕ МАСШТАБА ДОКУМЕНТА
Навигация и другие важные сведения

домой? Больше времени уделить семье? Нет. Мы будем 
делать то, что нравится большинству дизайнеров — из-
менять масштаб. Когда никого нет рядом, дизайнеры 
постоянно увеличивают масштаб документа с цепью 
изучения мелких деталей. Мы задаем масштаб 400%, 
потом уменьшаем его до 50%; потом снова увеличива-
ем до 1200%, а затем уменьшаем до 12,5%. Зачем это 
нужно? Не знает никто. Ученые изучали данный фено-
мен на протяжении нескольких пет. однако однознач-
ного ответа на вопрос так и не нашли. Однако можно 
смело утверждать, что такие операции, как изменение 
масштаба, смещение и другие действия с элементами 
страниц в InDesign обладают какой-то притязательной 
силой. Нам с вами как дизайнерам нравится возмож-
ность без особой надобности увеличить масштаб до 
4000%, чтобы изучить мелкие элементы какого-нибудь 
символа.
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НЕОБХОДИМО ОТМЕНИТЬ ИЗМЕНЕНИЕ МАСШТАБА?
ДЛЯ ЭТОГО ВОСПОЛЬЗУЙТЕСЬ КОМБИНАЦИЕЙ КЛАВИШ

Это одна из самых удобных 
комбинаций клавиш, однако по 
какой-то причине она известна 
очень небольшому количес-
тву пользователей (если вы 
будете использовать ее при 
работе, то сможете работать 
намного эффективнее). Ког-
да вы изменяете масштаб, то 
отменить ее нельзя, не так ли? 
По крайней мере, об этом вам 
скажет подавляющее боль-
шинство пользователей. Однако это не так! Чтобы переключиться между обычным и увеличенным представ-
лениями документа, следует нажать комбинацию клавиш <Аlt+Сtrl+2> (<0рtion+�+2>). Это один из тех советов, 
к которому вы будете регулярно обращаться при работе.

НАСТРОЙКА СТАНДАРТНЫХ ПАРАМЕТРОВ
Вам необходимо, чтобы по умолчанию использо-
вался другой шрифт? Хотите, чтобы по умолчанию 
при обводке вместо линии юлщиной 1 пункт исполь-
зовалась линия толщиной 0,5 пункта? Требуется, 
чтобы для функции Text Wrap (Обтекание текстом) 
по умолчанию было задано значение Wrap Around 
Bounding Box (Обтекание вокруг ограничивающей 
рамки)? В данном случае имеет смысл изменить 
глобальные установки программы. Однако вам 
следует знать одну деталь: подобные изменения 
следует вносить тогда, когда закрыты все доку-
менты. Закройте все документы, измените зна-
чения параметров... вот и все - теперь заданные 
вами значения параметров будут использоваться 
по умолчанию. Удивительно!
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КАК БЫСТРО ПЕРЕЙТИ К ОПРЕДЕЛЕННОЙ СТРАНИЦЕ
Если вы работаете с документом, содержащим 
большое количество страниц, и вам точно извес-
тен номер страницы, к которой следует перейти, 
это можно сделать очень быстро. Нажмите комби-
нацию клавиш <Ctrl+J> (<�+J>), чтобы активизиро-
вать текстовое поле Page Number (Номер страни-
цы). Укажите номер страницы, нажмите клавишу 

<Enter> (<Return>), и вы сразу увидите необходимую страницу. При необходимости перейти к главной странице 
(название которой вам известно) воспользуйтесь этой же комбинацией клавиш, однако вместо номера страни-
цы задайте первые несколько букв из ее названия.

КАК БЫСТРО ПЕРЕЙТИ К ПЕРВОЙ СТРАНИЦЕ
Вам необходимо быстро перейти к первой стра-
нице документа? В данном случае речь не идет о 
странице, которой автоматически назначен номер 
1, поскольку при работе над книгой или журналь-
ной статьей номер первой страницы может быть 
равен 354. Мы говорим именно о первой странице 
документа. Нажмите комбинацию клавиш <Ctrl+J> 
(<�+J>), чтобы активизировать текстовое поле 

Page Number (Номер страницы). Введите значение +1, после чего нажмите клавишу <Enter> (<Return>).
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КАК ОТКРЫТЬ ИЛИ ЗАКРЫТЬ ВСЕ БОКОВЫЕ ПАЛИТРЫ 
ОДНИМ ЩЕЛЧКОМ МЫШИ

Чтобы открыть или закрыть все боковые палитры одним щелчком мыши, на-
жмите клавишу <Alt> (<0ption>), а затем щелкните на ярлыке вкладки любой 
из палитр. Это очень просто.

ВЫДЕЛЕНИЕ ТЕКСТОВОГО ПОЛЯ
Требуется быстро выделить поле? Для этого щелкните на значке поля, 
в результате чего указанное в нем значение будет автоматически вы-
делено. Это позволит сэкономить немало времени, поскольку после 
щелчка можно сразу вводить необходимое значение. Кроме того, вам 
не придется пытаться попасть курсором в необходимое текстовое поле 
крошечных размеров, а после этого еще и выделять значение. Один 
раз попробовав применить данный совет на практике, вы наверняка 
будете неоднократно обращаться к нему при работе.
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СОЗДАНИЕ ДОКУМЕНТОВ БЕЗ ОБРАЩЕНИЯ 
К ДИАЛОГОВОМУ ОКНУ NEW DOCUMENT

Чтобы создать новый документ точно таких же размеров, как и те-
кущий, нажмите комбинацию клавиш <Alt+Ctrl+N> (<Option+�+N>); в 
результате новый документ будет создан даже без отображения диа-
логового окна New Document (Создание документа).

ВОССТАНОВЛЕНИЕ ПАРАМЕТРОВ ДИАЛОГОВОГО ОКНА 
NEW DOCUMENT

Если после указания значений параметров в диало-
говом окне New Document (Создание документа) вы 
решили отказаться от этого, не нужно щелкать на 
кнопке Cancel (Отмена), а после этого начинать все 
сначала. Просто нажмите клавишу <Alt> (<0ption>). 
В результате кнопка Cancel (Отмена) превратится 
в кнопку Reset (Сброс). Щелкните на ней, чтобы 
восстановить значения параметров, которые были 
заданы при отображении диалогового окна.
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КАК СЭКОНОМИТЬ ВРЕМЯ ПРИ СОЗДАНИИ 
ДОКУМЕНТОВ

Если вам приходится создавать документы 
нестандартного размера (например, размерами 
с открытку), можно сохранить соответствующий 
размер в качестве стандартного, а затем выби-
рать его из раскрывающегося списка Document 
Preset (Стандартные установки документа) диало-
гового окна New Document (Создание документа). 
Для этого выберите команду Document (Документ) 
из меню File=>New (Файл=> Создать). В диалого-
вом окне New Document (Создание документа) 
введите необходимые значения ширины, высоты, 
полей и других параметров, после чего щелкните 
на кнопке Save Preset (Сохранить стандартные ус-
тановки). В появившемся диалоговом окне задай-
те подходящее значение. Как только вы щелкнете 
на кнопке ОК, заданный вами набор установок станет доступным в раскрывающемся списке Document Preset 
(Стандартные установки документа).

КАК ОТОБРАЗИТЬ ЦЕЛЫЙ РАЗВОРОТ
Если при работе с разворотом нажать комбинацию 
клавиш <Ctrl+0> (<�+0>) (которая соответствует 
команде Fit Page in Window (Страница по разме-
рам окна)), на экране будет отображена целая 
страница, поэтому для перемещения влево-вправо 
вам придется использовать горизонтальную поло-
су прокрутки. Однако этого не придется делать, 
если нажать комбинацию клавиш <Alt+Ctrl+0> 
(<Option+Ctrl+0>) (которая соответствует команде 
Fit Spread in Window (Разворот по размерам окна).
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КАК ОТОБРАЗИТЬ РАЗВОРОТ В ОКНЕ ЕЩЕ БЫСТРЕЕ!
При необходимости увидеть целую страницу или разворот как можно быстрее, вы сэкономите 
время, если вместо использования меню View (Вид) или нажатия комбинации клавиш <Ctrl+Alt+0> 
(<�+0ption+0>) для перехода к режиму отображения Fit Spread in Window (Разворот по размерам 
окна) дважды щелкните на значке инструмента Hand (Рука) в палитре инструментов.

ОТОБРАЖЕНИЕ ЦЕЛОГО МОНТАЖНОГО СТОЛА
Наверняка вы, как и я, используете монтажный 
стол (рабочая область на экране за пределами по-
лосы набора) для размещения объектов, которые 
могут потребоваться в дальнейшем (дополнитель-
ные текстовые блоки, фотографии, эмблемы и 
т.д.). Но при этом у вас также могут возникать те 
же проблемы, что и у нас – вы часто забываете, 
где именно разместили те или иные объекты. В 
данном случае для отображения всего монтажно-
го стола достаточно нажать комбинацию клавиш 
<Shift+Alt+Ctrl+0>(<Shift+Option+�+0>).
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БЫСТРОЕ ИЗМЕНЕНИЕ МАСШТАБА
Для быстрого изменения масштаба документа 
мы редко обращаемся к инструменту Zoom (Мас-
штаб). Для увеличения масштаба достаточно на-
жать комбинацию клавиш <Ctrl++ (знак “плюс”)> 
(<�++ (знак “плюс”)>), а для его уменьшения 
– комбинацию клавиш <Ctrl+ - (знак “минус”)> 
(<�+ - (знак “минус”)>).

Каждое последующее нажатие комбинации кла-
виш приводит к соответствующему изменению 
масштаба. Вы даже не представляете, как быстро 
вы сможете достичь необходимых размеров!
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КАК БЫСТРО ЗАДАТЬ МАСШТАБ 100%
Вам необходимо задать для документа масштаб 100%? Для этого достаточно дважды щелкнуть 
на значке инструмента Zoom (Масштаб) в палитре инструментов. Выбирать инструмент не нужно 
- просто дважды щелкните на его значке.

ЗАДАНИЕ МАСШТАБА 200% ДЛЯ ТЕКУЩЕЙ ОБЛАСТИ 
ДОКУМЕНТА

Если вам необходимо быстро задать масштаб 
200% для текущей области документа, сделать это 
совсем не сложно. Щелкнув на любом объекте в 
этой области документа, нажмите комбинацию 
клавиш <Ctrl+2> (<�+2>) – так вы зададите масш-
таб 200% для текущей области документа.
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СЕКРЕТНАЯ КОМБИНАЦИЯ КЛАВИШ ДЛЯ ПОЛЯ ZOOM
Если вам точно известно, какое значение масш-
таба необходимо задать, можно щелкнуть в поле 
Zoom (Масштаб) и ВВЕСТИ требуемое значение. Для 
получения тех же результатов можно нажать ком-
бинацию клавиш <Alt+Ctrl+5> (<0ption+�+5>). После 
этого введите значение и нажмите клавишу <Enter> 
(<Return>).

ПЕРЕМЕЩЕНИЕ ПО ДОКУМЕНТУ ПРИ УВЕЛИЧЕННОМ 
МАСШТАБЕ

Если вы увеличили масштаб документа, то сущес-
твует более простой способ перемещения по нему, 
чем использование полос прокрутки. Вместо этого 
просто нажмите комбинацию клавиш <Alt+Spacebar> 
(<Option+Spacebar>), чтобы получить временный 
доступ к инструменту Hand (Рука), с помощью кото-
рого вы легко переместите инструмент в необходи-
мом направлении. После этого отпустите указанную 
комбинацию клавиш, чтобы вернуться к инструмен-
ту, который был активен перед этим.
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КАК ПОЛУЧИТЬ ВРЕМЕННЫЙ ДОСТУП
К ИНСТРУМЕНТУ ZOOM

Если при работе с документом вам потребуеюя 
быстро увеличить его масштаб, для получения 
временного доступа к инструменту Zoom (Мас-
штаб) достаточно нажать комбинацию клавиш 
<Ctrl+Spacebar> (<�+Spacebar>). При необходи-
мости уменьшить масштаб к данной комбинации 
следует добавить клавишу <Alt> (<0ption>).

ОТОБРАЖЕНИЕ СЕТКИ БАЗОВЫХ ЛИНИИ
Если вы используете средство Baseline Grid (Сетка 
базовых линий) (для активизации которого доста-
точно выбрать команду View⇒Show Baseline Grid 
(Вид⇒Показать сетку базовых линий)), можно 
задать масштаб страниц, при котором сетка еще 
будет заметна. Например, если по умолчанию за-
дать масштаб равным 75% и меньше, сетка будет 
скрыта. Чтобы изменить минимальное “пороговое” 
значение, следует перейти на вкладку Grids (Сетки) 
диалогового окна Preferences (Установки), для отоб-
ражения которого достаточно выбрать одноимен-
ную команду из MЕНЮ Edit (Правка) (на платформе 
Mac OS X это меню InDesign}. После этого умень-
шите значение параметру View Threshold (Порог 
отображения).
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ПАРАМЕТРЫ НАПРАВЛЯЮЩИХ ЛИНЕЕК
Направляющие линейки могут быть как полезными, 
так просто раздражающими. Именно по этой при-
чине их иногда требуется скрыть. Однако отобра-
жение и сокрытие направляющих вручную увлека-
тельным занятием назвать достаточно сложно.

В большинстве случаев направляющие отображаются при увеличении масштаба и скрываются при его умень-
шении. Кроме того, как и при работе со средством Baseline Grid (Сетка базовых линий) (см. предыдущий совет), 
можно задать пороговое значение. Прежде чем добавлять направляющие, выберите команду Ruler Guides 
(Направляющие линеек) из меню Layout (Макет) и задайте значение параметра View Thieshold (Порог отобра-
жения) равным 100%. В результате направляющие будут отображаться только при задании масштаба равным 
100% и больше. Как только вы зададите масштаб 99% или меньше, направляющие исчезнут.

НАСТРОЙКА ВНЕШНЕГО ВИДА ПАЛИТРЫ 
ИНСТРУМЕНТОВ

Вам не нравится стандартный вид палитры инструментов, на которой значки инструмен-
тов расположены в два столбца? Его можно легко изменить. Просто дважды щелкните 
на небольшом ярлычке в верхней части палитры инструментов, чтобы расположить 
значки инструментов в один столбец. Еще раз дважды щелкните на ярлычке, и значки 
инструментов будут расположены в одну строку. Чтобы восстановить стандартный вид 
палитры инструментов, достаточно еще один раз дважды щелкнуть на ярлычке.

Значки расположены в одну строку

Значки расположены в два столбца

Значки расположены в один столбец
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ПЛАВАЮЩАЯ ПАЛИТРА УПРАВЛЕНИЯ
Несмотря на то, что по умолчанию палитра управления прикреплена к верхней части экрана, не только такое 
ее расположение единственно возможно. Щелкните на небольшом ярлычке в левой части палитры, и перета-
щите ее на необходимое место. Чтобы прикрепшь палитру к нижней границе экрана, щелкните на ярлычке и 
перетащите палитру к нижнему левому углу экрана.

КАК СВЕРНУТЬ ПАЛИТРУ ИНСТРУМЕНТОВ
Если вы решили предпочесть работу с плавающей палитрой инструментов, но в определенных си-
туациях вам требуется ее свернуть, дважды щелкните на небольшом ярлычке в левой части. В 
результате на экране будет отображена только небольшая вкладка. Чтобы отобразить палитру 
инструментов еще раз, дважды щелкните на небольшом ярлычке в левой части.
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 УПРАВЛЕНИЕ ПАЛИТРАМИ
Несмотря на то, что концепция боковых палитр, используемая в 
InDesign CS, значительно упрощает упорядочение палитр на экране, 
можно сделать кое-что еще. Если слева от названия палитры находит-
ся значок в виде двух стрелочек, направленных вверх и вниз, щелкнув 
на нем, вы свернете и развернете список параметров палитры. Если 
вам необходимо освободить еще больше пространства, достаточно 
дважды щелкнуть непосредственно на ярлыке вкладки палитры. В 
результате на экране будет отображена только вкладка. Чтобы отоб-
разить палитру целиком, дважды щелкните на ее ярлыке еще раз.

Полноразмерная палитра

Параметры скрыты

Отображается только ярлык 
вкладки
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КАК РАЗМЕСТИТЬ В ПАЛИТРЕ LAYERS ЕЩЕ БОЛЬШЕ 
ЭЛЕМЕНТОВ

Если вам приходится много 
работать с большим количес-
твом слоев, палитра Layers 
(Слои) очень быстро окажется 
переполненной. Данный со-
вет позволит вам работать с 
большим количеством слоев, 
однако при этом вы сможете 
избежать чрезмерного за-
громождения палитры Layers 
(Слои) (мы не предлагаем вам 
увеличивать размеры палит-
ры). Чтобы в палитре Layers 
(Спои) отображалось большое 

количество слоев, выберите из меню палитры команду Small Palette Rows (Небольшие строки в палитре). В 
данном примере при использовании строк стандартного размера в палитре отображается всего 9 слоев (см. 
рисунок слева), однако после выбора команды Small Palette Rows (Небольшие строки в палитре) в палитре 
отображается уже 12 слоев (см. рисунок справа).

СОЗДАНИЕ СОСТАВНОЙ ПАЛИТРЫ
Компания Adobe предлагает несколько способов, которые помогут 
уменьшить загроможденность палитрами. Однако у разных пользо-
вателей различные потребности, некоторые пользователи, наоборот, 
хотят объединить все наиболее часто используемые ими палитры в 
одну большую палитру (которую мы назовем составной). Получив вло-
женную палитру, содержащую 3-4 вкладки, перетащите вкладку еще 
одной палитры к нижней части вложенной палитры, а затем медленно 
переместите ее вверх. У нижней части вложенной палитры должна 
появиться двойная линия черного цвета, которая указывает на воз-
можность прикрепления, для чего достаточно опустить кнопку мыши. 
В результате будет получена огромная составная палитра, на которой 
собраны все необходимые параметры.
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НАСТРОЙТЕ ПАРАМЕТРЫ РАБОЧЕЙ ОБЛАСТИ РАЗ И 
НАВСЕГДА!

При первом запуске InDesign все палитры, а 
также палитра инструментов отображаются на 
своих стандартных местах (которые, конечно же, 
были выбраны компанией Adobe), однако ничто 
не мешает вам изменить месторасположение 
палитр, сохранив собственный вариант рабочей 
области. Сначала задайте наиболее подходящее положение всех основных элементов, после чего из меню 
Window⇒Workspace (Окно⇒Рабочая область) выберите команду Save Workspace (Сохранить рабочую 
область). На экране появится диалоговое ОКНО, в котором можно задать подходящее название. Пос-
ле щелчка на кнопке ОК сохраненная рабочая область станет доступной в меню Window⇒Workspace 
(Окно⇒Рабочая область).

Возможность сохранения рабочих областей оказывается очень кстати в том случае, когда на одном компью-
тере работает несколько пользователей с разными личными предпочтениями и при выполнении задач разного 
плана.

КАК СКРЫТЬ ВСЕ ПАЛИТРЫ И ПАЛИТРУ 
ИНСТРУМЕНТОВ ОДНИМ ЩЕЛЧКОМ МЫШИ

Если палитры заняли слишком много места на экране, а вам необходимо оценить внешний вид документа, 
нажмите клавишу <ТаЬ>, чтобы скрыть и палитры, и панель инструментов. Для их отображения достаточно 
нажать клавишу <ТаЬ> еще один раз.
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КАК СКРЫТЬ ВСЕ ПАЛИТРЫ ОДНИМ ЩЕЛЧКОМ МЫШИ, 
ОСТАВИВ ПАЛИТРУ ИНСТРУМЕНТОВ

Вам необходимо скрыть все палитры, но оставить палитру инструментов на экране? Убедившись, что в до-
кументе не выделен ни один объект, щелкните на небольшом значке в виде палитры в нижнем правом углу 
палитры управления. Если это сделать при выделенном объекте, то будут скрыты только те палитры, которые 
имеют отношение к данному объекту.

КАК СКРЫТЬ ТОЛЬКО ПАЛИТРЫ
Несмотря на то, что концепция боковых палитр, используемая в InDesign CS, позволяет сэкономить достаточно 
много места, иногда возникает необходимость скрыть и эти палитры. Если вам необходимо скрыть палитры, 
оставив палитры управления и инструментов, нажмите комбинацию клавиш <Shift+Tab>. Чтобы отобразить 
палитры достаточно нажать комбинацию клавиш <Shift+Tab> еще один раз. В каких ситуациях вы будете обра-
щаться к данной комбинации клавиш? Скорее всего, при необходимости быстро получить доступ к вертикаль-
ной полосе прокрутки.
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РАЗМЕЩЕНИЕ ГРУППЫ ПАЛИТР У КРАЯ ЭКРАНА
А как быть в том случае, если после создания группы из трех вложенных палитр одну из них перетащить 
к правой границе экрана? К сожалению, следует отметить, что боковой станет именно эта палитра; 
все остальные палитры останутся на своих местах. Каким образом перетащить сразу все палитры? 
Да очень просто. Достаточно при перетаскивании одной из них удерживать нажатой клавишу <Alt> 
(<0ption>).

ПРЕДВАРИТЕЛЬНЫЙ ПРОСМОТР ДОКУМЕНТА
Если вам понадобилось оценить внешний вид документа (без направля-
ющих, непечатаемых символов и т.д.). можно щелкнуть на Preview Mode 
(Режим предварительного просмотра) в нижней части палитры инстру-
ментов (если активным не является инструмент Type (Текст), нажмите 
клавишу <W>). Если вы добавили реглеты или обрезы, используйте 
дополнительные режимы предварительного просмотра, выбор которых 
осуществляется из меню значка Preview Mode (Режим предварительного 
просмотра) (см. рисунок).
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КАК СОХРАНИТЬ ВСЕ ОТКРЫТЫЕ ДОКУМЕНТЫ С 
ПОМОЩЬЮ ОДНОЙ КОМБИНАЦИИ КЛАВИШ

Если вы открыли несколько документов и подоз-
реваете, что в работе системы может произойти 
сбой, для быстрого сохранения всех открытых до-
кументов достаточно нажать комбинацию клавиш 
<Shift+Alt+Ctrl+S> (<Shift+Option+�+S>). Очень 
удобно, не так ли?

УВЕЛИЧЕНИЕ РАЗМЕРОВ ПАЛИТРЫ NAVIGATOR
Этот совет удивит многих пользователей, которые используют палитру Navigator (Hавигатор) крошечного раз-
мера (см. рисунок слева). Для увеличения размеров палитры Navigator (Навигатор) достаточно щелкнуть на 
специальном значке в нижнем правом углу палитры и перетащить его (см. рисунок справа).
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КАК УВИДЕТЬ ВСЕ СРАЗУ
Палитра Navigator (Навигатор) оказывается не 
очень удобной, если необходимо увидеть все раз-
вороты целиком и при этом задать требуемый мас-
штаб для определенной части документа. Однако 
благодаря большой диагонали экрана современных 
мониторов сделать это все-таки можно. Выберите 
команду View All Spreads (Отображать все разворо-
ты) из меню палитры Navigator (Навигатор). Теперь 
вы видите все развороты и можете быстро перейти к необходимой части документа.

ПЯТЬ САМЫХ ВАЖНЫХ БЫСТРЫХ КЛАВИШ
Хотите экономить время буквально каждый день? Попробуйте запомнить быстрые клавиши, соответствующие 
наиболее популярным инструментам. 

Инструмент        Инструмент             Инструмент             Инструмент     Инструмент
Selection: <V>     Line: <\>                   Type: <T>                 Pen: <P>           Direct Selection: <A>

Запомнив эти быстрые клавиши, вы будете удивлены, насколько возрастет эффективность вашей работы.
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КОМБИНАЦИЯ КЛАВИШ ОТСУТСТВУЕТ? СОЗДАЙТЕ ЕЕ!
Если вы часто используете команду, которой по 
умолчанию не назначена никакая комбинация кла-
виш (например, команду для отображения диало-
гового окна Margins and Columns (Поля и колонки)), 
выполните следующие действия.
Выберите команду Edit⇒Keyboard Shortcuts 
(Правка⇒Комбинации клавиш). В появившемся 
диалоговом окне из раскрывающегося списка 
Product Area (Меню программы) выберите меню, 
к которому относится интересующая вас команда 
(например, команда Margins and Columns (Поля и 
колонки) отображается в меню Layout (Макет)). 
Затем в появившемся списке щелкните на инте-
ресующей вас команде. Если ей уже назначена 
комбинация клавиш, последняя будет отображена 
в поле Current Shortcuts (Текущие комбинации кла-
виш). Если нет, назначьте собственную комбина-
цию клавиш. Для этого щелкните в текстовом поле 
New Shortcut (Новая комбинация клавиш), введите 
подходящую комбинацию клавиш, щелкните на 
кнопке Assign (Назначить), после чего щелкните 
на кнопке ОК.

ВЫ РАНЬШЕ РАБОТАЛИ В QUARKXPRESS?
ИСПОЛЬЗУЙТЕ ПРИВЫЧНЫЕ КОМБИНАЦИИ КЛАВИШ

Если вы перешли к InDesign от QuarkXPress (а мы 
подозреваем, что так в свое время поступили мно-
гие пользователи), освоение InDesign можно уп-
ростить, используя привычные комбинации клавиш 
QuarkXPress. Выберите команду Edit⇒Keyboard 
Shortcuts (Правка⇒Комбинации клавиш). В поя-
вившемся диалоговом окне из раскрывающегося 
списка Set (Набор) выберите значение Shortcuts for 

QuarkXPress 4.0 (Комбинации клавиш QuarkXPress 4.0), после чего щелкните на кнопке ОК. Вот и все.

(Примечание: поступив подобным образом, вы сможете сыграть злую шутку над сотрудниками, коорые не 
смогут воспользоваться привычными комбинациями клавиш.)
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ПЕЧАТЬ СПИСКА КОМБИНАЦИИ КЛАВИШ
Если вы создали в InDesign немало собственных 
комбинаций клавиш, каким образом вы намерены 
все их запомнить? А вам и не нужно этого делать! 
Выберите команду Edit⇒Keyboard Shortcuts (Прав-
ка⇒Комбинации клавиш). В появившемся диалого-
вом окне щелкните на кнопке Show Set (Показать 
набор) (как показано на рисунке), чтобы отобразить 
список комбинаций клавиш в окне текстового ре-
дактора. После этого отправьте  его на печать.

КАК ПОВТОРНО АКТИВИЗИРОВАТЬ ВСЕ ДИАЛОГОВЫЕ 
ОКНА С ПРЕДОСТЕРЕЖЕНИЯМИ

Вам наверняка неоднократно приходилось видеть 
диалоговые окна с предостережением. И вы, на-
верное, часто устанавливали в них флажок Don’t 
show this dialog again (He показывать это диалого-
вое окно снова) (или флажок с похожим названи-
ем). Однако если по какой-то причине вы решили 
восстановить отображение подобных диалоговых 
окон (это особенно полезно при знакомстве с но-
выми функция программы), перейдите на вкладку 
General (Общие) диалогового окна Preferences 
(Установки), для отображения которого следует 
выбрать одноименную команду из меню Edit (Ре-
дактирование) (на платформе Macintosh это меню 
Photoshop). После этого щелкните на кнопке Reset 
All Warning Dialogs (Восстановить все диалоговые 
окна с предостережениями).
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В чем действительно InDesign CS 
предлагает довольно широкие возмож-
ности, так это в настройке параметров 
текста. Программа поддерживает такое 
количество типографских функций вы-
сокого уровня, что даже в компании Adobe не знают 

УДИВИТЕЛЬНЫЕ НАДПИСИ
Настройка параметров текста

точного назначения и половины из них. Еспи вы найдете 
в себе сипы на изучение данных функций, то не только 
сможете работать намного быстрее и эффективнее, но 
очень быстро заработаете репутацию профессионала 
по работе с текстом. В результате ваша жизнь претер-
пит значительные изменения Вы будете свысока смот-
реть на многих людей, которые занимаются версткой 
Объявлений, рекламы и других подобных документов. 
Вы будете смеяться над ними, так как они вряд пи зна-
ют, что такое пигатура. Вы будете иронизировать над 
ними. так как они вряд пи применяют висячую пункту-
ацию. Кроме того. они вряд пи используют правильные 
парные кавычки, но при этом часто допускают два про-
бела Еспи вы хотите знать, как правильно использовать 
подчеркивание, верхние и нижние индексы, а также как 
задавать параметры кернинга, обязательно изучите ма-
териал настоящей главы.
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КАК БЫСТРО ВЫБРАТЬ ИНСТРУМЕНТ TYPE
Если при работе со страницей, на которой распо-
ложено несколько текстовых блоков, вам потребо-
валось добавить текст в один из блоков, выберите 
инструмент Type (Текст). Чтобы не обращаться к па-
литре инструментов, дважды щелкните в текстовом 
блоке при одном активном инструменте выделения. 
В результате автоматически станет активным инс-
трумент Type (Текст), а в текстовом блоке появится 
курсор. Вы можете сразу приступать к вводу тек-
ста.

СКРЫТЫЕ ПАРАМЕТРЫ ТЕКСТА ВДОЛЬ КОНТУРА
Вам необходимо получить больший контроль над 
текстом вдоль контура? Дважды щелкните на знач-
ке инструмента Type on a Path (Текст вдоль кон-
тура) в палитре инструментов, чтобы отобразить 
диалоговое окно параметров.
(Имейте в виду, что инструмент Type on a Path 
(Текст вдоль контура) в палитре инструментов за-
нимает одну ячейку с инструментом Type (Текст).)
Наиболее интересные параметры доступны в раскрывающемся списке Effect (Эффект), поскольку вам предо-
ставляется возможность применять к надписи специальные эффекты, причем даже после ее создания. Ох, 
если бы эти эффекты были доступны в Photoshop!
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НАСТРОЙКА СТАНДАРТНЫХ ПАРАМЕТРОВ ТЕКСТА
Настроить стандартные параметры текста (шрифт, размер шрифта 
и т.д.) для документа совсем не сложно. Убедитесь в том, что в до-
кументе ничего не выделено (для этого достаточно воспользоваться 
командой Edit=>Deselect All (Правка=>Снять выделение со всего)). За-
тем выберите инструмент Type (Текст) и задайте в палитре Character 
(Символ) необходимые параметры. Как видите, действительно ничего 
сложного.

ОПРЕДЕЛЕНИЕ СТАНДАРТНЫХ СТИЛЕЙ СИМВОЛА И 
АБЗАЦА

При необходимости всегда можно определить 
стандартные стили, а простейший способ это 
сделать - импортировать требуемые стили из до-
кумента, в котором используется весь их набор. 
Для этого выберите из меню Type (Текст) коман-
ду Character Styles (Стили символа) или Paragraph 
Styles (Стили абзаца) – особой роли это не играет. 
Затем в меню палитры перейдите к команде Load 
All Styles (Загрузить все стили). На экране появится 
стандартное диалоговое окно Open a File (Откры-
тие файла). Выберите документ, где присутству-
ют стили, которые вы решили использовать по 
умолчанию, после чего щелкните на кнопке Open 
(Открыть).

Вот и все - все стили данного документа теперь будут использоваться как стандартные стили абзаца и 
символа.
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БЫСТРОЕ ИЗМЕНЕНИЕ РАЗМЕРА ШРИФТА
С КЛАВИАТУРЫ

Когда дело доходит до изменения размеров шрифта, можно обращаться к палитрам Control (Управление) 
или Character (Символ), а можно использовать и комбинации клавиш. Чтобы увеличить размер шрифта на 2 
пункта, выделите соответствующий текст и нажмите комбинацию клавиш <Shift+Ctrl+>> (<Shift+�+>>). Для 
уменьшения размера шрифта на 2 пункта выделите соответствующий текст и нажмите комбинацию клавиш 
<Shift+Ctrl+<> (<Shift+�+<>).

ИЗМЕНЕНИЕ РАЗМЕРА ШРИФТА С ШАГОМ БОЛЬШЕ
2 ПУНКТА

Используя комбинации клавиш из предыдущего со-
вета, вы можете прийти к выводу, что изменения 
размера шрифта с шагом 2 пункта (а именно это 
значение задано по умолчанию) вам недостаточ-
но. Например, вам может потребоваться изменить 
размер шрифта с шагом 6, 8 или даже 10 пунктов. 
Перейдите на вкладку Units & Increments (Едини-
цы измерения и приращения) диалогового окна 
Preferences (Установки), для отображения кото-
рого необходимо выбрать одноименную команду 
из меню Edit (Правка) (на платформе Macintosh 
это меню InDesign). В группе параметров Keyboard 
Increments (Приращения с клавиатуры) в текстовом 
поле Size/Leading (Размер/Междустрочный интер-
вал) по умолчанию задано значение 2. Задайте 
такое значение, какое посчитаете необходимым.
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ИСПОЛЬЗОВАНИЕ ПОДСТАНОВОЧНОГО ТЕКСТА
Очень часто при работе над макетом публикации 
у вас еще нет окончательного варианта текста. 
Однако это не проблема, та как в InDesign можно 
использовал» подстановочный текст. Подготовив 
колонки, щелкните в текстовом блоке правой кноп-
кой мыши (комбинация <Соntrol+щелчок>), после 
чего из появившегося меню выберите команду Fill 
With Placeholder Text (Заполнить подстановочным 
текстом). Блок будет заполнен текстом, который 
можно использовать до тех пор, пока вы не полу-
чите настоящий текст от писателей (которые чаще 
всего затягивают свою работу).

СОВЕТ ДЛЯ РЕДАКТОРОВ ГАЗЕТ И ЖУРНАЛОВ
Если вы работаете в редакции журнала или газеты, то наверняка со-
трудничаете с авторами и платите им за определенный объем текста. 
А значит, вам необходимо уметь определять количество слов в тексте. 
И InDesign в данном случае может прийти вам на помощь. Разместите 
текстовые блоки на странице таким образом, как они будут выглядеть в 
публикации, после чего из меню Type (Текст) выберите команду Fill With 
Placeholder Text (Заполнить подстановочным текстом) для заполнения 
текстовых блоков подстановочным текстом. После этого воспользуй-
тесь встроенным средством подсчета слов InDesign, выбрав команду 
Info (Сведения) из меню Wndow (Oкно). Соответствующие сведения 

будут представлены в нижней части палитры Info (Сведения). Если вы не видите сведений о статистике, они 
скрыты. Для их отображения выберите команду Show Options (Показать параметры) из меню палитры Info 
(Сведения).
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СОЗДАНИЕ СОБСТВЕННОГО ПОДСТАНОВОЧНОГО
ТЕКСТА

Если вам не нравится стандартный подстановочный текст InDesign, можно со-
здать собственный вариант подстановочного текста и использовать его вместо 
стандартного. Откройте текстовый файл с подходящим текстом, после чего со-
храните его под именем Placeholder. txt. Данный файл следует сохра-
нить в папке InDesign. После этого текст из файла будет использован в качестве 
подстановочного.

ПЕРЕКЛЮЧЕНИЕ ПАРАМЕТРОВ ТЕКСТА И АБЗАЦА В 
ПАЛИТРЕ CONTROL

При активном инструменте Type (Текст) в палитре Control (Управление) можно отображать как параметры 
текста, так и абзаца. Для переключения между двумя вариантами компоновки нажмите комбинацию клавиш 
<Alt+Ctrl+7> (<0ption+�+7>). Вы думаете, полезно ли это?  Чрезвычайно!

Параметры текста

Параметры абзаца
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БЫСТРЫЙ ДОСТУП К УСТАНОВКАМ ТЕКСТА

Если при использовании инструмента Type (Текст) 
вам потребовалось отобразить установки текста, 
щелкните на значке Superscript (Верхний индекс), 
Subscript (Нижний индекс) или Small Caps (Малые 
прописные) в палитре Control (Управление) при 
нажатой клавише <Alt> (<0ption>).

На вкладке Text (Текст) диалогового окна 
Preferences (Установки), помимо всего прочего, 
можно задать значения параметров Superscript 
(Верхний индекс), Subscript (Нижний индекс) или 
Small Cap (Малая прописная).

ВИЗУАЛЬНЫЙ СПОСОБ ИЗМЕНЕНИЯ КЕРНИНГА
При необходимости задать расстояние между двумя символами пользователи обычно обращаются к палит-
ре Character (Символ) и вручную задают необходимое значение в текстовом поле Kevninq (Кернинг). Однако 
кернинг все-1аки оценивается визуально, поэтому на самом деле к указанию числовых значений следует при-
бегать в последнюю очередь. В остальных случаях кернинг желательно задавать визуальным способом. Щел-
кните между символами, значение кернинга для которых следует изменить, после чего нажмите комбинацию 
клавиш <Alt+←> (Option+←) для уменьшения расстояния или же комбинацию клавиш <Alt+→> (<Option+→>)  
- для его увеличения. Чтобы перейти к следующей паре символов, используйте клавиши <←> и <→>, после 
чего добавьте к ним клавишу <Alt> (<0ption>).
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ЗАЧЕМ В ТЕКСТОВОМ ПОЛЕ KERNING ИСПОЛЬЗУЮТСЯ 
СКОБКИ

В InDesign таким образом указывается на то, что значение в поле было 
получено при использовании такого средства программы, как Auto 
Kerning (Автоматически кернинг), которое автоматически задает зна-
чение кернинга для так называемых кернинговых пар - пар символов, 
которые плохо различимы при использовании стандартных значений 
кернинга. Конечно же, ничто не мешает вам в случае необходимости 
изменить значение кернинга, но все же значение, указанное в скобках, 
оказывается наиболее предпочтительным.

ВИЗУАЛЬНЫЙ СПОСОБ ИЗМЕНЕНИЯ ТРЕКИНГА
Какое же значение задать при настройке тренинга (расстояния между выделенными символами или словами)? 
Этого не знает никто, поскольку подобные операции лучше выполнять визуальным, а не математическим 
способом. Именно поэтому вам обязательно следует знать следующие комбинации клавиш. Выделив символы 
или слова, расстояние между которыми необходимо настроить, нажмите комбинацию клавиш <Alt+←> 
(<0ption+←>) для уменьшения расстояния или же комбинацию клавиш <Alt+→> (<0ption+→>) – для его 
увеличения.
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НАСТРОЙКА МЕЖДУСТРОЧНОГО ИНТЕРВАЛА ВРУЧНУЮ
Настройка расстояния между строками текста (которое принято называть междустрочным интервалом или 
интерлиньяжем) - это еще один пример того. кода значения параметров лучше задавать визуальным, а не ма-
тематическим способом. Выделив строки слова, расстояние между которыми необходимо настроить, нажмите 
комбинацию клавиш <Alt+↑> (<Option+↑>) для уменьшения расстояния или же комбинацию клавиш <Alt+↓> 
(<0ption+↓>) - для его увеличения.

ВИЗУАЛЬНЫЙ СПОСОБ ИЗМЕНЕНИЯ МАСШТАБА
ПО ГОРИЗОНТАЛИ

Вам необходимо растянуть или сжать текст по горизонтали, избежав необходимости задавать необходимое 
значение в текстовом поле Horizontal Scale (Масштаи по горизонтали) в палитре Character (Символ)? Попробуй-
те воспользоваться данным приемом.

Выбрав инструмент Selection (Выделение), выделите текстовый блок, после чего, удерживая нажатой клавишу 
<Ctrl> (<�>), щелкните на одном из центральных боковых маркеров и перетащите его внутрь (относительно 
текста), чтобы сжать текст, или наружу, чтобы растянуть его.
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КАК БЫСТРО ЗАДАТЬ МАСШТАБ ПО ГОРИЗОНТАЛИ 
РАВНЫМ 100%

Как вам уже должно быть известно, масштаб по горизонтали изме-
няется для того, чтобы буквы были шире (в данном случае задается 
значение 120% или 130%) или уже (например, я в данном случае задаю 
значение 95%). Однако очень часто возникает необходимость быстро 
задать масштаб по горизонтали равным 100%. Как же это сделать? 
Все оказывается достаточно просто. Выделив необходимый фрагмент 
текста, нажмите комбинацию клавиш <Shift+Ctrl+X> (<Shift+�+X>), 
чтобы восстановить стандартное значение масштаба по горизонтали 
– 100%.

НЕ ЗНАЕТЕ ТОЧНОЕ ЗНАЧЕНИЕ РАЗМЕРА ШРИФТА
В ПУНКТАХ? ПРОСТО ПЕРЕТАЩИТЕ НАДПИСЬ

При необходимости значительно увеличить размер шрифта можно прибегнуть как к математическому, так и 
к визуальному способу. Вместо того, чтобы выделять текст и указывать необходимое значение в текстовом 
поле Font Size (Размер шрифта), выберите инструмент Selection (Выделение) и щелкните в текстовом блоке. 
После этого, удерживая нажатой комбинацию клавиш <Shift+Ctrl> (<Shirt+�>), щелкните на угловом маркере и 
перетащите его по диагонали наружу, чтобы увеличить размеры шрифта, или внутрь, чтобы уменьшить их.
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КАК ИЗМЕНИТЬ ПАРАМЕТРЫ СРАЗУ НЕСКОЛЬКИХ 
ТЕКСТОВЫХ БЛОКОВ

Чтобы изменить атрибут (например, шрифт, междустрочный интервал и т.д.) сразу для нескольких текстовых 
блоков, щелкните на каждом из них при нажатой клавише <Shift> инструментом Selection (Выделение). Затем 
выберите инструмент Type (Текст) и в палитре Control (Управление) внесите необходимые изменения. При этом 
изменения будут применены сразу ко всем выделенным текстовым блокам.

КАК ПРИМЕНИТЬ ФОРМАТИРОВАНИЕ СИМВОЛА
К НЕСКОЛЬКИМ ТЕКСТОВЫМ БЛОКАМ

Это один из наших самых любимых советов, касающихся работы в InDesign CS, – он значительно упрощает 
нашу жизнь при настройке параметров текста. Если вы определили все необходимые стили форматирования 
символов, вам не нужно последовательно их применять. Как и в предыдущем совете, щелкните на каждом 
из текстовых блоков при нажатой клавише <Shift> инструментом Selection (Выделение), после чего в палитре 
Character Styles (Стили символа) или Paragraph Styles (Стили абзаца) щелкните на нужном стиле. Он мгновенно 
будет применен ко всем текстовым слоям. Что тут сказать... Жизнь прекрасна!
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ОТОБРАЖЕНИЕ ДИАЛОГОВОГО ОКНА
NEW CHARACTER STYLE

Вам необходимо быстро отобразить диалоговое окно New Character Style (Создание стиля символа)? В палит-
ре Control (Управление) дважды щелкните на значке “А”, расположенном слева от раскрывающегося списка 
Character Styles (Стили символа). Диалоговое окно New Character Style (Создание стиля символа) немедленно 
будет отображено на экране.

СМЕЩЕНИЕ БАЗОВОЙ ЛИНИИ БЕЗ ОБРАЩЕНИЯ К 
ПАЛИТРЕ CHARACTER

Чтобы сместить определенный объект вверх (например, символ ®) или вниз (например, цифру 2 в формуле 
Н2О) относительно базовой линии, используйте комбинации клавиш. Выделив необходимый символ, нажмите 
комбинацию клавиш <Shift-Alt+↑> (<Shift+Option+↑>) для смещения символа вверх или же комбинацию клавиш 
<Shift+Alt+↓> (<Shift+Option+↓>) - для его смещения вниз.
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КАК ИЗБАВИТЬСЯ ОТ ДВОЙНЫХ ПРОБЕЛОВ
Если вы импортировали текст из документа, со-
зданного с помощью текстового процессора, очень 
велика вероятность того, что перед предложения-
ми содержится по два пробела (поскольку привыч-
кой добавлять двойные пробелы страдают многие 
пользователи, в свое время много печатавшие на 
печатной машинке). Однако то, что хорошо в слу-
чае печатной машинки (с ее символами равной 
ширины), в настольных издательских системах вы-
глядит просто ужасно, поэтому двойные пробелы 

необходимо обязательно удалять. Выберите команду Edit⇒Find/Change (Правка⇒Найти/Заменить). Щелкни-
те в текстовом поле Find What (Найти), после чего дважды нажмите клавишу <Spacebar> (ведь нам необходимо 
искать двойные пробелы, не так ли?). Затем перейдите к текстовому полю Change To (Заменить на) и нажмите 
клавишу <Spacebar> один раз. Теперь щелкните на кнопке Change All (Заменить все), чтобы заменить все 
двойные пробелы одиночным и. Достаточно просто, не так ли?

КАК ИЗБАВИТЬСЯ ОТ ЛИШНИХ СИМВОЛОВ
Если вы преобразовали документ QuarkXPress в 
формат InDesign, то в документе могут появиться 
лишние символы (например, очень часто в словах 
возникает символ %) (по крайней мере, в нашей 
практике подобное происходит достаточно часто). 
Однако InDesign позволяет достаточно быстро из-
бавляться от подобных неприятностей. Сначала 
выделите лишний символ, после чего нажмите 
комбинацию клавиш <Ctrl+C> (<�+С>) для его 
копирования в буфер обмена. Затем выберите 
команду Edit=>Find/Change (Правка=>Найти/За-
менить). Щелкните в текстовом поле Find What 
(Найти) и нажмите комбинацию клавиш <Ctri+V> 
(<�+V>), чтобы вставить в него предварительно 
скопированный символ. Оставив текстовое поле 
Change To (Заменить на) пустым, щелкните на 
кнопке Change All (Заменить все).

В результате все лишние “неправильные” символы будут удалены. Совсем несложно, не так ли?
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КАК ЕЩЕ БЫСТРЕЕ ИЗБАВИТЬСЯ ОТ НЕПРАВИЛЬНЫХ 
СИМВОЛОВ

В предыдущем разделе вы узнали, как избавить-
ся от лишних “неправильных” символов, которые 
появляются в документе при импортировании или 
преобразовании документа QuarkXPress в InDesign. 
При этом мы предлагали вам использовать ко-
манду Find/Change (Найти/Заменить) из меню Edit 
(Правка). Если вы один раз выполнили подобную 
операцию, то ее повторное применение вообще не 
составит никакого труда. Почему? Дело в том, что 
InDesign запоминает 15 последних замен. Поэтому 
если вам необходимо обработать еще один преобразованный документ, вам не придется снова копировать 
лишний символ в текстовое поле Find What (Найти) - его достаточно просто выбрать из одноименного рас-
крывающегося списка. При обработке нескольких импортированных документов данный совет поможет вам 
сэкономить немало времени.

КАК БЫСТРО ПРЕОБРАЗОВАТЬ ВСЕ БУКВЫ
В ПРОПИСНЫЕ

Если вы ввели текст, а затем решили преобразовать все буквы в прописные, это займет у вас не более трех 
секунд. Выделив соответствующий текст, нажмите комбинацию клавиш <Shift+Ctrl+K> (<Shift+�+K>).



InDesign CS
Советы знатоков

59Глава 2 • Настройка параметров текста

БЫСТРОЕ ВЫДЕЛЕНИЕ ПОЛЕЙ В ПАЛИТРЕ CHARACTER
Когда вам в следующий раз потребуется внести изменения в палитре 
Character (Символ), можете не пытаться попасть в крошечное поле, 
чтобы ввести в нем необходимое значение. Вместо этого достаточно 
щелкнуть на значке поля. В результате значение, указанное в поле, 
будет выделено автоматически, поэтому вам останется только ввести 
новое значение.

БЫСТРАЯ НАСТРОЙКА ПАРАМЕТРОВ ТЕКСТА
В ПАЛИТРЕ CHARACTER

Иногда мы стараемся избегать обращения к палитре Character (Сим-
вол), однако если вам все-таки приходится работать с ней, данный 
совет позволит вам делать это гораздо быстрее. Вы уже знакомы с 
предыдущим советом, поэтому знаете, как быстро выделить значе-
ние, указанное в текстовом поле. Вместо того, чтобы вводить новое 
значение параметра, для его изменения достаточно нажать клавиши 
<↑ > и <↓>. Получив необходимое значение параметра, нажмите кла-
вишу <Enter> для его подтверждения.
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КАК БЫСТРО ВЫБРАТЬ НУЖНЫЙ ШРИФТ
ПРИ ПРОКРУЧИВАНИИ СПИСКА

Если вы не знаете, какой именно шрифт лучше всего использовать в документе, попробуйте воспользовать-
ся данным советом. Выделите необходимый фрагмент текста, после чего щелкните в текстовом поле Font 
(Шрифт) (в палитре Control (Управление), как показано на рисунке, или в палитре Character (Символ)). Затем 
нажмите клавиши <Т> и <4-> для прокручивания списка шрифтов. Каждое нажатие клавиши приводит к выбо-
ру нового шрифта, который автоматически применяется к выделенному тексту. Благодаря этому вы сможете 
подобрать подходящий шрифт намного быстрее.

КАК БЫСТРО ПЕРЕЙТИ К НЕОБХОДИМОМУ ШРИФТУ
Если вам известно название шрифта, который вы решили использовать 
в документе, то не следует прокручивать список все шрифтов, установ-
ленных в системе. Выделите поле Font (Шрифт) (в палитре Control (Уп-
равление) или Character (Символ)), после чего введите первые несколь-
ко символов в названии шрифта, чтобы сразу его выбрать. (Вам может 
понадобиться ввести 2-3 символа, пока в поле не появится именно тот 
шрифт, который вам необходим.)
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АВТОМАТИЧЕСКОЕ ИЗМЕНЕНИЕ ШРИФТОВ БЕЗ
ИСПОЛЬЗОВАНИЯ ТАБЛИЦ СТИЛЕЙ

Предположим, что вы имеете дело с документом, 
состоящим из нескольких страниц, и во всех под-
писях используется шрифт Minion Italic. Если вы 
применяете таблицу стилей, то при необходимости 
сможете очень быстро изменить шрифт на другой, 
например, на шрифт Adobe Garamond Pro Italic. Но 
как быть в том случае, если таблицы стилей пред-
варительно созданы не были? Выберите команду 
Type=>Find Font (Тексты=>Найти шрифт). Список 
всех шрифтов, используемых в документе, будет 
представлен в диалоговом окне. Щелкните на 
шрифте, который решили заменить (в данном слу-
чае это шрифт Minion Italic), после чего выберите 
необходимые значения из раскрывающихся спис-
ков Font Family (Семейство шрифтов) и Font Style 

(Стиль шрифта). (В данном случае выбран шрифт Adobe Garamond Pro Italic.) Щелкните на кнопке Change All 
(Заменить все), чтобы заменить все включения шрифта Minion Italic на шрифт Adobe Garamond Pro Italic.

ВСТАВКА ТЕКСТА В INDESIGN
Если вам необходимо вставить небольшой фрагмент текста в документ In Design (например, из Microsoft Word), 
наверное, одним из самых простых способов является следующий. Выделив необходимый фрагмент в окне 
текстового процессора, нажмите комбинацию клавиш <Ctrl+C> (<�+C>), чтобы скопировать данный фрагмент 
в буфер обмена. Затем перейдите к InDesign и нажмите комбинацию клавиш <Ctrl+V> (<�+V>) – так вы вста-
вите фрагмент. Однако существует еще более простой способ. Если оба документа отображены на экране, 
то необходимый фрагмент можно просто перетащить из документа текстового процессора в окно документа 
InDesign.
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ВСТАВКА ТЕКСТА С ПРИМЕНЕНИЕМ ТЕКУЩЕГО 
ФОРМАТИРОВАНИЯ

В предыдущих версиях InDesign при вставке текс-
та из другого приложения сохранялось его исход-
ное форматирование. Откровенное говоря, такое 
поведение программы просто выводило меня из 
себя. Можно сказать, что это была единственная 
особенность InDesign, которую я просто ненавидел. 
Однако в InDesign CS ситуация изменилась кар-
динальным образом. Теперь можно сохранять как 
исходное форматирование текста, так и применять 
к нему форматирование (шрифт, размер, между-
строчный интервал и т.д.), уже заданное в InDesign. 
Для этого перейдите на вкладку General (Общие) 
диалогового окна Preferences (Установки), выбрав 
одноименную команду из меню Edit (Правка) (на 
платформе Macintosh это меню InDesign). После 
этого в группе параметров Clipboard (Буфер обме-
на) сбросьте флажок Preserve Text Attributes When Pasting (Сохранять атрибуты текста при вставке). Только 
этой возможности для меня было достаточно, чтобы перейти к использованию InDesign CS.

ПЕРЕТАСКИВАНИЕ ТЕКСТА В INDESIGN
Если текстовый документ находится на рабочем 
столе, то его можно просто перетащить в откры-
тый документ InDesign; при этом текст автомати-
чески будет заключен в текстовый блок. Следует 
отметить, что данный прием применим и при рабо-
те с графическими изображениями.
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КОНТРОЛЬ НАД ИМПОРТИРОВАННЫМ ТЕКСТОМ
При импортировании текста в InDesign можно пол-
ностью контролировать данный процесс, удержи-
вая нажатой всего одну клавишу. Выберите коман-
ду File⇒Place (Файл⇒Разместить). В диалоговом 
окне Place (Размещение) дважды щелкните на 
значке необходимого файла при нажатой клавише 
<Shift>. В результате на экране будет отображено 
диалоговое окно Import Options (Параметры им-
порта), в котором можно задать все необходимые 
параметры импортирования (например, задать па-
раметры преобразования кавычек).

КАК СНЯТЬ ВЫДЕЛЕНИЕ СО ВСЕХ ОБЪЕКТОВ
Если в документе InDesign выделено несколько объектов, вам может 
понадобиться снять выделение сразу с них всех. Для этого выберите 
команду Edit⇒Deselect All (Правка⇒Снять выделение со всего) или 
нажмите комбинацию клавиш <Shift+Ctrl+A> (<Shift+�+A>).
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КАК БЫСТРО ПРЕОБРАЗОВАТЬ ОДНУ КОЛОНКУ
В НЕСКОЛЬКО

Если вы импортировали текст, а затем решили раз-
местить его в несколько колонок, выберите инстру-
мент Selection (Выделение) (его значок имеет вид 
черной стрелки), после чего, удерживая нажатой 
клавишу <Alt> (<0ption>), щелкните на текстовом 
блоке. В результате на экране появится диалого-
вое окно Text Frame Options (Параметры текстово-
го блока), в котором можно задать необходимое 
количество колонок. При необходимости установи-
те флажок Preview (Предварительный просмотр), 
чтобы оценить полученный результат.

ВАМ НЕОБХОДИМО ВСТАВИТЬ СИМВОЛ ™?
А КАК НАСЧЕТ ©?

Такие символы, как ©, ™, и 
®, называются специальны-
ми; InDesign позволяет доста-
точно просто вставлять их в 
документ. При необходимости 
вставить в документ специ-
альный символ щелкните 
правой кнопкой мыши (комби-
нация <Соntrol+щелчок>) и из 
появившегося контекстного 
меню выберите команду Insert 
Special Character (Вставить 
специальный символ), после 
чего выберите необходимый 
символ.
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КАК ИСПОЛЬЗОВАТЬ ГЛИФЫ
Если вы имеете представление 
о законах типографии, то знае-
те, что во многих шрифтах ис-
пользуются глифы (специаль-
ные символы, используемые 
в профессиональной типогра-
фии: дроби, альтернативные и 
печатные буквы и т.д.). Чтобы 
использовать глифы, отобра-
зите палитру Glyphs (Глифы), 
выбрав команду Туре⇒Glyphs 
(Тексты⇒Глифы). В палитре 
Glyphs (Глифы) отображаются все 
дополнительные символы для те-
кущего шрифта. Для вставки лю-
бого символа достаточно дважды 
щелкнуть на его значке.

ГЛИФЫ СЛИШКОМ МАЛЫ? УВЕЛИЧЬТЕ ИХ РАЗМЕРЫ
Если стандартный размер до-
полнительных символов в па-
литре Glyphs (Глифы) кажется 
вам слишком малым, щелкните 
на левом значке в виде гор в 
нижней части палитры, чтобы 
увеличить размеры символа 
на одну ступень. Щелкнув еще 
раз, вы еще больше увеличите 
размеры символа. Если же вам 
необходимо уменьшить раз-
меры специального символа, 
щелкните на правом значке в 
виде гор.
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ПЯТЬ КОМБИНАЦИЙ КЛАВИШ ДЛЯ ВЫДЕЛЕНИЯ ТЕКСТА
Если вам приходится достаточно много работать с текстом (например, редактировать текст), то вы сможете 
сохранить немало времени, запомнив несколько простых комбинаций клавиш.

1. Для выделения целого слова на нем достаточно дважды щелкнуть.

2. Для выделения символов, расположенных слева от курсора, нажмите комбинацию клавиш <Shift+←>. Для 
выделения символов, расположенных справа от курсора, нажмите комбинацию клавиш <Shift+→>. Каждое 
нажатие комбинации клавиш приводит к выделению дополнительных символов.

3. Чтобы выделить целую строку текста, щелкните на ней трижды.

4. Для выделения целого абзаца текста щелкните на ней четырежды (это намного проще, чем может пока-
заться).

5. И наконец, нажав комбинацию клавиш <Shift+Ctrl+\> (<Shift+�+\>), можно выделить строку, в которой нахо-
дится курсор.

Используйте эти комбинации клавиш, и вы сможете экономить время буквально каждый день.

РЕДАКТИРОВАНИЕ ПРИ ПРОВЕРКЕ ПРАВОПИСАНИЯ
На первый взгляд кажется, 
что средство проверки пра-
вописания отображается в от-
дельном диалоговом окне, но 
если на него посмотреть поб-
лиже, то становится понятно, 
что вы имеете дело с плава-
ющей палитрой. В чем состо-
ит основное различие? Да в 
том, что, работая с палитрой 
Check Spelling (Проверка пра-
вописания), можно перейти к 
документу, внести изменения, 
после чего вернуться обратно 
к палитре. Поэтому не стоит 
лишний раз щелкать на кнопке 
Ignore (Игнорировать) - лучше 
внесите исправления, после чего вернитесь к палитре Check Spelling (Проверка правописания).
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ЭКОНОМЬТЕ ВРЕМЯ ПРИ ПРОВЕРКЕ ПРАВОПИСАНИЯ
Как и большинство средств проверки правописа-
ния, средство, доступное в InDesign, позволяет 
добавлять неизвестные слова (например, назва-
ние компании или ваше имя) в словарь. Однако 
можно внести все необходимые слова в словарь 
InDesign. Выберите команду Edit=>Dictionary 
(Правка=>Словарь). В результате на экране поя-
вится диалоговое окно, в котором можно указать 
имя, название организации и другие слова, отсутс-
твующие во встроенном словаре.

ПРОВЕРКА ПРАВОПИСАНИЯ ТЕКСТОВ НА 
ИНОСТРАННЫХ ЯЗЫКАХ

InDesign CS поставляется с целым рядом встроенных словарей для 
разных языков. Если вам приходится работать с документами, на-
пример, на французском языке, у вас появляется возможность про-
верять правописание как минимум наиболее распространенных слов. 
Выделите слово на французском (немецком, итальянском, испанском 
и т.д.) языке, затем из раскрывающегося списка Language (Язык), рас-
положенного в нижней части палитры Character (Символ), выберите 
необходимый язык. Если данный список отсутствует, отобразите его, 
выполнив команду Show Options (Показать параметры) в меню палит-
ры. Теперь можно проверить правописание документа с помощью ко-
манды Edit=>Check Spelling.
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ЗАПРЕТ ПЕРЕНОСОВ СЛОВ
Если вы используете слова, которые никогда не пе-
реносятся, укажите их в словаре InDesign, выбрав 
команду Edit⇒Dictionary (Правка⇒Словарь). В по-
явившемся диалоговом окне Dictionary (Словарь) 
введите слова, указав перед ним знак ”~” (тильда). 
После ввода каждого слова следует щелкнуть на 
кнопке Add (Добавить).

КОМБИНАЦИЯ КЛАВИШ ДЛЯ ПРИМЕНЕНИЯ 
ПОЛУЖИРНОГО НАЧЕРТАНИЯ

Если при работе со старыми версиями настольных издательских систем вы выделяли текст и использовали 
комбинацию клавиш для применения полужирного начертания, программы использовали соответствующие 
варианты шрифта. Если полужирное начертание для шрифта определено не было, программы его имитиро-
вали. Как правило, полученные результаты выглядели ужасно, однако это мало кого беспокоило, поскольку в 
те времена люди имело дело с принтерами без PostScript, поэтому рассчитывать на высокое качество печати 
все равно не приходилось. Однако InDesign CS обладает гораздо более широкими функциональными возмож-
ностями. Если вы выделите фрагмент текста и нажмете стандартную комбинацию клавиш для применения 
полужирного начертания (<Shift+Ctrl+B> (<Shift+�+B>)), InDesign применит следующий вариант шрифта с 
более жирным начертанием. Если полужирное начертание для шрифта не определено, программа просто 
проигнорирует нажатие комбинации клавиш. Поэтому можете смело использовать ее при работе. То же самое 
справедливо и применительно к курсивному начертанию. Если вы нажмете комбинацию клавиш <Shift+Ctrl+l> 
(<Shift+�+l>) при использовании шрифта, курсивное начертание для которого не определено, программа так-
же проигнорирует нажатие комбинации клавиш.
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ЕСЛИ БУКВЫ СЛИВАЮТСЯ ДРУГ С ДРУГОМ 
(ИСПОЛЬЗОВАНИЕ ЛИГАТУР)

При использовании определенных пар строчных 
букв последние из-за особенностей их дизайна 
сливаются друг с другом (например, строчные 
буквы “f” и “i” в слове “finally”). Работникам типогра-
фии подобные сочетания букв очень не нравятся, 
поскольку выглядят неэстетично. По этой причине 
дизайнеры придумали лигатуры. Лигатуры -это 
“обработанные” комбинации сливающихся симво-
лов, которые выглядят намного лучше и представ-
ляют собой один символ. Практически все совре-
менные шрифты профессионального качества 
содержат лигатуры, воспользоваться которыми 
можно, выбрав команду Ligatures (Лигатуры) из 
меню палитры Character (Символ). В результате 
программа найдет в тексте соответствующие 
последовательности символов и заменит их ли-
гатурами.

КАК БЫСТРО ЗАДАТЬ ПАРАМЕТРЫ ВЫРАВНИВАНИЯ
Для выбора выравнивания текста по левому краю, по центру или по правому краю совсем не обязательно 
обращаться к палитре Paragraph (Абзац) или Control (Управление), поскольку для этого можно использовать 
комбинации клавиш <Shift+Ctrl+L> (<Shift+�+L>), <Snift+Ctri+C> (<Shift+�+C>) и <Shift+Ctrl+R> (<Shift+�+R>) 
соответственно.
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ПРАВИЛА ИСПОЛЬЗОВАНИЯ ОТСТУПОВ АБЗАЦЕВ
Отступы применяются с целью указать читателю на то, что начинается 
новый абзац. Добавить отступы к абзацам несложно. Отобразите па-
литру Paragraph (Абзац) (также можно отобразить и палитру Character 
(Символ), поскольку по умолчанию данные палитры являются вложен-
ными), после чего во втором текстовом поле сверху введите необходи-
мое значение отступа. Итак, какое же значение отступа следует зада-
вать? Большинство профессионалов сошлись на том, что достаточным 
значением для отступа является ширина прописной буквы “М” в исполь-
зуемом шрифте. Например, если применяется шрифт Myriad, значение 
отступа должно быть приблизительно равно 0,10. Однако нам наиболее 
универсальным кажется значение 0,15, которое мы и задаем при работе 
с подавляющим большинством шрифтов.

ИСПОЛЬЗОВАНИЕ “ВИСЯЧИХ” КАВЫЧЕК В ЦИТАТАХ
Если вы решили добавить ци-
тату (например, в журналах 
это практикуется достаточно 
широко), вам не обойтись без 
кавычек, не так ли? В подоб-
ных ситуациях профессионалы 
всегда используют “висячие” 
кавычки. При этом кавычки 
располагаются на одну позицию 
левее относительно гекстового 
блока (соответствующий пример 
приведен на рисунке). Создание 
“висячих” кавычек оказывается настолько важным, что компания Adobe пред-
лагает специальную палитру Story (Статья), для отображения которой следу-
ет выбрать одноименную команду из меню Type (Текст). Как только палитра 
Story (Статья) будет отображена на экране, установите флажок Optical Margin 
Alignment (Оптическое выравнивание полей), после чего задайте используемый 
вами размер шрифта.
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ДОБАВЛЕНИЕ ТЕНЕЙ К ТЕКСТУ
Вам необходимо добавить к тексту тень? (Если вы 
действительно намерены это сделать, убедитесь 
в том, что размер шрифта равен как минимум 36 
пунктам.) Выделите текстовый блок с помощью 
инструмента Selection (Выделение), после чего 
из меню Object (Объект) выберите команду Drop 
Shadow {Падающая тень). В появившемся диалого-
вом окне Drop Shadow (Падающая тень) вам сле-
дует установить флажок Drop Shadow (Падающая 
тень) (который по какой-то причине по умолчанию 
оказывается сброшенным). Затем установите 
флажок Preview (Предварительный просмотр) и, 
подобрав подходящие параметры тени, щелкните 
на кнопке ОК.
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СОГЛАСОВАНИЕ РАЗМЕРОВ ТЕКСТОВОГО БЛОКА
С РАЗМЕРАМИ ТЕКСТА

Если вам приходилось работать с предыдущими версиями InDesign (которые предшествовали InDesign CS), но-
вовведения, представленные в новой версии программы, приятно вас удивят. Раньше при вводе текста в блок 
размеры блока всегда превышали размеры текста, поэтому уменьшать размеры блока приходилось вручную. 
Теперь в этом никакой необходимости нет. Наконец-то, компания Adobe учла пожелания пользователей. Если 
размеры текстового блока превышают размеры текста, выберите инструмент Selection (Выделение) и щелкни-
те на кнопке Fit frame to content (Согласовать блок с содержимым) в палитре Control (Управление).
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КАК ПЕРЕМЕЩАТЬ ОБЪЕКТЫ ПРИ ВЫДЕЛЕННОМ 
ТЕКСТЕ

Данная возможность оказывается гораздо полезнее, чем может показаться на первый взгляд. Давайте рас-
смотрим следующий сценарий. Вы выделили фрагмент текста для изменения его параметров, увеличили раз-
мер шрифта, после чего текст начал “налазить” на другой объект на странице (фотографию, блок, графическое 
изображение и т.д.). Стоит ли вам выбирать инструмент Selection (Выделение), перемещать объект, после чего 
снова выбирать инструмент Type (Текст) и повторно выделять текст? Не очень-то удобно, не так ли? Однако 
существует и более простой способ достичь тех же результатов. При выделенном тексте нажмите клавишу 
<Ctrl> (<�>), чтобы активизировать инструмент Selection (Выделение), с помощью которого можно перемес-
тить объект. При этом текст останется выделенным. Отпустив клавишу <Ctri> (<�>), вы снова активизируете 
Type (Текст). Таким образом вам удастся сохранить немало времени. И это только один из возможных сцена-
риев. А таких сценариев, поверьте мне, сотни.

ПРЕДВАРИТЕЛЬНЫЙ ПРОСМОТР РЕЗУЛЬТАТОВ 
ОБТЕКАНИЯ ТЕКСТОМ

Если при работе с графичес-
ким изображением вы исполь-
зуете обтекание текстом, то 
при перемещении изображе-
ния обтекание текстом приме-
няется только после того, как 
вы отпустите кнопку мыши. 
Если вы хотите сразу увидеть 
результаты обтекания текс-
том изображения на его новом 
месте, щелкните на изобра-
жении и немного подождите, 
только после чего начинайте 
перетаскивание изображения.



InDesign CS
Советы знатоков

74 Глава 2 • Настройка параметров текста

ПРИМЕНЕНИЕ ГРАДИЕНТОВ К РЕДАКТИРУЕМОМУ 
ТЕКСТУ

InDesign - это одна из немногих программ, которая позволяет добавлять 
градиенты к надписям с сохранением возможности их редактирова-
ния (в большинстве других программ перед добавлением градиентов 
текст сначала необходимо преобразовать в графическое изображение, 
однако после этого невозможно изменить шрифт, междустрочный ин-
тервал, межсимвольное расстояние и т.д.). Чтобы добавить градиент 
после добавления текста, щелкните на текстовом блоке инструментом 
Selection (Выделение), после чего щелкните на значке Formatting affects 
text (Форматирование влияет на текст), расположенном под образца-
ми цвета заливки и цвета в палитре инструментов. Теперь отобразите 
палитру Gradient (Градиент) (выбрав одноименную команду из меню 
Window (Окно)) и задайте необходимые параметры градиента.

КАК БЫСТРЕЕ ПЕРЕМЕСТИТЬ ТЕКСТОВЫЙ БЛОК
Если вы вносите изменения в макет, то при необ-
ходимости переместить текстовый блок попробуйте 
воспользоваться следующим советом. Вы можете 
щелкнуть на блоке, задержать инструмент, а затем 
перетащить блок - в результате InDesign будет пос-
тоянно отображать текст, из-за чего скорость пере-
мещения станет достаточно низкой. Если же вам 
необходимо переместить блоки как можно быстрее, 
щелкните и немедленно перетащите блок. При этом 
InDesign отобразит “призрак” блока без содержи-
мого. Благодаря этому перемещение блока будет 
осуществляться намного быстрее.
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КАК ПОЛУЧИТЬ ДОСТУП К ИНСТРУМЕНТУ HAND ПРИ 
РАБОТЕ С ИНСТРУМЕНТОМ TYPE

При работе с любым инструментом, за исключением инструмента Type (Текст), нажатие клавиши <Spacebar> 
позволяет получить временный доступ к инструменту Hand (Рука) (предназначенному для перемещения до-
кумента). Работая с инструментом Type (Текст), вы сможете получить временный доступ к инструменту Hand 
(Рука), если будете удерживать нажатой клавишу <Alt> (<0ption>).

ВЫБОР ШРИФТОВ И РАЗМЕРОВ В ОКНЕ STORY EDITOR
Если вы используете средство Story Editor (Редак-
тор статей) программы InDesign CS (а значит, ско-
рее всего, вы в свое время работали в PageMaker), 
тогда вам наверняка будет интересно узнать, что 
можно изменять шрифт и его размер, используе-
мые в окне Story Editor (Редактор статей). Перей-
дите на вкладку Story Editor Display (Окно Редактор 
статей) диалогового окна Preferences (Установки), 
для отображения которого следует выбрать одно-
именную команду из меню Edit (Правка) (на плат-
форме Macintosh это меню InDesign) После этого 
задайте все необходимые параметры текста, ко-
торые хотели бы использовать при работе в окне 
Story Editor (Редактор статей).



InDesign CS
Советы знатоков

76 Глава 2 • Настройка параметров текста

ДОСТУП К ТЕКСТОВЫМ БЛОКАМ ШАБЛОННОЙ 
СТРАНИЦЫ ПРИ РАБОТЕ С ОБЫЧНОЙ СТРАНИЦЕЙ

Если вы разместили текстовые 
блоки на шаблонной странице 
документа, при работе с обыч-
ной страницей доступ к ним 
получить невозможно. Так счи-
тают многие. Воспользуйтесь 
советом, и вы получите до-
ступ. Щелкните на текстовом 
блоке при нажатой ‘.юинации 
клавиш Shirt+Ctrl> (<Shift+�>). 
В результате текстовый блок, 
размещенный на шаблонной 
странице, окажется доступным 
для редактирования и при ра-
боте с обычной страницей.

ИСПОЛЬЗОВАНИЕ “ПРАВИЛЬНЫХ” ТИРЕ
Итак, если вы работаете в InDesign, то можете 
больше не вводить текст с клавиатуры. Ведь вы 
занимаетесь версткой, а не вводом текста. Как 
профессионал, вы просто обязаны использовать 
“правильные” тире (это означает, что не следует 
использовать в качестве тире обычные дефисы). 
Предположим, что вы работаете над рекламным 
объявлением, в котором указано время прове-
дения вечеринки (20:00-22:00). В данном случае 
следует использовать короткое тире, а не дефис. 
Для добавления короткого тире достаточно на-
жать комбинацию клавиш <Alt+-> (знак “минус”) 
(<0ption+ ->). Если же вам необходимо добавить в текст длинное тире, нажмите комбинацию клавиш 
<Shift+Alt+ -> (<Shift+Option+ ->).
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НЕ ПРОСТО ПРОБЕЛ – ОСОБЫЙ ПРОБЕЛ
При работе с текстом иногда обычный пробел, 
для добавления которого используется клави-
ша <Spacebar>, оказывается слишком большим. 
Иногда вам может быть необходим пробел 
меньшего размера. Так сказать, мини-пробел. 
InDesign предлагает на выбор целый ряд “про-
фессиональных” пробелов. Выбрав команду 
Type⇒Insert White Space (Тексты⇒Вставить про-
бел), вы отобразите целый список специальных 
пробелов, в котором присутствуют и такие попу-
лярные варианты, как узкий пробел (узкая шпа-
ция) и широкий пробел (широкая шпация). Однако 
мне больше всего нравится волосяной пробел 
(волосяная шпация), равный 1/24 части широкого 
пробела.
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В настоящей главе представлены 
советы no работе с цветом в InDesign. 
Даже еспи вы считаете, что данная 
тема вам не интересна, а значит, 
материал настоящей главы можно 
пропустить, мы настоятельно рекомендуем вам этого 

ВСЕ ЦВЕТА РАДУГИ
Работа с цветом

не делать, так как нельзя наперед твердо знать, 
какие знания потребуются, а какие нет. Умение 
работать с цветом при создании макетов всегда 
считалось вершиной мастерства. Кроме того, мы 
постарались собрать в настоящей главе наиболее: 
полезные советы, знание которых позволит вам при 
случае блеснуть уровнем своего профессионализма.
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ПЕРЕТАСКИВАНИЕ ЭЛЕМЕНТОВ МЕЖДУ ПАЛИТРАМИ
Данный совет поможет вам сэкономить немало времени. Если вы создали цвет 
при работе с палитрой Color (Цвет), то для сохранения соответствующего образца 
цвета в палитре Swatches (Образцы) его достаточно перетащить из одной палит-
ры в другую. При этом курсор принимает форму руки со знаком “+” (плюс), а в 
палитре Swatches (Образцы) появляется черная горизонтальная линия, указыва-
ющая расположение нового образца в палитре.

СОЗДАНИЕ ГРАДИЕНТОВ МЕТОДОМ ПЕРЕТАСКИВАНИЯ
InDesign CS предоставляет новый способ создания градиентов методом перетас-
кивания. Щелкните на образце цвета в палитре Swatches (Образцы) и перетащи-
те его на ограничитель цвета в палитре Gradients (Градиенты). Удивительно!
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СОЗДАНИЕ СТАНДАРТНОГО НАБОРА ЦВЕТОВ
Если в качестве стандартного 
вам необходимо использовать 
какой-то особый набор цветов 
(при этом он будет автомати-
чески доступен при создании 
каждого нового докумета), сде-
лать это достаточно просто. За-
кройте все открытые докумен-
ты, перейдите к палитре Color 
(Цвет), создайте необходимые 
цвета, после чего перетащите 
их в палитру Swatches (Образ-
цы). Вот и все! При следующем 
создании нового документа 
заданные вами цвета будут ис-
пользованы как стандартные.

ЗАИМСТВОВАНИЕ ЦВЕТОВ ИЗ ДРУГОГО ДОКУМЕНТА
Если вы уже потратили время на создание пользовательских цветов в доку-
менте, их можно использовать и в других документах. Выберите команду Load 
Swatches (Загрузить образцы) из меню палитры Swatches (Образцы). В появив-
шемся диалоговом окне Open a File (Открытие файла) найдите документ, цвета 
из которого вы решили использовать, после чего щелкните на кнопке Open (От-
крыть). В результате все цвета, используемые в документе, будут отображены в 
палитре Swatches (Образцы).
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ИСПОЛЬЗОВАНИЕ СТИЛЕЙ ЦВЕТА
Если вы потратили определенное время на со-
здание узора для заливки или обводки, а затем 
решили применить их к другому объекту, вам не 
придется в дальнейшем создавать все с самого 
начала. Щелкните на новом объекте, после чего 
выберите инструмент Eyedropper (Пипетка) и щел-
кните на объекте, атрибуты которого (заливка, 
толщина линии обводки, цвет и т.д.) вы решили 
использовать. Как только вы щелкните, все эти 
атрибуты будут применены к новому объекту. Ка-
ким образом можно узнать количество атрибутов, 
копируемых инструментом Eyedropper (Пипетка)? 
Дважды щелкните на значке инструмента Eyedropper (Пипетка) в палитре инструментов для отображения 
диалогового окна Eyedropper Options (Параметры инструмента Пипетка), в котором укажите атрибуты, кото-
рые принимаются во внимание при работе с инструментом.

ЕЩЕ ОДИН ПРИЕМ РАБОТЫ С ИНСТРУМЕНТОМ 
EYEDROPPER

Итак, вы применили атрибуты одного объекта к другому. 
Но как теперь выбрать атрибуты еще одного объекта? 
Если щелкнуть на нем инструментом Eyedropper (Пипет-
ка), будут изменены атрибуты первого объекта, которые 
вы копировали изначально. Может, следует выбирать 
инструмент Selection (Выделение)? Нет! При активном 
инструменте Eyedropper (Пипетка) нажмите клавишу 
<Alt> (<0ption>) и щелкните на новом объекте.
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ЭКОНОМЬТЕ ВРЕМЯ, ПЕРЕТАСКИВАЯ ЦВЕТ
Если вам необходимо применить к объекту опреде-
ленный цвет, то это можно сделать двумя спосо-
бами. Щелкните вначале на объекте, а затем - на 
соответствующем образце в палитре Swatches (Об-
разцы) (в данном случае достаточно двух щелчков 
мышью). Второй способ заключается в следующем: 
не щелкая на объекте, просто перетащите на него 
образец цвета из палитры Swatches (Образцы) (в 
данном случае достаточно одного щелчка мышью). 
При наведении указателя на объект, к которому вы 
решили применить цвет, он примет форму руки со 
знаком “+” (плюс). Верите или нет, но, используя дан-
ный совет при назначении цвета объектам, вы смо-
жете забыть о сотнях ненужных щелчков мышью.

УДАЛЕНИЕ НЕСКОЛЬКИХ ОБРАЗЦОВ
Для удаления нескольких образцов из палитры Swatches (Образцы) 
щелкните на них при нажатой клавише <Ctrl> (<�>), после чего пере-
тащите на значек мусорной корзины в нижней части палитры Swatches 
(Образцы).
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УДАЛЕНИЕ НЕНУЖНЫХ ОБРАЗЦОВ ЦВЕТА
При необходимости отправить документ на печать 
на принтер или в типографию, вам следует убе-
диться в том, что документ максимально прост, что 
позволит избежать многих потенциальных проблем. 
Удалите все неиспользуемые образцы из палитры 
Swatches (Образцы), чтобы принтер “знал”, какие 
именно цвета используются в документе. В InDesign 
отсутствует специальная команда, поэтому вам при-
дется удалять лишние цвета в два этапа. Выберите 
команду Select All Unused (Выделить все неисполь-
зуемые) из меню палитры Swatches (Образцы). В 
результате будут выделены все неиспользуемые в 
документе образцы цвета. После этого щелкните 
на значке в виде мусорной корзины в нижней части 
палитры Swatches (Образцы), чтобы сразу удалить 
все выделенные образцы.

ОБЪЕДИНЕНИЕ ОБРАЗЦОВ
Для удаления ненужных образцов можно воспользоваться следующим 
советом. Ненужные образцы следует объединить с образцами, кото-
рые остаются в документе. Начните с того, что щелкните на образце, 
который решили оставить в документе, а затем при нажатой клавише 
<Ctrl> (<�>) щелкните на образцах, которые необходимо удалить. Для 
объединения образцов выберите команду Merge Swatches (Объединить 
образцы) из меню палитры Swatches (Объединить образцы). После 
этого останется только тот образец, на котором вы щелкнули с самого 
начала, а остальные образцы исчезнут!
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ИЗМЕНЕНИЕ ПОРЯДКА СЛЕДОВАНИЯ ОБРАЗЦОВ
Если вы хорошо знакомы с палитрой Layers (Слои) программы 
Photoshop, у вас не возникнет никаких проблем при упорядочении 
образцов цвета в InDesign, поскольку вы должны будете выполнить 
практически те же действия. Щелкните на образце цвета, который 
решили переместить, после чего перетащите его на нужное место в 
палитре Swatches (Образцы).

СОХРАНЕНИЕ ОТТЕНКОВ КАК ОБРАЗЦОВ
Создание определенного оттенка на основе цвета, выбранного в па-
литре Swatches (Образцы), - довольно простая задача: для этого до-
статочно переместить ползунок Tint (Опенок) в верхней части палитры 
от значения 100% к меньшему значению. Однако как только вы снова 
зададите для параметра Tint (Оттенок) значение 100% (возможно, при 
работе с другим образцом), полученный опенок исчезнет. Для того 
чтобы убедиться в этом, сохраните полученный оттенок как образец. 
Сначала щелкните на образце, который решили использовать в качес-
тве основы, после чего перетащите ползунок Tint (Опенок) до необхо-
димого значения. Получив требуемый опенок, щелкните на значке New 
Swatch (Создать образец) в нижней части палитры Swatches (Образ-
цы). В результате он будет сохранен как образец цвета. Теперь любые 
изменения, внесенные в палитре Соlor (Цвет), никак не будут отраже-
ны на подобранном оттенке, так как вы сохранили его как образец.
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КАК ИЗБЕЖАТЬ ПУТАНИЦЫ С ОТТЕНКАМИ
InDesign CS работает с опенками несколько не так, как вы могли по-
думать, поэтому мы решили включить в книгу данный совет, который 
поможет вам избежать путаницы. Ползунок Tint (Опенок) в палитре 
Swatches (Образец) - это на самом деле “главный” ползунок, так как 
он применяется ко всем образцам, на которых вы щелкаете. Если вы 
щелкнули на одном из образцов цвета и перетащили ползунок Tint 
(Оттенок) до значения 62%, то даже после выбора другого образца 
цвета для его параметра Tint (Оттенок) также будет задано значение 
62%. Если значение параметра Tint (Оттенок) увеличить до 100%, вы 
одновременно увеличите его и для предыдущего образца (хотя перед 
этим для параметра Tint (Оттенок) этого образца вы задавали значе-
ние 62%). Таким образом, задавая для параметра Tint (Оттенок) одного 
из образцов цвета значение 62%, вы делаете это сразу для всех образ-
цов. Так что. как говорится, имейте в виду.

ПУТАНИЦА С ОТТЕНКАМИ, ЧАСТЬ 2
Если вы подумали, что более запутанной ситуации, чем была описана 
выше, и не найти, мы посмешим вас разочаровать. Предположим, что 
вы щелкнули на образце пурпурного цвета и уменьшили значение его 
параметра Tint (Оттенок) до 40%, после чего сохранили полученный 
оттенок как новый образец (чтобы избежать его зависимости от по-
ложения ползунка Tint (Оттенок)). После этого вы повторили подобную 
операцию, задав для параметра Tint (Оттенок) значения 20% и 30%. 
Если после этого вы внесете изменения в оттенок пурпурного (напри-
мер, увеличите количество красного), эти изменения автоматически 
будут отражены и на всех остальных опенках, поскольку они связаны 
с “родительским” оттенком. Будет подобное поведение программы вос-
приниматься как удобная функция или досадная ошибка, зависит от 
вашего стиля работы.
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УКАЗАНИЕ НАЗВАНИЙ ДЛЯ ОБРАЗЦОВ ЦВЕТА
ПО ИХ ЗНАЧЕНИЯМ

Вам не удается вспомнить, какие именно оттенки 
вы использовали при работе над предыдущим ма-
кетом? Или вы пытаетесь воссоздать оттенок си-
него, который использовали в прошлом году? При 
создании нового технологического цвета в диа-
логовом окне New Color Swatch (Создание нового 
образца) по умолчанию будет установлен флажок 
Name with Color Value (Название по значению цве-
та). В результате в названии образца указываются 
значения голубого, пурпурного, желтого и черного, 
которые используются при его получении. При из-
менении образца цвета его название автоматичес-
ки обновляется.

КАК ПРИСВОИТЬ НАЗВАНИЯ ОБРАЗЦАМ
(И ЗАЧЕМ ЭТО ДЕЛАТЬ)

Как уже отмечалось в предыдущем совете, при со-
здании нового образца для него по умолчанию за-
дается название, в котором указываются значения 
голубого, пурпурного, желтого и черного, исполь-
зуемые при его получении (например, С=39, М=0, 
Y=87, К=0). Если только вы не являетесь опытным 
специалистом по допечатной подготовке, подоб-
ные названия вам вряд ли покажутся описатель-
ными. Для того чтобы задать для образца более 
подходящее название (например, “оливково-зе-
леный”), отобразите палитру Swatches (Образцы) 
и дважды щелкните на образце. В результате на 
экране появится диалоговое окно Swatch Options 
(Параметры образца). Текстовое поле Swatch 

Name (Имя образца) будет недоступно до тех пор, пока вы не сбросите флажок Name with Color Value (На-
звание по значению цвета). После этого в текстовом поле Swatch Name (Имя образца) можно ввести более 
подходящее название. Это не только позволит вам быстрее выбирать необходимые оттенки, но и облегчит 
жизнь сотруднику типографии, так как он будет точно знать, какие цвета необходимо использовать (заказные 
цвета не создаются на основе основных цветов, как технологические).
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ЗАГРУЗКА ЦВЕТОВ PANTONE
Если вас интересовал вопрос, почему цвета 
Pantone оказались скрытыми, мы вам поможем. 
Из меню палитры Swatches (Образцы) выберите 
команду New Color Swatch (Создать образец цве-
та). На экране будет отображено диалоговое окно 
New Color Swatch (Создание образца цвета). Если 
раскрыть список Color Mode (Цветовой режим), вы 
увидите список всех библиотек цветов, которые 
устанавливаются вместе с InDesign CS. Выберите 
необходимую библиотеку (в данном случае это 
библиотека PANTONE solid coated), чтобы загру-
зить соответствующий набор цветов. Для выбора 
определенного цвета достаточно ввести его но-
мер в текстовом поле PANTONE.

ИМПОРТ ТОЛЬКО НЕСКОЛЬКИХ ИЛИ ЖЕ ВСЕХ ЦВЕТОВ 
PANTONE

В предыдущем совете мы показали вам, как задать 
определенный цвет Pantone в качестве образца 
цвета, но как поступить при необходимости импор-
тировать около десяти образцов цвета Pantone? 
Или как быть, если вам необходима сразу вся 
цветовая книга? На самом деле все достаточно 
просто. Для импортирования нескольких цветов 
Pantone выберите из меню палитры Swatches (Об-
разцы) команду New Color Swatch (Создать обра-
зец цвета). Затем в раскрывающемся списке Color 
Mode (Цветовой режим) перейдете к соответству-
ющей цветовой книге Pantone. Ее содержимое 
будет немедленно отображено в списке. При 
нажатой клавише <Ctrl> (<�>) щелкайте на отде-
льных образцах Pantone, которые необходимо импортировать, после чего щелкните на кнопке Add (Добавить). 
Если вам необходимо импортировать всю цветовую книгу Pantone в палитру Swatches (Образцы), щелкните на 
первом образце, а затем прокрутите список и щелкните на последнем образце при нажатой клавише <Shift>. 
После этого щелкните на кнопке ОК. В результате вся цветовая книга Pantone будет отображена в палитре 
Swatches (Образцы), поэтому вам придется немало потрудиться, чтобы найти подходящий образец.
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БЫСТРОЕ ПЕРЕМЕЩЕНИЕ ПО ПАЛИТРЕ SWATCHES
Вам необходимо быстро перейти к определенному образцу в палит-
ре Swatches (Образцы)? Удерживая нажатой комбинацию клавиш 
<Alt+Ctrl> (<0ption+�>), щелкните в палитре Swatches (Образцы) и 
введите первую букву (или несколько букв) в названии необходимого 
образца. Это будет очень удобно в том случае, если вы загрузили всю 
цветовую книгу Pantone.

ПРАВИЛЬНЫЙ ПОДХОД К РЕАГИРОВАНИЮ ОБРАЗЦОВ
Если вы выделили какие-то объекты в документе, 
вам необходимо очень осторожно подходить к ре-
дактированию образцов цвета. Дважды щелкните 
на образце цвета в палитре Swatches (Образцы), 
чтобы отобразить диалоговое окно Swatch Options 
(Параметры образца), и соответствующий оттенок 
будет немедленно применен ко всем выделенным 
объектам. Для того чтобы избежать подобных не-
приятностей, при двойном щелчке на образце цвета 
достаточно удерживать нажатой комбинацию кла-
виш <Shift+Alt+Ctrl> (<Shift+Option+�>). В результа-
те выбранный образец цвета не будет применен к 
выделенным объектам Конечно же, если вы изме-
нили оттенок, заданный для объектов, изменения 

будут применены к объектам сразу после щелчка на кнопке ОК (однако это достаточно очевидно, не так ли?).
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РАБОТА С ЦВЕТОВОЙ ПОЛОСОЙ
В нижней части палитры Go/or (Цвет) отображается цветовая полоса, 
щелкая на которой, можно выбрать любой опенок из текущей цвето-
вой модели (RGB, LAB или CMYK). Для изменения цветовой модели 
следует выбрать соответствующую команду из меню палитры Color 
(Цвет). Однако существует и более простой способ: для переключения 
цветовых моделей щелкните на цветовой полосе при нажатой клави-
ше <Shift>.

КАК ПОЛУЧИТЬ СПЛОШНОЙ ЧЕРНЫЙ ИЛИ СПЛОШНОЙ 
БЕЛЫЙ ОДНИМ ЩЕЛЧКОМ МЫШИ

Я знаю многих опытных пользователей, которые, тем не менее, не уме-
ют быстро выбирать сплошной черный или белый цвет. В нижней час-
ти палитры Соlor (Цвет) отображается цветовая полоса, а в ее конце 
– два образца цвета, которые, как вы уже догадались, соответствуют 
белому и черному цвету. Если вам необходим один из этих цветов, до-
статочно щелкнуть на его образце
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НАСТРОЙКА ДИАПАЗОНА ЦВЕТОВ ОДНИМ ЩЕЛЧКОМ
Если вы создали оттенок, выходящий за пределы диапазона печати от-
тенков CMYK, рядом с образцом цвета над цветовой полосой в нижней 
части палитры Соlor (Цвет) появится треугольник-предостережение. 
Каким же образом можно выйти из данной ситуации? Щелкните на 
треугольнике-предостережении, чтобы программа автоматически по-
добрала ближайший цвет.

СОЗДАНИЕ БЕЗУПРЕЧНЫХ ОТТЕНКОВ
Если вы создали цвет (используя палитру Color (Цвет), конечно же), 
а затем решили, что на самом деле вам необходим более светлый от-
тенок того же цвета, воспользуйтесь данным советом. При нажатой 
клавише <Shift> щелкните на одном из ползунков. Теперь все ползунки 
будут перемещаться одновременно, что позволит получить более свет-
лый опенок (если перемещать его влево при работе с изображениями 
СМYK или вправо при работе с изображениями RGB) или более насы-
щенный оттенок (если перемещать его вправо при работе с изображе-
ниями СМYК или влево при работе с изображениями RGB).
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КАК ОТОБРАЗИТЬ В ПАЛИТРЕ COLOR ОТТЕНКИ
ОДНОГО ЦВЕТА

Вам необходимо, чтобы в палитре Соlог (Цвет) отображались оттенки одного 
цвета в диапазоне от 0% до 100%? Для этого достаточно щелкнуть на соответс-
твующем цвете в палитре Swatches (Образцы).

ПОМОЩЬ ПРИ СОЗДАНИИ ЦВЕТОВ
Не знаете, комбинация каких цветов позволит получить оливковый 
цвет? Обратите на внимание на ползунки в палитре Color (Цвет) - ведь 
они цветные. И это не просто так: ползунки как будто подсказывают, 
куда их следует перетащить для получения необходимых оттенков. 
Если вы используете режим CMYK, а ползунки выглядят черными, 
уменьшайте количество черного до тех пор, пока не появится какой-
то цвет. Если при этом вы не видите оливковый цвет, перетаскивай-
те верхний ползунок влево и наблюдайте за цветом ползунков – не 
приобретают ли они необходимый оттенок. Немного поэксперименти-
ровав, вы наверняка сможете получить необходимый опенок. (А вот 
небольшая подсказка: при необходимости получить оливковый цвет 
начинайте с перемещения зеленого цвета, после чего немного изме-
ните положение красного ползунка.)
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КАК ОТМЕНИТЬ ЗАЛИВКУ ИЛИ ОБВОДКУ,
НАЖАВ ОДНУ КЛАВИШУ

Чтобы быстро отказаться от заливки или обводки, совсем не обязательно обращаться к палитре 
инструментов - нажмите клавишу </>.

КАК ПОМЕНЯТЬ МЕСТАМИ ЦВЕТА ЗАЛИВКИ И ОБВОДКИ
Если вы подобрали подходящий цвет обводки, а затем решили, что вам необходимо использовать 
такой же цвет заливки, для этого достаточно щелкнуть на значке Swap Fill and Stroke (Обмен цве-
тов заливки и обводки) в палитре инструментов или нажать комбинацию клавиш <Shift+X>.
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ВОССТАНОВЛЕНИЕ ЧЕРНОГО ЦВЕТА ОБВОДКИ
И ОТКЛЮЧЕНИЕ ЗАЛИВКИ

По умолчанию в InDesign CS задан черный цвет обводки, а заливка не используется (это означа-
ет, что, если вы нарисуете блок, он будет пустым внутри, а его граница будет тонкой, имеющей 
черный цвет). Чтобы быстро восстановить данные параметры, необходимо нажать ту же самую 
быструю клавишу, которая в Photoshop используется для выбора стандартных основного и фо-
нового цвета, - <D>. Кроме того, можно щелкнуть на соответствующем значке в нижней части 
палитры инструментов, как показано на рисунке.

ПЕРЕТАСКИВАНИЕ ЦВЕТОВ С ПАЛИТРЫ ИНСТРУМЕНТОВ
Раньше мы уже говорили о возможности перетаскивания 
цветов из палитры Swatches (Образцы) на объект в доку-
менте, однако то же самое можно делать и при работе с 
палитрой инструментов. Достаточно щелкнуть на образце 
цвета заливки или обводки и перетащить на объект, к кото-
рому его необходимо применить.
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ДИНАМИЧЕСКИЙ ПРОСМОТР ГРАДИЕНТОВ
Если вы создали градиентный переход, который ре-
шили применить к объекту (или надписи), то у вас 
есть возможность изменить положение ползунков 
на полосе градиента и сразу увидеть результат 
применения градиента к объекту. Щелкните на 
объекте, к которому необходимо применить гради-
ент, после чею перейдите к палитре Swatches (Об-
разцы), в которой будет отображен образец гра-
диента. Дважды щелкните на образце градиента, 
чтобы отобразить диалоговое окно Gradient Options 
(Параметры градиента) (как показано на рисунке). 
В нижней части диалогового окна расположена 
полоса градиентов, на которой представлены огра-
ничители цвета. Если установить флажок Preview 
(Предварительный просмотр) (по умолчанию он 
сброшен), любые внесенные вами изменения будут 
немедленно отражены на объекте.

ПОВТОРНОЕ ПРИМЕНЕНИЕ ГРАДИЕНТА, КОТОРЫЙ ВЫ 
ИСПОЛЬЗОВАЛИ ПОСЛЕДНИМ

Если вы недавно применили определенный градиент, его можно применить повторно, нажав кла-
вишу <.>. (Это избавит от необходимости щелкать на значке Apply gradient (Применить градиент) 
в нижней части палитры инструментов - см. рисунок.).
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УПРАВЛЕНИЕ ЦВЕТОМ ПРИ ИМПОРТИРОВАНИИ 
ФОТОГРАФИЙ

Если вы настроили параметры управления 
цветом в Adobe Photoshop, InDesign CS может 
воспользоваться некоторыми преимуществами, 
используя сведения, указанные во внедренных 
цветовых профилях цифровых изображений. 
Однако по умолчанию в InDesign CS функция 
управления цветом отключена. Чтобы активизи-
ровать ее, выберите команду Edit⇒Сolor Settings 
(Правка⇒Установки цвета) – в результате будет 
отображено диалоговое окно, хорошо извест-
ное пользователям Photoshop. В верхней части 
диалогового окна находится флажок, установив 
который, вы активизируете управление цветом. 
Что это означает? Вам открывается доступ 
к большому количеству параметров, описать 
которые можно только в отдельной книге, на-
пример Real World Color Management, написан-
ной Брюсом Фрейзером (Bruce Fraser), Фредом 
Бантингом (Fred Bunting) и Крисом Мерфи (Chris 
Murphy), которая была выпущена издательством 
Peachpit Press.

БЫСТРЫЙ СПОСОБ ОТОБРАЗИТЬ ПАЛИТРУ GRADIENT
Быстро отобразить палитру Gradient (Градиент) очень просто - достаточно дважды щелкнуть на 
значке инструмента Gradient (Градиент) в палитре инструментов.
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ПРОВЕРКА СОГЛАСОВАННОСТИ ЦВЕТОВ В КНИГЕ
Если вы работаете над книгой, журналом или 
другим проектом, в котором используется 
несколько документов, очень важно, чтобы в 
них всех были применены одни и те же образцы 
цвета (другими словами, во всех документах дол-
жен использоваться один и тот же оттенок крас-
ного). InDesign CS позволяет синхронизировать 
все образцы в документах, что- бы в них использо-
вались одинаковые опенки красного и других цветов. Выбери- те команду 
File ⇒New⇒Book (Файл⇒Создать⇒Книга). Сохраните книгу (в 
результате на экране будет отображена палитра Book (Кни- га)), после 
чего щелкните на значке “+” в нижней части палитры – так вы добавите 
в нее все главы, синхронизацию которых необходимо выпол-
нить. Как только все главы будут отображены в палитре Book 
(Книга), выберите из меню палитры команду Synchronize Book 
(Синхронизировать книгу). По умолчанию выполняется синх-
ронизация не только образцов цвета, но и стилей символов 
и абзацев. Если вам необходимо синхронизировать только 
образцы цвета, выберите из меню палитры Book (Книга) ко-
манду Synchronize Options (Параметры синхронизации), после 
чего сбросьте флажки Character Styles (Стили символа) и 
Paragraph Styles (Стили абзаца).
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ПРИ НАЛОЖЕНИИ СИНЕГО И ЖЕЛТОГО ПОЛУЧАЕТСЯ 
ЗЕЛЕНЫЙ

Вы еще помните те времена, когда учились в начальной школе? Рисуя 
мелками нескольких цветов, мы получали совершенно иные оттенки. 
Отобразите палитру Attributes (Атрибуты), выбрав одноименную ко-
манду из меню Window (Окно). Выделите верхний объект и установите 
флажок Overprint Fill (Заливка с наложением). При печати цвет верхнего 
объекта будет смешан с цветом нижнего.

ХВАТИТ УГАДЫВАТЬ ПРИ НАДПЕЧАТКЕ!
Надпечатка – это не разгадывание загадок. Ведь вам не очень-то хо-
чется тратить краску и бумагу? Если требуется напечатать несколь-
ко объектов, расположенных друг над другом, можно сразу увидеть 
предварительный результат, выбрав команду Overprint Preview 
(Предварительный просмотр надпечатки) из меню View (Вид).
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Я уверен, что вы подумали о том, что в InDesign 
CS никто не рисует. А если кто-то это и делает, 
то особо на данную тему не распространяется.
На самом gene InDesign CS предлагает целый 
ряд инструментов для создания геометрических 

ЭФФЕКТИВНЫЕ РИСУНКИ
Рисование в InDesign

фигур, в частности, инструмент Реn, позволяющий рисовать фи-
гуры базовой формы. Конечно же, эти инструменты пригодятся 
только в том случае, если вы знаете, как рисовать. Еспи вы этого 
не умеете, то получите документ, беспорядочным образом запол-
ненный многоугольниками, прямоугольниками и овалами. Но если 
вы не умеете рисовать, стоит ли вам читать материал настоящей 
главы? Нет. Не читайте его. Пропустите его и сразу же переходи-
те к материалу следующей главы, будто настоящей главы вообще 
не существует. Не существует для вас, конечно же. Почему мы 
рекомендуем вам пропустить материал настоящей главы? Пото-
му что хотим задеть вас за живое. Поскольку мы рекомендуем 
вам не читать настоящую главу, вы ее обязательно прочтете. Для 
этого вы приложите все усилия. Вы будете внимательно читать 
каждую страницу, каждую строку, буквально каждое слово. Ви-
дите, вы сообразительнее, чем мы думали.
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РЕДАКТИРОВАНИЕ ОДНОГО ОБЪЕКТА ИЗ ГРУППЫ
Если вы сгруппировали несколько объектов, после 
чего возникла необходимость изменить масштаб 
одного из них, выберите инструмент Direct Selection 
(Прямое выделение) (его значок выглядит как пус-
тая стрелка) и щелкните на объекте, а не группе. В 
данном случае после щелчка на круге были измене-
ны его размер и цвет.

ПРЕОБРАЗОВАНИЕ НАДПИСЕЙ В ГРАФИЧЕСКИЕ 
ИЗОБРАЖЕНИЯ

Вам необходимо выполнить над надписями ка-
кие-то преобразования? Тогда надписи сначала 
потребуется преобразовать в графические изоб-
ражения. После этого надпись можно сжимать, 
растягивать, деформировать, а также выполнять 
ряд других операций, применимых к обычным гра-
фическим объектам. Для того чтобы это сделать, 
сначала выделите надпись, после чего из меню 
Type (Текст) выберите команду Create Outlines (Со-
здать контуры). В результате буквы будут преоб-
разованы в контуры (такие же, какие можно было 
бы создать с помощью инструмента Реn (Перо)). 
Поскольку теперь вы имеете дело с контурами, 
для изменения их формы используйте инструмент 
Direct Selection (Прямое выделение), а для добавления, удаления и редактирования узловых точек – инстру-
мент Реn (Перо).
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СГЛАЖИВАНИЕ КОНТУРОВ
Вы получили неровный контур? (Подобное проис-
ходит регулярно, особенно в том случае, если для 
их создания используется мышь, а не графический 
планшет Wacom.) Как правило, проблема связана 
с тем, что контур содержит очень много узловых 
точек. Для сглаживания контуров предназначен 
специальный (надо признать, очень функциональ-
ный) инструмент Smooth (Сглаживание). Выберите 
инструмент Smooth (Сглаживание) (в палитре инс-
трументов он занимает одну ячейку с инструмен-
том Pencil (Карандаш)), после чего обработайте 
им участки контура, содержащие слишком много 
точек. В результате лишние точки будут удалены 
с сохранением исходной формы контура (конечно 
же, насколько это возможно). Теперь контур вы-
глядит намного лучше!

РАЗМЫТИЕ ГРАНИЦ ОБЪЕКТОВ
При необходимости размыть границы объекта щел-
кните на нем правой кнопкой мыши (комбинация 
<Сопtгоl+щелчок>) и выберите из появившегося 
меню команду Feather (Растушевать). В появив-
шемся диалоговом окне Feather (Растушевка) за-
дайте необходимую степень размытия Поскольку 
по умолчанию флажок Preview сброшен, то при не-
обходимости заранее оценить результаты данный 
флажок следует установить.
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ЭФФЕКТЫ ПРОСВЕЧИВАНИЯ
Если при работе в InDesign требуется добавить 
надпись, через которую должно просвечиваться 
графическое изображение, вам обязательно сле-
дует ознакомиться с данным советом. С помощью 
инструмента Rectangle (Прямоугольник) нарисуйте 
прямоугольную область над участком изобра-
жения, над которым должен появиться текст. 
Залейте прямоугольник белым (или другим подхо-
дящим) цветом, выбрав его из палитры Swatches 
(Образцы). После этого выберите из меню Window 
(Окно) команду Transparency (Прозрачность) для 
отображения одноименной палитры. Уменьшайте 
значение параметра Opacity (Непрозрачность) до тех пор, пока не увидите изображения под прямоугольной 
областью. Теперь можно добавлять текст.

ОПРЕДЕЛЕНИЕ КОЛИЧЕСТВА СТОРОН 
МНОГОУГОЛЬНИКА

Если требуется задать количество сторон много-
угольника, перед его созданием дважды щелкните 
на значке инструмента Polygon (Многоугольник), 
который занимает в палитре инструментов одну 
ячейку с инструментом Rectangle (Прямоуголь-
ник) – так вы отобразите диалоговое окно Polygon 
Settings (Установки многоугольника). Здесь можно 
задать количество сторон, а также “глубину” звез-
ды в поле Star Inset (Глубина звезды).
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ИЗМЕНЕНИЕ ПАРАМЕТРОВ МНОГОУГОЛЬНИКОВ
НА ЛЕТУ

Этот совет позволит изменить количество сторон 
многоугольника при его создании. При перетас-
кивании инструмента для увеличения количества 
сторон нажмите клавишу <↑>, а для уменьшения 
- клавишу <↓>. Чтобы изменить количество точек 
на контуре, следует нажать клавишу <←> или 
<→>.

ЭКСПЕРИМЕНТЫ С РАЗМЕРОМ
Если вам необходимо изменить размеры объекта, однако вы не уве-
рены в том, какое именно процентное значение задать, данный совет 
позволит вам сэкономить немало времени. Указав определенное зна-
чение в палитре Control (Управление) или Transform (Преобразование), 
не спешите сразу нажимать клавишу <Enter> (<Return>). Вместо этого 
нажмите комбинацию <Shift+Enter> (<Shift+Return>). В результате мас-
штаб объекта будет изменен, однако соответствующее текстовое поле 
останется выделенным. Это позволит быстро ввести новое значение, 
избежав необходимости повторно выделять поле. Данный совет поз-
волит вам выполнять работу намного быстрее.
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ИСКУССТВО МАСШТАБИРОВАНИЯ БЛОКОВ
Это очень полезный совет, он также позволит 
сэкономить время. Если после создания блока и 
импортирования в него графического изображе-
ния у вас возникла необходимость изменить его 
масштаб, то действия, которые необходимо вы-
полнить, зависят от используемого инструмента. 
Например, если щелкнуть на кадре инструментом 
Selection (Выделение) (его значок имеет вид чер-
ной стрелки), то в результате нажатия комбина-
ции клавиш <Shift+Ctrl> (<Snift+�>) будет изменен 
масштаб и блока, и вставленного в него объекта. 
Однако если той же комбинацией клавиш восполь-
зоваться после щелчка на кадре инструментом 
Direct Selection (Прямое выделение) (его значок 
имеет вид пустой стрелки), будет изменен только 
масштаб объекта, вставленного в блок. Как види-
те, полученные результаты в значительно мере 
зависят от используемого инструмента.

КАК УСКОРИТЬ ПРОЦЕСС СОЗДАНИЯ КОПИЙ
Создавая копию объекта или текстового блока, не 
обязательно тратить время на выполнение опера-
ций копирования и вставки. Вместо этого щелкни-
те инструментом Selection (Выделение) или Direct 
Selection (Прямое выделение) на объекте при на-
жатой клавише <Alt> (<0ption>), затем перетащите 
объект для создания его копии. Если щелкнуть на 
объекте при нажатой клавише <Alt> (<0ption>), 
курсор примет вид двух стрелок. При перетаски-
вании отображаются только границы кадра, но как только вы отпустите кнопку мыши, будет отображено и 
его содержимое.
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ВЫДЕЛЕНИЕ ОБЪЕКТА, РАСПОЛОЖЕННОГО ЗА ДРУГИМ 
ОБЪЕКТОМ

Чтобы переместить объект (надпись или графичес-
кое изображение), расположенный за другим объ-
ектом, щелкните на “закрывающем” объекте при 
нажатой клавише <Ctrl> (<�>). В результате будет 
выделен объект, расположенный за ним. Если объ-
ект скрыт под несколькими объектами, щелкайте 
на переднем объекте при нажатой клавише <Ctrl> 
(<�>) до тех пор, пока не будет выделен необходи-
мый вам объект.

ВЫДЕЛЕНИЕ ОБЪЕКТА, РАСПОЛОЖЕННОГО ЗА ДРУГИМ 
ОБЪЕКТОМ (ВАРИАНТ 2)

Для выделения объекта, скрытого за другим объек-
том также можно щелкнуть правой кнопкой мыши 
(комбинация <Control+щелчок>) на верхнем объек-
те, после чего выбрать из появившегося контекс-
тного меню команду Next Object Below (Следующий 
объект снизу).
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ПЕРЕМЕЩЕНИЕ ОБЪЕКТОВ ВВЕРХ ИЛИ ВНИЗ
Если один объект скрывает другой, его можно пе-
реместить под нижний объект, нажав комбинацию 
клавиш <Ctrl+[> (<�>). В данном случае звезда 
располагалась под квадратом, однако после выде-
ления квадрата и нажатия указанной комбинации 
клавиш квадрат оказался расположенным под звез-
дой. Чтобы звезда снова оказалась под квадратом, 
достаточно нажать комбинацию клавиш <Ctrl+]> 
(<�+]>).

ПРОДОЛЖАЕМ ПЕРЕМЕЩАТЬ ОБЪЕКТЫ ВВЕРХ
ИЛИ ВНИЗ

Еще один способ перемещения объектов вверх 
и вниз состоит в следующем. Щелкнув на объ- 
екте правой кнопкой мыши (комбинация 
<Сопtrоl+щелчок>), выберите в появившемся 
меню команду Arrange (Упорядочить). После этого 
в подменю перейдите к команде Send Backward 
(Переместить на уровень вниз), чтобы переместить 
выделенный объект на один уровень вниз, или к 
команде Send to Back (Переместить назад), чтобы 
переместить выделенный объект на самый нижний 
уровень.
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КАК ЗАДАТЬ СТАНДАРТНЫЙ ЦВЕТ ЗАЛИВКИ
И ОБВОДКИ

По умолчанию в InDesign в качестве цвета заливки и обводки используется черный цвет, однако 
ничто не мешает вам задать и более подходящие варианты. Запустите InDesign, но не создавай-
те и не открывайте никаких документов. Отобразив палитру Svatches (Образцы), щелкните на 
значке Fill (Заливка) и выберите подходящий цвет. Затем выполните эти же действия, щелкнув 
на значке Stroke (Обводка). Заданные вами цвет заливки и обводки теперь будут использоваться 
по умолчанию.

АВТОМАТИЧЕСКОЕ ДОБАВЛЕНИЕ И УДАЛЕНИЕ ТОЧЕК 
НА КОНТУРЕ

При создании контура с помощью инструмента Реn 
(Перо) может возникнуть необходимость удалить 
только что добавленную узловую точку. Вам на-
верняка известно, что предварительно необходи-
мо выбрать из палитры инструментов инструмент 
Delete Anchor Point (Удаление узловой точки). Но на 
самом деле это совсем необязательно. Добавлять и 
удалять узловые точки можно и при работе с обыч-
ным инструментом Реn (Перо). Если его навести на 
существующую точку, он временно превратится в 
инструмент Delete Anchor Point (Удаление узловой 
точки), а значит, вам остается только щелкнуть 
на “лишней” точке для ее удаления. Чтобы доба-
вить узловую точку, просто наведите инструмент 
Реn (Перо) на соответствующий участок контура. 
В результате инструмент Реn (Перо) временно 

превратится в инструмент Add Anchor Point (Добавление узловой точки). Как видите, инструмент Pen (Перо) 
оказывается достаточно функциональным.
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КАК ПЕРЕМЕСТИТЬ ТОЛЬКО ОДНУ ЧАСТЬ КРИВОЙ
Если вы создали кривую с помощью инструмен-
та Реn (Перо), то при необходимости изменить 
форму кривой вы обязательно увидите две на-
правляющие линии. Изменяя положение этих ли-
ний, можно соответствующим образом изменить 
форму кривой. Если при этом потянуть одну ли-
нию вверх, то другая опустится вниз. Однако су-
ществует прием, который позволит переместить 
только одну направляющую линию, оставив по-
ложение другой без изменений. Нажмите комби-
нацию клавиш <Shift+C> для выбора инструмента 
Convert Direction Point (Преобразование направля-
ющей точки), которым щелкните на одной из направляющих точек на направляющей линии. Теперь можно 
оказывать влияние только на одну часть кривой. Вы даже не представляете, насколько этот маленький совет 
позволит изменить всю вашу жизнь.

КАК ЗАВЕРШИТЬ СОЗДАНИЕ ОДНОГО КОНТУРА
И ПЕРЕЙТИ К ДРУГОМУ

Если при создании открытого контура вам потре-
бовалось приступить к созданию нового контура, 
предварительно не замыкая предыдущий, попро-
буйте воспользоваться данным советом. Смести-
те инструмент с контура и щелкните при нажатой 
клавише <Ctrl> (<�>). В результате с первого 
контура будет снято выделение, и вы сможете 
приступить к созданию нового контура.
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КАК УДАЛИТЬ ОДНУ НАПРАВЛЯЮЩУЮ ТОЧКУ
НА КРИВОЙ

Итак, вам прекрасно известно, что каждая узло-
вая точка имеет две направляющие линии и две 
направляющие точки. Однако знаете ли вы, что 
это совсем не обязательно? Чтобы удостоверить-
ся, воспользуйтесь инструментом Direct Selection 
(Прямое выделение) для выделения узловой точки, 
одну из направляющих линий которой вам необ-
ходимо удалить. Перетаскивайте направляющую 
точку по направлению к центру до тех пор, пока она 
не соприкоснется с узловой точкой. Как только это 
произойдет, узловая точка исчезнет.

НАРЕЗКА СЫРА. КАК СОЗДАТЬ ПОЛОВИНУ 
ОКРУЖНОСТИ

Если вы когда-нибудь пытались нарисовать поло-
вину окружности, то знаете, насколько это может 
быть проблематично. Данный совет позволит 
вам выполнять подобные операции очень быст-
ро и легко. Воспользуйтесь инструментом Ellipse 
(Овал) для создания идеальной окружности (для 
этого при перетаскивании инструмента достаточ-
но удерживать нажатой клавишу <Snift>). Затем 
воспользуйтесь инструментом Scissors (Ножницы) 
для “вырезания” двух боковых точек. Теперь вам 
остается только удалить ненужную половину ок-
ружности.
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УКАЖИТЕ НА ВАЖНЫЙ ЭЛЕМЕНТ С ПОМОЩЬЮ 
СТРЕЛКИ

Если простых линий для привлечения внимания к объекту не доста-
точно, используйте стрелки. Нарисуйте линию, после чего перейдите к 
палитре Stroke (Обводка) и выберите из ее меню команду Show Options 
(Показать параметры). Используя раскрывающийся список Start (Нача-
ло) или End (Конец), выберите подходящую форму стрелки. Убедитесь 
в том, что для параметра Weight (Толщина) задано необходимое зна-
чение.
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Это достаточно большая глава. Почему? 
Да потому, что она посвящена работе 
со страницами макета, добавлению и 
редактированию страниц, добавлению 
к ним нумерации, созданию шаблонных 
страниц, а также многим другим темам.

ПЕРЕЛИСТЫВАЕМ СТРАНИЦЫ
Работа со страницами

Если вы работаете только с однострочными докумен-
тами, нужно пи вам читать материал настоящей гла-
вы7 Конечно да! Потому что в ее последних разделах 
представлены советы, которые окажутся полезными 
независимо от того, с документами какого размера вам 
приходится работать. С какими бы докуменпчами вы ни 
имели бы депо, материал настоящей главы будет для 
вас очень полезным.
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ПЕРЕТАСКИВАНИЕ СТРАНИЦ MEЖДУ ДОКУМЕНТАМИ
Эта новая возможность InDesign CS оказывается 
очень полезной. Если вам необходимо скопировать 
страницу из одного документа в другой, ее можно 
перетащить. Убедившись в том, что оба документа 
открыты, перейдите к палитре Pages (Страницы). 
После этого щелкните на странице, которую не-
обходимо скопировать, и перетащите ее на место 
предполагаемой новой страницы. Вот и все!

СОЗДАНИЕ ИЕРАРХИЧЕСКИХ ШАБЛОННЫХ СТРАНИЦ
Я прекрасно знаю, что вы подумали: всегда можно создать две шаблон-
ные страницы, однако иерархические шаблонные страницы оказывают-
ся гораздо предпочтительнее! Предположим, что вы готовите страницы 
для каталога; при этом на каждой странице должны быть представлены 
такие элементы, как логотип, адрес URL Web-узла, а также цветная 
полоса. Однако каталог также разделен на несколько разделов, для 
которых также необходимо указать название, цветную полосу и другие 
элементы. Данный совет значительно упростит выполнение подобных 
задач. Сначала создайте первую шаблонную страницу, используя стан-
дартную страницу A-Master. Эта страница будет использована во всем 
документе. Затем создайте шаблонную страницу для первого раздела, 
выбрав команду New Master (Создать шаблонную страницу) из меню 
палитры Pages (Страницы). Теперь разместите основную шаблонную 
страницу над шаблонной страницей раздела. На шаблонной странице раздела будут содержаться все элемен-
ты основной. При внесении изменений в основную шаблонную страницу они будут автоматически отображать-
ся в шаблонных страницах.
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ЗАДАВАЙТЕ ТАКОЙ РАЗМЕР МАКЕТА, КОТОРЫЙ ВАМ 
ДЕЙСТВИТЕЛЬНО НЕОБХОДИМ

Нет ничего хуже, чем неожиданная необходи-
мость изменять размеры макета. Однако от этого 
никто не застрахован. Предположим, что вам не-
обходимо задать для макета вместо книжной ори-
ентации альбомную. Вы можете вручную изменить 
расположение элементов, а можете воспользо-
ваться данным советом. Выберите команду Layout 
Adjustment (Корректировка макета) из меню Layout 
(Макет), после чего в появившемся диалоговом 
окне установите флажок Enable Layout Adjustment 

(Разрешить корректировку макета). Теперь при изменении размеров или ориентации страницы InDesign будет 
стараться максимально сохранить размещение объектов, лишь при необходимости изменяя их размеры и по-
ложение.

СОЗДАНИЕ РАЗВОРОТНОГО СГИБА
Когда вам в следующий раз потребуется создать разворотный сгиб, попробуйте воспользоваться данным со-
ветом. Отобразив палитру Pages (Страницы), выберите из ее меню команду Allow Pages to Shuffle (Разрешить 
перетасовывание страниц). Теперь при перетаскивании страниц относительно друг друга в палитре Pages 
(Страницы) (вам необходимо разместить страницу рядом с другой таким образом, чтобы появилась черная 
вертикальная линия, как показано на рисунке по центру) страницы будут расположены друг за другом. Подоб-
ные сгибы обычно состоят из трех страниц.
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СОЗДАНИЕ ШАБЛОНА
Если вы создали документ, ко-
торый регулярно публикуется 
с минимальными изменения-
ми, имеет смысл создать его 
шаблон вместо того, чтобы 
несколько раз обращаться к по-
мощи команды Save As (Сохра-
нить как). Использовать шабло-
ны намного эффективнее, вы 
сможете избежать случайного удаления нужного документа при пересохранении. Создайте все необходимые 
блоки и другие элементы, используемые в документе. Затем выберите команду Save As (Сохранить как) из 
меню File (Файл). Из раскрывающегося списка Format (Тип файла) выберите значение InDesign CS template 
(Шаблон InDesign) и щелкните на кнопке Save (Сохранить). После этого создание новых документов на основе 
шаблона значительно упростится.

КАК СЧИТАЮТСЯ СТРАНИЦЫ
Итак, вам необходимо доба-
вить в документ несколько 
страниц. Вы изучили команды 
во всех меню программы и не 
нашли ни одной подходящей. 
По какой-то причине компания 
Adobe решила, что подобной 
команде в меню не место. 
Перейдите к палитре Pages 
(Страницы) и щелкните на 
значке Create New Page (Со-
здать новую страницу) в нижней 
части палитры. Кроме того, можно выбрать команду Insert 
Pages (Вставить страницы) из меню палитры Pages (Стра-
ницы).
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БЫСТРЫЙ СПОСОБ ДОБАВЛЕНИЯ СТРАНИЦ
Вам необходимо добавить страницы еще быстрее, чем возможно при 
использовании команды Insert Pages (Вставить страницы) из меню 
палитры Pages (Страницы)? Щелкните на значке страницы в верхней 
части палитры Pages (Страницы) и перетащите его вниз. Каждая по-
добная операция приводит к добавлению новой страницы.

УВЕЛИЧЕННЫЕ ЗНАЧКИ СТРАНИЦ
По умолчанию в палитре Pages (Страницы) используются значки стра-
ниц достаточно малого размера. Однако мириться с этим совсем не 
обязательно. Если вам больше нравятся значки страниц увеличенного 
размера, выберите из меню палитры Pages (Страницы) команду Palette 
Options (Параметры палитры). В появившемся диалоговом окне в рас-
крывающемся списке Icon Size (Размер значка) укажите подходящий 
вариант. В данном примере мы выбрали значение Extra Large (Очень 
большой).
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ДЕЛАЙТЕ ВСЕ ИМЕННО ТАК, КАК СЧИТАЕТЕ 
НЕОБХОДИМЫМ

Я думаю, большинству поль-
зователей нравится внешний 
вид палитры Pages (Страницы). 
Однако если вам все же что-то 
не нравится (например, страни-
цы должны отображаться по 
горизонтали, а не по вертика-
ли), выберите команду Palette 
Options (Параметры страницы) 
из меню палитры Pages (Стра-
ницы). В появившемся диалого-
вом окне можно задать разные 
значения параметров в группах 
параметров Masters (Шаблон-
ные страницы) или Pages (Страницы). Как говорится, все в ваших руках!

СОЗДАНИЕ НАПРАВЛЯЮЩИХ НА ЦЕЛЫЙ РАЗВОРОТ
Если вы работаете с разворо-
тами на две страницы, то при 
добавлении направляющей 
она отображается только на 
текущей странице, а не на 
всем развороте. Если вам 
необходимо, чтобы направ-
ляющая отображалась на 
всем развороте целиком (это 
очень удобно для выравнива-
ния объектов), перед тем, как 
перетащить ее с линейки, на-
жмите клавишу <Ctrl> (<�>).
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КАК БЫСТРО ИЗБАВИТЬСЯ ОТ НАПРАВЛЯЮЩИХ
Вам необходимо как можно быстрее избавиться 
от направляющих? Выберите инструмент Selection 
(Выделение), выделите направляющие, которые 
необходимо удалить (при этом направляющие отоб-
ражаются тем же цветом, который задан для соот-
ветствующего слоя в палитре Layers (Слои)), после 
чего нажмите клавишу <Backspace> (<Delete>). 
Старайтесь выделять направляющие чуть выше 
или чуть правее страницы в области монтажного 
стола, чтобы избежать выделения других элемен-
тов на странице.

КАК УДАЛИТЬ СРАЗУ ВСЕ НАПРАВЛЯЮЩИЕ
Вам необходимо как можно быстрее удалить 
все направляющие на странице или разворо-
те? Для этого нажмите комбинацию клавиш 
<Alt+Ctrl+G> (<Option+�+G>), чтобы выделить все 
направляющие, а затем воспользуйтесь клавишей 
<Backspace> (<Delete>) для их удаления.
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РАЗМЕЩЕНИЕ НАПРАВЛЯЮЩЕЙ В НУЖНОМ МЕСТЕ
Вам точно известно, где 
именно следует разместить 
направляющую? Не перетас-
кивая ее с соответствующей 
линейки, дважды щелкните 
в соответствующей точке 
на вертикальной или гори-
зонтальной линейке. Удиви-
тельно!

КАК СРАЗУ СОЗДАТЬ ВЕРТИКАЛЬНУЮ И 
ГОРИЗОНТАЛЬНУЮ НАПРАВЛЯЮЩИЕ

Если курсор перетащить 
с верхней линейки, будет 
создана горизонтальная на-
правляющая. Если курсор 
перетащить с левой линейки, 
будет создана вертикальная 
направляющая. Но известно 
ли вам, что если при нажа-
той клавише <Ctrl>(<�>) 
щелкнуть в левом верхнем 
углу (там, где пересекаются 
обе линейки) и перетащить 
курсор, можно создать сра-
зу вертикальную и горизон-
тальную направляющие, пе-
ресекающиеся в той точке, в 
которой вы отпустите кнопку 
мыши?
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КОПИРОВАНИЕ НАПРАВЛЯЮЩИХ
Если требуется переместить 
направляющие, заданные на 
одной странице, на другую стра-
ницу документа (или вообще 
в другой документ), их можно 
скопировать и вставить, как и 
любой другой объект. Выберите 
инструмент Selection (Выделе-
ние), после чего при нажатой 
клавише <Shift> щелкните на 
всех направляющих, которые 
вам необходимо скопировать, и, 
наконец, нажмите комбинацию 
клавиш <Ctri+C> (<�+С>), чтобы 
скопировать направляющие в 
буфер обмена. Теперь перейди-
те к странице, на которую необ-
ходимо вставить направляющие, 
и нажмите комбинацию клавиш 
<Ctri+V> (<�+V>). Разве может 

быть что-то проще? Если вы вставляете направляющие в другой документ, убедитесь в том, что для обоих 
документов заданы одинаковые физические размеры.

БЛОКИРОВКА НАПРАВЛЯЮЩИХ
Работая над макетом страницы 
и используя направляющие, вы 
вряд ли хотите допустить их 
случайное смещение. Именно 
по этой причине вам необхо-
димо знать данную комбина-
цию клавиш. Для блокировки 
направляющих достаточно 
нажать комбинацию клавиш 
<Alt+Clri+;> (<0ption+�+;>). 
После этого вам не удастся 
переместить ни одной направ-
ляющей. При необходимости 
разблокировать направляю-
щие снова нажмите указанную 
выше комбинацию клавиш.
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ОТОБРАЖЕНИЕ И СОКРЫТИЕ НАПРАВЛЯЮЩИХ
Это один из самых полезных советов по работе с InDesign CS. Чтобы оценить внешний вид страницы без 
лишних элементов (т.е. без направляющих линеек, направляющих полей и направляющих колонок), нажмите 
комбинацию клавиш <Ctrl+;> (<�+;>).

Направляющие отображаются Направляющие скрыты

СОЗДАНИЕ МАКЕТА НАПРАВЛЯЮЩИХ
Добавление направляющих методом перетаскива-
ния - достаточно устаревший метод работы. Когда 
вам в следующий раз потребуется добавить в до-
кумент направляющие, расположенные на строго 
определенном расстоянии друг от друга, попробуй-
те воспользоваться настоящим советом. Выберите 
команду Create Guides (Создать направляющие) из 
меню Layout (Макет). На экране появится диалого-
вое окно, в котором следует установить флажок 
Preview (Предварительный просмотр). После этого 
укажите количество строк и столбцов, а также рас-
стояние между ними (межстрочный и межстолбцовый интервал соответственно).
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НАЗНАЧЕНИЕ НАПРАВЛЯЮЩИХ СЛОЮ
Выбор команды View⇒Hide Guides (Вид⇒Скрыть направляющие) при-
водит к сокрытию сразу всех направляющих. Но как быть, если скрыть 
необходимо только часть направляющих? Данный совет значительно 
упростит вашу жизнь. При нажатой клавише <Alt> (<0ption>) щелкните 
на значке Create a new Layer (Создать новый слой) в нижней части па-
литры Layers (Слои), после чего укажите для нового слоя подходящее 
название, например guides (направляющие). Теперь воспользуйтесь 
инструментом Selection (Выделение) для выделения направляющих, 
которые должны располагаться на данном слое. В палитре Layers 
(Слои) справа от названия слоя, содержащего выделенные направ-
ляющие, появится небольшой квадратик. Перетащите его на новый 
слой guides, чтобы назначить направляющие отдельному слою. Теперь 
можете щелкать на значке в виде глаза напротив слоя, чтобы после-
довательно отображать и скрывать направляющие.

ОРГАНИЗУЙТЕСЬ С ПОМОЩЬЮ СЛОЕВ
Хватит создавать отдельные документы для каждого варианта брошю-
ры! Гораздо удобнее использовать слои. Если в макете будут применены 
одни и те же элементы, но некоторые элементы потребуется изменить, 
попробуйте разместить “изменяемые” элементы на различных слоях. 
Если вы создадите больше слоев, чем необходимо на самом деле, в 
этом нет ничего страшного. Отобразите палитру Layers (Слои), выбрав 
одноименную команду из меню Window (Окно), после чего щелкните на 
значке Create a new Layer (Создать новый слой) в нижней части палит-
ры (чтобы сразу задать название слоя, щелкать следует при нажатой 
клавише <Alt> (<0ption>)). После этого выделите элементы на странице. 
В палитре Layers (Слои) справа от названия слоя, содержащего выде-
ленные элементы, появится небольшой квадратик. Перетащите его, 
чтобы переместить элементы на соответствующие слои.
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ВЫДЕЛЕНИЕ ВСЕХ ОБЪЕКТОВ НА СЛОЕ
Выбрав команду Select All (Выделить все), вы получите 
вполне предсказуемые результаты – будет выделено бук-
вально все (за исключением, разумеется, заблокирован-
ных слоев и элементов шаблонных страниц). Однако как 
выделить все объекты на определенном слое? Восполь-
зуйтесь данным советом. При нажатой клавише <Alt> 
(<0ption>) щелкните на названии слоя в палитре Layers 
(Слои). В результате будет выделено только содержимое 
соответствующего слоя.

УПОРЯДОЧЕНИЕ СЛОЕВ ДОЛЖНЫМ ОБРАЗОМ
Порядок следования слоев играет огромную роль, когда дело доходит 
до печати прозрачных объектов. Фоновые изображения следует разме-
щать снизу, затем должны следовать фотографии, после этого вектор-
ные изображения и текст. Чтобы упростить процесс упорядочения эле-
ментов, обратитесь к палитре Layers (Спои) и создайте отдельные слои 
для объектов каждого типа. Изменять порядок расположения объектов 
можно путем перетаскивания слоев в палитре Layers (Слои).
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УДАЛЯЙТЕ ВСЕ НЕИСПОЛЬЗУЕМЫЕ СЛОИ
В документе появились неис-
пользуемые слои? (Это происхо-
дит достаточно часто.) Выберите 
команду Delete Unused Layers 
(Удалить неиспользуемые слои) 
из меню палитры Layers (Слои), 
чтобы мгновенно от них изба-
виться.

ПРОСМОТР РЕАЛЬНЫХ НОМЕРОВ СТРАНИЦ
По умолчанию номера страниц, 
которые вы видите в нижнем 
левом углу окна документа, 
определяются настройками ав-
томатической нумерации стра-
ниц, заданной для документа. 
Например, если вы задали для 
первой страницы документа 
номер 326, второй странице 
будет назначен номер 327. 
Однако если необходимо уви-
деть реальные номера стра-
ниц, перейдите на вкладку 
General (Общие) диалогового 
окна Preferences (Установ-
ки) программы InDesign (для 
отображения данною диалого-
вого окна достаточно нажать 
комбинацию клавиш <Ctrl+K> 
(<�+K>)). В группе параметров 
Page Numbering (Нумерация 
страниц) из раскрывающегося 

списка View (Вид) вместо значения Section Numbering (Нумерация в пределах раздела) выберите значение 
Absolute Numbering (Абсолютная нумерация).
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СОЗДАНИЕ РАЗДЕЛОВ (С СОБСТВЕННОЙ НУМЕРАЦИЕЙ 
СТРАНИЦ)

В документе можно создать новый раздел с собс-
твенной нумерацией страниц; для этого выберите 
команду Numbering & Section Options (Параметры 
нумерации страниц и раздела) из меню палитры 
Pages (Страницы). В появившемся диалоговом 
окне установите флажок Start Section (Начало 
раздела), затем выберите переключатель Start 
Page Numbering At (Начинать нумерацию страниц 
с) и укажите начальную страницу раздела. Щелк-
ните на кнопке ОК, чтобы создать новый раздел, 
начиная с текущей страницы. В документе может 
появиться следующая нумерация страниц: 1, 2, 3, 
4, 5, 6, 7, затем 22, 23, 24 и т.д.

НЕСТАНДАРТНАЯ НУМЕРАЦИЯ СТРАНИЦ
С использованием автоматической нумерации 
страниц справится даже ребенок. Но как насчет 
того, чтобы нумерация начиналась с определенной 
страницы и продолжалась до определенной главы? 
Попробуйте воспользоваться данным советом. Ра-
ботая c документом, состоящим из большого коли-
чества страниц, перейдите к странице 3 и выберите 
команду Numbering & Section Options (Параметры 
нумерации страниц и раздела) из меню Layout (Ма-
кет). В открывшемся диалоговом окне можно за-
дать нумерацию с определенной страницы, а также 
указать стиль нумерации который будет использо-
ван до разрыва раздела или конца документа.
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ПЕРЕХОД К НЕОБХОДИМОЙ СТРАНИЦЕ
Если вам известен номер страницы, к которой не-
обходимо перейти, воспользуйтесь данным сове-
том. Щелкните на кнопке со стрелкой “вниз”, рас-
положенной справа от номера текущей страницы в 
нижней части документа.

РЕДАКТИРОВАНИЕ ЭЛЕМЕНТОВ ШАБЛОННОЙ 
СТРАНИЦЫ

Чтобы получить доступ ко 
всем элементам шаблонной 
страницы при работе с обыч-
ной страницей, выберите из 
меню палитры Pages (Страни-
цы) команду Override All Master 
Page Items (Разблокировать 
все элементы шаблонной 
страницы). Теперь элементы 
шаблонной страницы станут 
доступными на каждой стра-
нице документа.
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КАК ОТРЕДАКТИРОВАТЬ ТОЛЬКО ОДИН ЭЛЕМЕНТ 
ШАБЛОННОЙ СТРАНИЦЫ

При необходимости отредактировать только один 
элемент шаблонной страницы достаточно щел-
кнуть на нем при нажатой комбинации клавиш 
<Shift+Ctrl> (<Shift+z>). После этого с объектом 
можно выполнять любые операции, вплоть до 
удаления. Однако при этом элемент становится 
доступным только на текущей странице, поэтому 
после удаления он остается на всех остальных 
страницах. Если вам необходимо убрать элемент 
с шаблонной страницы и оставить его только на 
текущей, выделите элемент, после чего выбери-
те из меню палитры Pages (Страницы) команду 
Detach Selection Fioni Master (Убрать выделенный 
элемент с шаблонной страницы).

НАЗНАЧЕНИЕ СТРАНИЦЕ АТРИБУТОВ ШАБЛОННОЙ 
СТРАНИЦЫ

Допустим, что вы работаете над страницей документа и решили, что 
на ней будут использоваться некоторые элементы шаблонной стра-
ницы. Для этого перейдите к палитре Pages (Страницы), щелкните на 
миниатюре шаблонной страницы, атрибуты которой решили исполь-
зовать, после чего перетащите ее на миниатюру текущей страницы. 
В результате все атрибуты шаблонной страницы будут применены к 
текущей.
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ПРЕОБРАЗОВАНИЕ ОБЫЧНОЙ СТРАНИЦЫ В 
ШАБЛОННУЮ

Вам удалось создать настолько удачную страницу, 
что было решено и другие страницы сделать таки-
ми же. Но как быть, ведь изначально вы создавали 
ее не как шаблонную? Все оказывается достаточ-
но просто. Выберите команду Save As Master (Со-
хранить как шаблонную) из меню палитры Pages 
(Страницы).

БЫСТРОЕ ПРЕОБРАЗОВАНИЕ ТЕКСТОВОГО БЛОКА В 
ГРАФИЧЕСКИЙ

Если вам нравится разрабатывать макет страниц, 
используя графические и текстовые блоки и не 
заполняя страницу никаким содержимым, данный 
совет наверняка покажется вам полезным. Со-
здайте текстовый блок. Чтобы преобразовать его 
в графический, вам не обязательно сначала уда-
лять текстовый блок, а затем создавать графичес-
кий блок таких же размеров. Вместо этого выде-
лите блок, после чего выберите из меню Object⇒
Content (Объект⇒Содержимое) команду Graphic 
(Графика). Подобный прием используется и при 
преобразовании графических блоков в текстовые.
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СОЗДАНИЕ СТИЛЯ СОДЕРЖАНИЯ
Содержание кажется очень простым элементом 
документа до тех пор, пока вы не попытаетесь со-
здать его в InDesign. На самом деле это несложно, 
но сначала необходимо определить стиль содер-
жания. Для создания простого стиля содержания 
выберите команду Table of Contents Styles (Стили 
содержания) из меню Layout (Макет), после чего в 
появившемся диалоговом окне щелкните на кнопке 
New (Создать). Укажите для стиля подходящее на-
звание. Вам следует указать стили абзаца, исполь-
зуемые в содержании, и щелкнуть на кнопке ОК. 
Подробности – в следующих советах.

ДОПОЛНИТЕЛЬНЫЕ ПАРАМЕТРЫ СОДЕРЖАНИЯ
В диалоговом окне New Table of Contents Style 
(Создание стиля содержания) присутствует кноп-
ка More Options (Дополнительные параметры). 
Щелкнув на ней, вы отобразите дополнительные 
параметры. В частности вам предоставляется 
возможность задать положение номеров страниц, 
используемый разделитель между элементом ог-
лавления и номером страницы (например, символ 
табуляции), а также параметры сортировки и мно-
гое другое.



InDesign CS
Советы знатоков

133Глава 5 • Работа со страницами

ЧТО ТАКОЕ СТИЛЬ ЭЛЕМЕНТА
В диалоговом окне New Table of Contents Style 
(Создание стиля содержания) достаточно часто 
используется слово “style” (стиль). Что же это озна-
чает? Стили, перечисленные справа, определяют 
внешний вид элементов слева. Например, если вам 
необходимо определить стиль абзаца для заголов-
ка, соответствующий вариант следует выбрать из 
раскрывающегося списка Style (Стиль), располо-
женного справа от поля Title (Название). Не забы-
вайте, что вам придется создать все необходимые 
стили абзаца, прежде чем появится возможность 
создать стиль содержания.

СОЗДАНИЕ ОТТОЧИЯ
Как правило, элементы содержания и номера стра-
ниц отделяются друг от друга с помощью отточия. 
Щелкните на кнопке More Options (Дополнитель-
ные параметры) диалогового окна New Table of 
Contents Style (Создание стиля содержания), после 
чего из раскрывающегося списка Between Entry and 
Number (Между элементом и номером страницы) 
выберите значение Tab Character (Символ табу-
ляции). Чтобы в содержании появились точки, вам 
необходимо создать соответствующую таблицу 
стилей для элемента содержания.
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СВЯЗЫВАНИЕ ДОКУМЕНТОВ В КНИГЕ
InDesign предоставляет возможность создать документ, состоящий 
из 9 999 страниц. Если вы работаете над документом, который будет 
содержать больше нескольких сотен страниц, советуем разделить его 
на несколько частей (документов). При этом вы все равно сможете вос-
пользоваться функциями одного документа, используя такое средство, 
как Book (Книга). Создайте два или больше документов InDesign, затем 
выберите команду File⇒New⇒Book (Файл⇒Создать⇒Книга). Вам 
будет предложено сохранить книгу, после чего вы получите доступ к 
палитре Book (Книга). После этого можно щелкать на значке “плюс” в 
нижней части палитры.

СОЗДАНИЕ ДОКУМЕНТА PDF НА ОСНОВЕ КНИГИ
После создания книги InDesign, 
можно создать документ PDF, 
содержащий все документы, 
входящие в ее состав. Выбе-
рите команду Export Book to 
PDF (Экспортировать книгу в 
формат PDF) из меню палит-
ры Book (Книга). При желании 
внимательно изучите другие 
команды, доступные в меню палитры. Некоторые из них 
оказываются очень полезными. Например, в меню доступна 
команда, предназначенная для печати книги.
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СИНХРОНИЗАЦИЯ КНИГИ
Люди очень часто совершен-
но бескорыстно предлагают 
свою помощь. Они берут на 
себя часть вашей нагрузки, 
ничего не прося взамен. 
Если при работе над книгой 
в InDesign другие люди по-
могали вам при подготовке 
отдельных документов, вам 
необходимо обеспечить их 
согласованность в книге. 
Для этого выберите команду 
Synchronize Book (Синхрони-
зировать книгу) из меню па-
литры Book (Книга). Благода-
ря этому во всех документах 
будет использовано общее 
оглавление, стили символов 
и абзацев, а также настройки 
треппинга и образцы цвета.

НУМЕРАЦИЯ СТРАНИЦ В КНИГЕ
Нумерация страниц играет очень важную роль, а 
данный совет позволит использовать ее наиболее 
эффективно. Параметры нумерации страниц сле-
дует проверить для каждого документа в книге, 
поскольку вам обязательно нужно отключить ав-
томатическую нумерацию страниц. Для этого вы-
берите команду Document Page Numbering Options 
(Параметры нумерации страниц в документе) из 
меню палитры Book (Книга). Затем задайте необ-
ходимые параметры нумерации страниц.
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СОЗДАНИЕ ЭЛЕМЕНТОВ ПРЕДМЕТНОГО УКАЗАТЕЛЯ
Прежде чем вам удастся собрать предметный 
указатель, следует указать слова, которые долж-
ны в нем использоваться. К сожалению, inDesign 
не способна автоматически размечать элемен-
ты предметного указателя. Отобразите палитру 
Index (Предметный указатель), выбрав одно-
именную команду из меню Window⇒Type&Tables 
(ОКНО⇒Текст и таблицы). Для этого также можно 
нажать комбинацию клавиш <Shift+F8>. Теперь 
просто выделите слово, которое необходимо по-
метить как элемент предметного указателя, после 
чего щелкнте на значке Create a new index entry 
(Создать новый элемент предметного указателя) 
в нижней части палитры. В диалоговом окне New 
Page Reference [Новая ссылка на страницу) можно 
задать уровень элемента и порядок его сортиров-
ки. Как только вы щелкнете на кнопке ОК, слово будет добавлено в палитру Index (Предметный указатель) и 
размещено в списке по алфавиту.

ПЕРЕКРЕСТНЫЕ ССЫЛКИ В ПРЕДМЕТНОМ УКАЗАТЕЛЕ
Вас наверняка раздражает, когда, найдя слово в 
предметном указателе, вам предлагается что-то 
наподобие См. также. После этого вам приходится 
обращаться к другому слову. Поверьте, это не нра-
вится и читателям книги. При создании элемента 
предметного указателя в окне New Page Reference 
(Создание ссылки на страницу) выберите из рас-
крывающегося списка Type (Тип) вместо значения 
Current Page (Текущая страница) значение Sее 
(См.), See Also (См. также} и т.д. Затем в тексто-
вом поле Referenced (Ссылка на), расположенном 
под раскрывающимся списком Type (Тип), введите 
соответствующий элемент предметного указателя.
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КАК СОЗДАТЬ ДОКУМЕНТ PDF ПРИ РАБОТЕ С ПАЛИТРОЙ 
BOOK

Несмотря на то, что кнопка PDF в палитре Book (Книга) отсутствует, вы можете при нажатой клавише <Alt> 
(<0ption>) щелкнуть на кнопке Print (Печать). Вместо печати вам будет предложено указать название докумен-
та PDF, а не отправлять документ на печать.

ДОБАВЛЕНИЕ В КНИГУ ДОКУМЕНТОВ С РАБОЧЕГО 
СТОЛА

Конечно, всем нравится работать с диалоговым окном Open (Открытие документа), однако часто намного про-
ще использовать объекты, расположенные на рабочем столе. При работе с книгами в InDesign попробуйте вос-
пользоваться данным советом. Отобразив палитру Book (Книга), просто переместите в нее документы InDesign 
с рабочего стола (или любой папки на жестком диске компьютера). При этом документы будут автоматически 
помещены в книгу.
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ЕСЛИ НЕОБХОДИМ ТОЛЬКО ОДИН ДОКУМЕНТ
Несмотря на то, что палитра 
Book (Книга) позволяет рабо-
тать с несколькими докумен-
тами как с одним большим, 
в некоторых ситуациях вам 
потребуется выполнить опре-
деленную операцию именно с 
одним документом. Например, 
вам может понадобиться от-
править на печать только один 
документ из книги. Выделите 
один или несколько докумен-
тов, если в этом возникнет не-
обходимость (для выделения 
нескольких документов щелк-
ните на них при нажатой кла-
више <Ctrl> (<�>)), затем из 
меню раскройте меню палитры 
Book (Книга). Вы заметите, что 
вместо команд, относящихся к 
целым книгам, отображаются 
команды, имеющие отношение 
к документам. Например, вмес-
то команды Print Book (Печать книги) отображается команда Print Selected Documents (Печать выделенных 
документов).

РАЗМЕЩЕНИЕ ДОКУМЕНТОВ В WEB
Книгу, состоящую из несколь-
ких документов InDesign, раз-
местить в Web может оказаться 
достаточно проблематично. Кто 
захочет открывать отдельные 
документы? Поэтому обяза-
тельно воспользуйтесь данным 
советом. Открыв книгу, выбери-
те из меню палитры Book (Кни-
га) команду Package⇒Book For 
GoLive (Упаковать⇒Книга для 
GoLive). Чтобы воспользовать-
ся всеми преимуществами дан-
ной команды, вам необходима 
программа Adobe GoLive CS. 
Если GoLive CS в вашем распо-
ряжении имеется, откройте с ее 
помощью подготовленный “пакет”, после чего подготовьте содержимое книги к размещению Web.
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Несмотря на то, что достаточно много задач 
можно решить в In Design CS, иногда без импор-
тирования графики в InDesign не обойтись. Не-
которым пользователям приходится это делать 
достаточно часто. Еспи вы часто импортируете

ГРАФИЧЕСКИЕ ИЗОБРАЖЕНИЯ
Работа с графикой

или экспортируете графические изображения, иногда вам может 
понадобиться совет, который бы позволил ускорить выполнение 
той ипи иной операции. Именно такие советы и представлены 
в настоящей главе. Изучив их, вы сможете работать намного 
эффективнее. Кроме того, перед вами откроются настолько 
широкие возможности, что вам позавидует любой пользователь 
QuarkXPress. Представленные в настоящей главе советы очень 
полезны. Однако использовать их следует осторожно.
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СОЗДАНИЕ ВИНЬЕТКИ В INDESIGN
Прямоугольные фотографии были популярны в 
90-х годах прошлого века. Сейчас в моде фотогра-
фии с “рваными* краями или фотографии в форме 
виньетки. При необходимости получить “рваные” 
края вам придется обратиться к Photoshop. Однако 
если требуется получить неровную гладкую грани-
цу, попробуйте воспользоваться данным советом. 
Выделите фотографию с помощью инструмента 
Selection (Выделение). Затем выберите команду 
Feather (Растушевать) из меню Object (Объект). 
Установите флажки Feather (Растушевка) и Preview 
(Предварительный просмотр). После этого задайте 
необходимую степень растушевки или щелкните в 
поле Feather Width (Ширина растушевки) и исполь-
зуйте клавиши <↓> и <↑> для изменения текущего 
значения.

БЛОКИ НЕ ОБЯЗАТЕЛЬНО ДОЛЖНЫ БЫТЬ 
ПРЯМОУГОЛЬНЫМИ

Конечно же, при создании блоков в документах 
чаще всего используется инструмент Rectangle 
Frame (Прямоугольный блок). Однако данный совет 
позволит вам создавать текстовые и графические 
блоки очень необычной формы. Нарисовав блок, 
выберите инструмент Реп (Перо), щелкните им на 
границе блока и перетащите в нужном направлении. 
В результате вы добавите точку кривой, а значит, 
сможете изменить изгиб границы блока.
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ЗНАКОМСТВО С РЕЖИМАМИ НАЛОЖЕНИЯ
InDesign CS предлагает те же режимы наложения, 
которые хорошо знакомы всем пользователям, ра-
ботающим в Photoshop. Чтобы создать интересный 
эффект, не обращаясь к дополнительному прило-
жению, попробуйте выделить векторную фигуру, 
залитую вашим любимым цветом (хотя лучше ис-
пользовать цвета, необходимые для работы) и рас-
положенную над другим объектом. После этого вы-
берите режим наложения Multiply (Умножение) из 
раскрывающегося списка в верхней части палитры 
Transparency (Прозрачность). Экспериментируйте 
с режимами наложения, и, поверьте, ваши друзья 
будут удивлены полученными вами результатами.

ИСПОЛЬЗОВАНИЕ КОМАНДЫ PASTE INTO
Заключение графических 
изображений в текст всегда 
позволяет получить очень 
интересные результаты. 
Если на странице располо-
жены надпись и графичес-
кое изображение, попробуй-
те воспользоваться данным 
советом. Выделите текст с 

помощью инструмента Type (Текст), после чего выполните команду Type⇒Create Outlines (Текст⇒Создать 
контуры). Выберите инструмент Direct Selection (Прямое выделение), затем выделите графическое изобра-
жение и выберите команду Copy (Копировать) из меню Edit (Правка). Выделите контуры надписи и выберите 
команду Paste Into (Вставить в) из меню Edit (Правка). При активном инструменте Direct Selection (Прямое вы-
деление) можно перетаскивать изображения для согласования его положения относительно текста.
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ДОБАВЛЕНИЕ ТЕНЕЙ
Очень тяжело найти публикацию, в которой бы не 
использовалось хотя бы одной вручную добавлен-
ной тени. Поэтому можете смело применять в своей 
публикации одну или даже несколько теней. Падаю-
щие тени добавляют как к тексту, так и к графичес-
ким изображениям. Падающие тени и растушевка 
связываются с отдельными блоками, а значит, для 
их добавления к тексту в блоке текст не нужно 
предварительно выделять с помощью инструмен-
та Type (Текст). Выделив соответствующий блок с 
помощью инструмента  Selection (Выделение), вы-
берите команду Drop Shadow (Падающая тень) из 
меню Object (Объект). Установите флажки Preview 
(Предварительный просмотр) и Drop Shadow (Пада-
ющий тень). Затем задайте необходимые параметры тени.

ИМИТАЦИЯ СВЕЧЕНИЙ
В In Design CS специальное средство для создания 
свечения отсутствует, однако ничто не мешает вам 
сымитировать свечение, если в этом возникнет 
необходимость. Выделив соответствующий блок с 
помощью инструмента Selection (Выделение), вы-
берите команду Drop Shadow {Падающая тень) из 
меню Object (Объект). Установите флажки Preview 
(Предварительный просмотр) и Drop Shadow (Пада-
ющий тень), после чего задайте параметры тени. В 
качестве цвета установите подходящий цвет - зе-
леный или желтый. В результате к тексту в блоке 
будет добавлено свечение.
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ПЕРЕТАСКИВАНИЕ ИЗОБРАЖЕНИЙ С РАБОЧЕГО СТОЛА
Команда File⇒Place (Файл⇒Разместить)... Сколько раз вам приходи-
лось обращаться к ней при работе в InDesign? Однако существует и 
более простой способ добавления изображений в документы. Ведь вам 
прекрасно известен метод перетаскивания, не так ли? Данный совет 
позволит вам подготавливать документы намного быстрее. Скорее 
всего, изображения, которые вам необходимо разместить в документе, 
находятся в папке. Открыв папку в окне Windows Explorer (Проводник) 
(на платформе Macintosh соответствующее окно называется Finder), 
перетащите изображения на страницу документа. При этом можно 
переместить несколько изображений сразу. Для выделения несколь-
ких изображений щелкните на них при нажатой клавише <Ctrl> (<�>), 
после чего перетащите их в документ.

ОТОБРАЖЕНИЕ ПАРАМЕТРОВ ИМПОРТА
Для того чтобы отобразить 
параметры импорта, уста-
новите флажок Show Import 
Options (Показать параметры 
импорта) в диалоговом окне 
Place (Размещение). В ре-
зультате при вставке текста, 

графических изображений и файлов PDF вам будет предложено несколько возможных вариантов импорта. 
Например, если необходимо удалить ручные разрывы страниц в документе Word, выберите значение No Breaks 
(Без разрывов) из раскрывающегося списка Manual Page Breaks (Ручные разрывы страниц).
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РАЗМЕЩЕНИЕ ДОКУМЕНТОВ PDF
На страницах документов 
InDesign можно размещать 
файлы PDF. Удивительно, не 
так ли? Хотя, конечно же, мож-
но было ожидать, что компания 
Adobe обеспечит поддержку 
собственного формата элект-
ронных документов. Предполо-
жим, что у вас есть документ 
PDF, содержащий несколько 
страниц. Если его просто вста-
вить в документ InDesign, то 
будет вставлена только первая странница. Но если вы установите флажок Show Import Options (Показывать 
параметры импорта) в диалоговом окне Place (Размещение), то появится возможность выбирать страницы, а 
также задавать параметры кадрирования.

АКТИВИЗАЦИЯ И ОТКЛЮЧЕНИЕ ОБТЕКАНИЯ ТЕКСТОМ
Обтекание текстом - это очень интересная 
функция, однако иногда возникает необходи-
мость использовать обтекание текстом разных 
объектов. Предположим, что вам необходимо 
показать заказчику несколько вариантов свер-
станной страницы, на которых используются 
разные изображения, но один и тот же текст. 
Данный совет позволит вам упростить реше-
ние подобных задач. Разместите каждое изоб-
ражение, а также текст на отдельном слое. Затем в палитре Layers (Слои) дважды щелкните на на-
звании одного из слоев, содержащих графическое изображение. В диалоговом окне Layer Options 
(Параметры слоя) установите флажок Suppress Text Wrap When Layer Is Hidden (Игнорировать обтекание 
текстом, если слой скрыт). Выполните эти действия для каждого слоя, содержащего графическое изоб-
ражение. Теперь, последовательно работая с каждым слоем, в палитре Text Wrap (Обтекание текстом) 
(для отображения которой необходимо воспользоваться командой Window⇒Type&Tables⇒Text Wrap 
(Окно⇒Текст и таблицы⇒0бтекание текстом)) задайте параметры обтекания. Поскольку в диалоговом окне 
Layer Options (Параметры слоя) установлен флажок Suppress Text Wrap When Layer Is Hidden (Игнорировать 
обтекание текстом, если слой скрыт), при сокрытии определенного слоя соответствующее обтекание текстом 
не используется.
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ПРОФЕССИОНАЛЬНОЕ ПРИМЕНЕНИЕ ОБТЕКАНИЯ 
ТЕКСТОМ

При использовании обтекания текстом в InDesign 
текст располагается на определенном расстоянии 
от объекта. В то же время при работе с файлами 
EPS, созданными с помощью Illustrator, текст мо-
жет располагаться в полном соответствии с фор-
мой графического объекта, а не кадра. Выделите 
графическое изображение, после чего выберите 
команду Clipping Path (Обтравочный контур) из 
меню Object (Объект). Перейдите к значению 
Detect Edges (Определение границ) в меню Type 
(Тип). Щелкните на кнопке ОК. Теперь при щел-
чке на значке Wrap Around Object Shape (Обтека-
ние по форме объекта) (это третий значок слева 
в палитре Text Wrap (Обтекание текстом)) текст 
будет расположен в полном соответствии с фор-
мой графического объекта, а не кадра.

ИЗМЕНЕНИЕ ЭЛЕМЕНТОВ ШАБЛОННЫХ СТРАНИЦ
Шаблонные страницы очень удобны. Разместите необходимые элементы на одной странице и после этого вы 
сможете их использовать на нескольких страницах документа. Однако в некоторых случаях вам потребуется 
изменить изображение определенной страницы, а это невозможно, так как изображение является элементом 
шаблонной страницы. Данный совет позволит решить эту проблему. Щелкните на том элементе шаблонной 
страницы, который вам необходимо изменить на текущей странице. При этом удерживайте нажатой комби-
нацию клавиш <Shift+Ctrl> (<Shift+�>). В результате вы сможете можно выполнять необходимые операции с 
изображением.



InDesign CS
Советы знатоков

148 Глава 6 • Работа с графикой

РАБОТА С ВЕКТОРНЫМИ ИЗОБРАЖЕНИЯМИ
Несмотря на то, что обе программы, Adobe In 
Design и Adobe Illustrator, поддерживают работу с 
векторными изображениями, инструменты рисова-
ния Illustrator оказываются функциональнее соот-
ветствующих инструментов InDesign. Данный совет 
поможет вам использовать лучшее из двух миров. 
Нарисуйте иллюстрацию в Illustrator. Убедитесь в 
том, что на вкладке File Handling & Clipboard (Рабо-
та с файлами и буфером обмена) диалогового окна 
Preferences (Установки) программы Illustrator (для 
отображения данной вкладки необходимо выбрать 
одноименную команду из меню Edit⇒Preferences 
(Правка⇒Установки); на платформе Macintosh это 
меню Illustrator⇒Preferences (Illustrator⇒Установки)) в группе параметров Clipboard on Quit (Содержимое буфе-
ра обмена) установлен флажок АIСВ (Adobe Illustrator Clipboard – Буфер обмена Adobe Illustrator). Скопировав 
иллюстрацию в буфер обмена, перейдите в InDesign, после чего вставьте иллюстрацию. Выбрав инструмент 
Direct Selection (Прямое выделение), можно изменить положение узловых точек непосредственно в InDesign, 
несмотря на то, что исходная иллюстрация была создана в Illustrator.

КАК ИЗБЕЖАТЬ ПРЕДВАРИТЕЛЬНОГО СОЗДАНИЯ 
БЛОКОВ

Дизайнеры предпочитают заниматься своим ос-
новным делом – дизайном. Работать с сетками и 
рисовать блоки они не любят. Если вы относитесь к 
данной категории дизайнеров, то этот совет придет-
ся вам по душе. Текст и графические изображения 
можно вставлять в InDesign, избежав необходимос-
ти предварительно создавать блоки. Как только вы 
вставите текст или изображение, InDesign создаст 
соответствующий блок автоматически.
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ЕСЛИ ВАМ НРАВИТСЯ НАЧИНАТЬ С СОЗДАНИЯ БЛОКОВ
Если же вы любите порядок, то всегда начинаете с создания блоков, 
которые в дальнейшем заполняете текстом или графическими изобра-
жениями. InDesign предлагает целый ряд инструментов для создания 
блоков. В значках некоторых инструментов присутствует “х°; в значках 
других инструментов “х” отсутствует. InDesign совершенно все равно, с 
помощью какого инструмента создан блок. Знак “х” используется для 

того, чтобы упростить жизнь пользователей, которые раньше работали в QuarkXPress.

СОГЛАСОВАНИЕ РАЗМЕРОВ БЛОКА И ИЗОБРАЖЕНИЯ
Если графическое изображе-
ние должно помещаться в оп-
ределенной части страницы, 
попробуйте воспользоваться 
данным советом. Нарисуйте 
блок, в котором должно поме-
щаться изображение. Теперь 
поместите изображение в по-
лученный блок. Чтобы согла-
совать размеры изображения 
с размерами блока, выберите 
команду Object⇒Fitting⇒Fit 
Content Proportionally (Объ-
ект⇒Подгонка⇒Пропорци-
онально подогнать размеры 
содержимого).
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КОГДА РАЗМЕР ИМЕЕТ ЗНАЧЕНИЕ
Итак, вам необходимо изменить размеры изобра-
жения. Однако при перетаскивании маркера изме-
няются размеры блока! В InDesign по умолчанию 
происходит именно так. Если же вам необходимо 
изменить размеры изображения и блока одно-
временно, выберите инструмент Selection (Выде-
ление), после чего перетащите один из угловых 
маркеров, удерживая нажатой комбинацию клавиш 
<Ctrl+Shift> (<�+Shift>). В результате масштаб изоб-
ражения будет изменяться пропорционально.

КАК БЫСТРО ИЗМЕНИТЬ РАЗМЕРЫ НЕСКОЛЬКИХ 
ОБЪЕКТОВ

Вам необходимо изменить 
размеры сразу нескольких 
объектов? Это очень просто. 
Удерживая нажатой клави-
шу <Shift>, щелкните на всех 
объектах, размеры которых 
необходимо изменить одно-
временно, после сгруппируйте 
объекты, нажав комбинацию 
клавиш <Ctrl+G> (<�+G>). 
Теперь щелкните на угловом 
маркере и перетащите его 
для изменения размеров объ-
ектов. Примечание: данный 
совет применим при работе с 
объектами, но не текстом.
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ПЕРЕМЕЩЕНИЕ ИЗОБРАЖЕНИЯ НЕЗАВИСИМО
ОТ БЛОКА

Блоки чаще всего расположены именно там, где и должны быть. Одна-
ко относительно графических изображений подобного сказать нельзя. 
Например, в блоке может отображаться не тот фрагмент изображения, 
который вы хотели бы видеть. Блоки очень часто используются для 
кадрирования больших фотографий. Если вам необходимо изменить 
положение изображения в блоке, выберите инструмент Direct Selection 
(Прямое выделение) и переместите изображение так, как посчитаете 
необходимым. Если, нажав клавишу мыши. перед перетаскиванием 
инструмент некоторое время удерживать на одном месте, то можно 
сразу увидеть, как именно будет выглядеть изображение в блоке, если 
в данный момент отпустить кнопку мыши.

ТРИ В ОДНОМ
Итак, вам необходимо переместить и повернуть объект, а также изме-
нить его размеры. В данном случае воспользуйтесь инструментом Free 
Transform (Свободное преобразование). Этот инструмент (в палитре 
инструментов ему соответствует значок в виде пунктирной рамки, над 
которой отображается стрелка) позволяет выполнять все перечис-
ленные операции. Если щелкнуть на рамке объекта и потащить ее, вы 
переместите объект. Если же щелкнуть на угловом маркере и пере-
тащить его, вам удастся изменить размеры объекта. И наконец, если 
подвести инструмент к угловому маркеру (как показано на рисунке), 
можно повернуть объект.
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КАК ПЕРЕВЕРНУТЬ ИЗОБРАЖЕНИЕ
Нет ничего неприятнее, чем перевернутое изображение на странице. 
Для решения данной проблемы совсем не обязательно обращать-
ся к Photoshop; все необходимые действия можно выполнить и в 
InDesign. Выделив изображение, выберите из меню в правовой части 
палитры Confro/(Управление) команду Flip Horizontal (Перевернуть по 
горизонтали).

НЕ СЛЕДУЕТ ИСПОЛЬЗОВАТЬ ВЫРАВНИВАНИЕ 
ОБЪЕКТОВ «НА ГЛАЗ»

Выравнивание объектов на стра-
нице “на глаз” - это далеко не 
самая лучшая идея. Когда вам 
в следующий раз потребуется 
выровнять объекты, выберите 
команду Align (Выравнивание) 
из меню Window (Окно). Теперь 
выделите объекты, которые не-
обходимо выделить, и щелкните 
на соответствующих значках 
выравнивания в палитре Align 
[Выравнивание).



InDesign CS
Советы знатоков

153Глава 6 • Работа с графикой

РАСПРЕДЕЛЕНИЕ ОБЪЕКТОВ
Если вам необходимо, чтобы объекты на странице располагалась на 
определенном расстоянии относительно друг друга, выполните следую-
щие действия. Выберите из меню палитры Align (Выравнивание) коман-
ду Show Options (Показать параметры). Установите флажок Use Spacing 
(Использовать распределение), после чего укажите необходимое значе-
ние в соответствующем текстовом поле. Затем выделите необходимые 
объекты и щелкните в палитре Align (Выравнивание) на значке Distribute 
vertical space (Распределить по вертикали) или Distribute horizontal space 
(Распределить по горизонтали).

ОПЕРАЦИИ КОПИРОВАНИЯ И ВСТАВКИ ПРИЗНАНЫ 
УСТАРЕВШИМИ

Когда вам в следующий раз потребуется создать 
копию какого-то объекта на странице, перетащите 
его с помощью инструмента Selection (Выделение) 
при нажатой клавише <Alt> (<0ption>).

До распределения объектов:

После распределения 
объектов:
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ИСПОЛЬЗУЙТЕ КОМАНДУ STEP AND REPEAT
ВМЕСТО КОПИРОВАНИЯ И ВСТАВКИ

Итак, мы установили, что, операции копирования 
и вставки имеют право на существование, однако 
их применение для получения большого количества 
копий объекта на одной странице - это настоящее 
безумие. Поэтому попробуйте воспользоваться дан-
ным советом. Выделив объект, выберите команду 
Step and Repeat (Многократное преобразование) 
из меню Edit (Правка). Теперь задайте необходи-
мое количество копий, а также укажите значения параметров Horizontal Offset (Смещение по горизонтали) и 
Vertical Offset (Смещение по вертикали).

НЕ ПЕРЕМЕЩАЙТЕ ОБЪЕКТ НА ТО ЖЕ МЕСТО – 
КОПИРУЙТЕ ЕГО

Возникала ли у вас необходимость создать копию объекта, расположен-
ную в том же месте, что и оригинал? Это очень пригодится при необхо-
димости разместить полученные объекты в одном и том же месте на 
различных страницах. Когда вам в следующий раз пробуется получить 
подобные результаты, попробуйте воспользоваться данным советом. 
Создайте копию объекта, который должен появиться в том же самом 
месте другой страницы (для этого нажмите комбинацию клавиш <Ctrl+C> 
(<�+С>)), после чего перейдите к необходимой странице и выберите ко-
манду Paste in Place (Разместить на месте) из меню Еdit (Правка).
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КОМАНДА PASTE REMEMBERS LAYERS
Чтобы объекты всегда оставались на слоях, к ко-
торым они относятся, используйте команду Paste 
Remembers Layers (Учитывать слои при вставке) 
из меню палитры Layers (Слои). Например, если 
в документе используется специальный слой для 
размещения фотографий, а вам необходимо ско-
пировать фотографию со страницы 1 на страницу 
16, оставив ее на том же слое, обязательно вос-
пользуйтесь данным советом.

КУДА ЖЕ ПРОПАЛА ПАЛИТРА LIBRARY?
Если вы пытались найти команду для отображения палитры Library 
(Библиотека) в меню Window (Окно) (в котором доступны команды для 
отображения всех остальных палитр), то вам уже известно, что там 
этой команды нет. Где спрятана палитра? Верите или нет, но палитру 
Library (Библиотека) необходимо создавать. Выберите команду Library 
(Библиотека) из меню File⇒New (Файл⇒Создать). На экране отобра-
зится диалоговое окно New Library (Создание библиотеки), в котором 
при желании можно задать более подходящее название. Щелкните на 
кнопке ОК, и палитра немедленно появится на экране. Если в дальней-
шем вы закроете палитру, для ее отображения придется воспользо-
ваться командой Open (Открыть) из меню File (Файл). Подобный способ 

отображения палитры может показаться вам не очень удобным, и мы с вами в этом совершенно согласны.
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ДОБАВЛЕНИЕ ОБЪЕКТОВ В БИБЛИОТЕКУ
Теперь, когда библиотека создана, палитру Library (Библиотека) следу-
ет заполнить необходимыми элементами. При этом можно перетаски-
вать объекты на палитру или просто выделять объекты и щелкать на 
New Library Item [Новый элемент библиотеки) в нижней части палитры 
Library (Библиотека).

ПЕРЕТАСКИВАНИЕ ОБЪЕКТОВ ИЗ ПАЛИТРЫ LIBRARY 
НА СТРАНИЦУ

Итак, вы создали библиоте-
ку элементов. А что дальше? 
Просто перетаскивайте необ-
ходимые элементы из палитры 
Library (Библиотека) на страни-
цу. Также можно использовать 
команду Place Item(s) (Раз-
местить элемент(ы)) из меню 
палитры Library (Библиотека), 
однако метод перетаскивания 
кажется нам более удобным.
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ПЕРЕИМЕНОВАНИЕ ЭЛЕМЕНТА БИБЛИОТЕКИ
Если вы создали элемент или 
блок и перетащили его на 
палитру Library (Библиотека), 
он наверняка будет указан в 
библиотеке под названием 
Untitled (Без имени). Прово-
дить поиск по таким названи-
ям очень сложно. Отобразите 
палитру Library (Библиотека) и 
дважды щелкните на элемен-

те, который решили переименовать. В появившемся диалоговом окне Item Information (Сведения об элементе) 
введите более подходящее название и щелкните на кнопке ОК.

ЭКОНОМИЯ ВРЕМЕНИ ПРИ ПОИСКЕ ЭЛЕМЕНТОВ
В БИБЛИОТЕКЕ

Если вы добавили в палитру 
Library (Библиотека) програм-
мы InDesign достаточно много 
элементов, выполнить их по-
иск будет непросто. Поэтому, 
чтобы в дальнейшем избежать 
подобных неприятностей, при 
перетаскивании элемента в 
палитру Library (Библиотека) 
удерживайте нажатой клави-

шу <Alt> (<0ption>). В результате на экране автоматически будет отображено диалоговое окно Item Information 
(Сведения об элементе), в котором можно указать не только название элемента, но и ключевые слова в поле 
Description (Описание). В дальнейшем это позволит вам сэкономить немало времени.
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ДОБАВЛЕНИЕ КЛЮЧЕВЫХ СЛОВ К ЭЛЕМЕНТАМ 
БИБЛИОТЕКИ

Если вы решили добавить клю-
чевые слова к элементам, уже 
присутствующим в библиотеке, 
дважды щелкните на элементе 
и введите необходимые клю-
чевые слова в текстовом поле 
Description (Описание) в нижней 
части появившегося диалогово-
го окна. Затем эти ключевые 
слова можно использовать при 
поиске элементов в библиотеке, для чего сначала следует щелкнуть на значке Show Library Subset (Показать 
подгруппу библиотеки) в нижней части палитры Library (Библиотека).

ПОИСК В БИБЛИОТЕКЕ
Если вы поместили в библи-
отеку InDesign десятки или 
даже сотни элементов, про-
кручивание списка для поиска 
необходимого элемента может 
оказаться достаточно утоми-
тельным занятием. Поэтому 
при необходимости найти оп-
ределенный элемент в биб-
лиотеке щелкните на значке 
Show Library Subset (Показать 
подгруппу библиотеки) (он вы-
глядит как бинокль) в нижней части палитры Library (Библиотека). В результате на экране появится диалого-
вое окно Subset (Подгруппа), в котором можно провести поиск элементов по названию и другим атрибутам. 
Каждый щелчок на кнопке More Choices (Больше критериев) позволяет добавить дополнительные критерии, 
что позволяет уменьшить область поиска.
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СУЖЕНИЕ ОБЛАСТИ ПОИСКА
Итак, представьте себе сле-
дующую ситуацию. Вы выпол-
нили поиск в библиотеке по 
ключевому слову “логотип” и 
получили список из 60 элемен-
тов. Это не очень хорошо, не 
так ли? Сузить область поиска 
можно следующим образом. 
Как только результаты будут 
отображены на экране, щелк-

ните на значке Show Library Subset (Показать подгруппу библиотеки) (он выглядит как бинокль) в нижней части 
палитры Library (Библиотека) В появившемся диалоговом окне Subset (Подгруппа) выберите переключатель 
Search Cunently Shown Items (Поиск среди отображаемых элементов), из раскрывающегося списка Parameters 
(Параметры) выберите значение Description (Описание), после чего введите другое ключевое слово. Как толь-
ко вы щелкнете на кнопке ОК, поиск будет осуществлен по результатам предыдущего поиска, благодаря чему 
вам удастся найти именно тот элемент, который необходим.

КАК ОТОБРАЗИТЬ ВСЕ ЭЛЕМЕНТЫ БИБЛИОТЕКИ
Если вы успешно провели 
поиск, в библиотеке будет 
отображен только найденный 
вами один-единственный эле-
мент. Как же после этого уви-
деть другие элементы, не осу-
ществляя их поиск? Выберите 
команду Show All (Показать 
все) из меню палитры Library 
(Библиотека). Как только вы 
это сделаете, в палитре будут 
показаны все элементы биб-
лиотеки.
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ОТОБРАЖЕНИЕ НАЗВАНИЙ ЭЛЕМЕНТОВ БИБЛИОТЕКИ
Как бы привлекательно ни выглядели миниатюры элементов, они за-
нимают слишком много места. Если вы хотите использовать палитру 
Library (Библиотека) максимально эффективно, попробуйте воспользо-
ваться данным советом. Выберите команду List View (Список) из меню 
палитры Library (Библиотека). Теперь в палитре Library (Библиотека) 
будет отображаться намного больше элементов, чем при использовании 
представления Thumbnail View (Миниатюры).

НЕ ПЕЧАТАТЬ!
Иногда вам необходимо разместить элементы, предназначенные толь-
ко для просмотра. Например, это могут быть указания для сотрудников 
отдела технической редакции или же пометки о том, что документ был 
утвержден. Воспользуйтесь данным советом. Выделите соответствую-
щий объект, после чего отобразите палитру Attributes (Атрибуты), вы-
брав одноименную команду Window (Окно). Теперь просто установите 
флажок Nonprinting (Непечатаемый).
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ВЫБОР ЦЕНТРА ПРЕОБРАЗОВАНИЙ ОБЪЕКТА
По умолчанию все изменения, вносимые в палитре Сontrol (Управление), применяются к центру 
выделенных объектов. Однако такое положение вещей можно изменить, воспользовавшись 
данным советом. Значок элемента в палитре Control (Управление) содержит девять маркеров. 
Щелкните на маркере, соответствующем необходимому вам центру преобразований. Например, 

мы при работе чаще всего выбираем верхний левый маркер.

ПОДКЛЮЧЕНИЕ НОВЫХ ИЗОБРАЖЕНИЙ
Итак, ваш заказчик предоставил изображение, которое вы размести-
ли в документе. После этого вы повернули изображение, изменили его 
масштаб, а также выполнили ряд других операций, необходимых для 
того, чтобы изображение выглядело должным образом. Через некото-
рое время заказчик позвонил вам и сказал, что он решил использовать 
другое изображение. После того как вы придете в себя (при этом лучше 
молчать), выполните следующие действия. Отобразите палитру Links 
(Связи), выбрав одноименную команду из меню Window (Окно). Щелк-
ните на значке Relink (Обновить связь) в нижней части палитры. Теперь 
выберите другое изображение и щелкните на кнопке Open (Открыть). К 
вставленному изображению будут применены все те преобразования, 
которые вы задали для предыдущего изображения.
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ЗАМЕНА ГРАФИЧЕСКОГО ИЗОБРАЖЕНИЯ
Иногда такое действительно 
происходит. Вы передумали 
и решили использовать в до-
кументе другое изображение. 
Никаких проблем! Выделите 
изображение, которое решили 
заменить, после чего выберите 
команду Place (Разместить) из меню Filе (Файл). Найдите необходимое изображение и установите флажок 
Replace Selected Item (Заменить выделенный элемент) в нижней части диалогового окна Place (Замена). В 
результате выделенное изображение будет автоматически заменено.

СОЗДАНИЕ ИЗОБРАЖЕНИЯ
Иногда использовать файлы PDF нe представляет-
ся возможным. Вам может понадобиться импорти-
ровать изображение из макета, чтобы разместить 
его на Web-странице или отправить по электронной 
почте. Когда вы в следующий раз решите создать 
изображение JPEG на основе изображения из ма-
кета, воспользуйтесь данным советом. Выделите 
объекты, которые необходимо поместить в файл 
JPEG. Затем выберите команду Export (Экспор-
тировать) из меню File (Файл), укажите формат 
JPEG и щелкните на кнопке Save (Сохранить). В по-
явившемся диалоговом окне Export JPEG (Экспорт 
в JPEG) вместо переключателя Page (Страница) 
выберите переключатель Selection (Выделение). 
Задав необходимое качество, щелкните на кнопке 
Export (Экспорт).
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КТО АВТОР ЦИФРОВОЙ ФОТОГРАФИИ В ДОКУМЕНТЕ? 
INDESIGN ЗНАЕТ ОТВЕТ!

Если вы поместили в документ InDesign цифровую 
фотографию и решили выразить благодарность 
фотографу, InDesign может вам в этом помочь. 
Щелкните на ней, после чего выберите коман-
ду File⇒File Info (Файл⇒Сведения о файле). 
На экране появится диалоговое окно, в котором 
будут представлены сведения, внедренные в саму 
цифровую фотографию. Перейдите на вкладку 
Description (Описание). Здесь автор фотографии 
мог указать свое имя. Выделите имя, после чего 
нажмите комбинацию клавиш <Ctrl+C> (<�+C>) и 
щелкните на кнопке Cancel (Отмена) диалогового 
окна File Info (Сведения о файле). Все, что вам 
остается сделать, так это создать текстовый 
блок рядом с фотографией и вставить в него имя 
фотографа.

СОЗДАНИЕ ПОЛУПРОЗРАЧНЫХ ИЗОБРАЖЕНИЙ
Иногда требуется разместить над фоном полупрозрачное изображение. Когда в следующий раз перед вами 

возникнет подобная задача, выделите изображение 
с помощью инструмента Selection (Выделение), пос-
ле чего перетащите влево ползунок Opacity {Непро-
зрачность) в палитре Transparency (Прозрачность).
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ПОРЯДОК РАЗМЕЩЕНИЯ ОБЪЕКТОВ – ЭТО ВСЕ
Некоторые люди избегают использования прозрач-
ности в настольных издательских системах, однако 
при должном применении прозрачности можно 
достичь очень неплохих результатов. При этом 
достаточно следовать простым правилам, касаю-
щимся порядка размещения объектов. Вы можете 
использовать слои, однако проще запомнить, что 
сверху должны располагаться объекты, на которые 
прозрачность не может оказывать никакого воз-
действия. Например, если прозрачный объект рас-
положить над текстом, текст будет растеризован. 
Чтобы не допустить этого, на самом нижнем слое 
размещайте фоновое изображение, потом растро-
вые изображения, потом векторные изображения, 
а только потом основной текст и заголовки.

ИДЕНТИФИКАЦИЯ СТРАНИЦ С ПОМОЩЬЮ 
ПРОЗРАЧНЫХ ОБЪЕКТОВ

Иногда прозрачные объекты могут быть вам совершенно не нужны; кро-
ме того, вы можете быть не уверены в целесообразности использова-
ния прозрачности на определенных страницах. Данный совет позволит 
вам легко находить страницы, на которых присутствуют прозрачные 
объекты. Отобразите палитру Pages (Страницы) и внимательно изучи-
те ее содержимое. Если на значках определенных страниц вы увидите 
шахматный узор, это означает, что на них присутствуют прозрачные 
объекты.



InDesign CS
Советы знатоков

165Глава 6 • Работа с графикой

СТИЛИ СРЕДСТВА TRANSPARENCY FLATTENER
Ключ к успеху при печати документов, содер-
жащих прозрачные объекты, – использование 
стилей средства Transparency Flattener (Сведение 
прозрачности). Однако прежде чем создавать по-
добные стили, вам следует получить необходимые 
сведения в типографии, в которую в конечном 
итоге будет передан документ для печати. Но если 
вы самостоятельно печатаете документы InDesign, 
в которых используется прозрачность, данный со-
вет позволит вам значительно улучшить получае-
мые результаты. Выберите команду Transparency 
Flattener Presets (Стандартные установки сведения 
прозрачности) из меню Edit (Правка). По умолча-
нию доступно три стандартных набора настроек. 
Если вы хотите поэкспериментировать с собствен-
ными вариантами установок, щелкните на кнопке 

New (Создать). Задав подходящее положение ползунков и значения параметров, щелкните на кнопке ОК. 
Необходимый стиль сведения прозрачности следует выбрать в группе параметров Advanced (Дополнительно) 
диалогового окна Print (Печать). Экспериментируйте до тех пор, пока не достигните наилучших результатов 
при работе со своим конкретным устройством вывода.
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ИСПОЛЬЗОВАНИЕ ПРОЗРАЧНОСТИ ИЗ PHOTOSHOP
Попрощайтесь с обтравочными контурами. 
Photoshop предлагает замечательные инструменты 
для удаления фона в изображении. Преимущества-
ми данных инструментов можно воспользоваться и 
при работе в настольной издательской системе. В 
Photoshop разместите изображение на отдельном 
прозрачном слое и удалите фон. Сохраните изоб-
ражение в собственном формате Photoshop (.PSD), 
после чего разместите полученный файл в доку-
менте InDesign, воспользовавшись командой File⇒
Place (Файл⇒Разместить). Затем разместите 
вставленное изображение на самом верхнем слое.

ИСПОЛЬЗОВАНИЕ АЛЬФА-КАНАЛОВ PHOTOSHOP
Фотореставраторы часто используют 
альфа-каналы в качестве масок или 
сохраненных выделенных областей. 
Когда вам в следующий раз придет-
ся удалять фон во вставляемом из 
Photoshop изображении, убедитесь в 
том, что в нем присутствует альфа-
канал. Выделите вставленное изоб-
ражение Photoshop на стра-
нице документа, после чего 
выберите команду Clipping 
Path (Обтравочный контур) 
из меню Object (Объект). В 
раскрывающемся списке Type 
(Тип) выберите значение Alpha 
Channel (Альфа-канал). Если 
в изображении присутствует 
несколько альфа-каналов, 
укажите необходимый канал в 
раскрывающемся списке Alpha 
(Альфа-канал).
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АВТОМАТИЧЕСКОЕ СОЗДАНИЕ ОБТРАВОЧНЫХ 
КОНТУРОВ

Несмотря на то, что InDesign поддерживает рабо-
ту с файлами в собственном формате Photoshop, 
содержащими прозрачные слои, иногда вам могут 
потребоваться обтравочные контуры. Например, 
вы должны будете использовать обтекание текс-
том векторных изображений или изображений, в 
которых присутствуют обтравочные контуры. Если 
вы имеете дело с изображением с очень прос-
тым фоном, который не был удален в Photoshop, 
попробуйте сделать это в InDesign. Разместите 
изображение в документе (воспользовавшись ко-
мандой File⇒Place (Файл⇒Разместить)), после 
чего выберите команду Clipping Path (Обтравочный 
контур) из меню Object (Объект). Затем выберите 

значение Detect Edges (Определение границ) из меню Type (Тип). Установив флажок Preview (Предваритель-
ный просмотр), используйте ползунки Threshold (Порог) и Tolerance (Допуск) для удаления фона. Чтобы удалить 
темные оттенки, используйте параметр Invert (Инвертировать). Получив необходимые результаты, щелкните 
на кнопке ОК.
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ИСПОЛЬЗОВАНИЕ ПАЛИТРЫ TRANSPARENCY 
FLATTENER

Печать прозрачных участков 
- это достаточно сложная за-
дача. Когда вы в следующий 
раз будете отправлять на 
принтер документ InDesign 
CS, в котором присутствуют 
прозрачные участки, ис-
пользуйте палитру Flattener 
Preview (Просмотр результа-
тов сведения), чтобы оценить 
внешний вид документа при 
печати. Для отображения 
данной палитры выберите 
команду Window⇒Output 
Preview⇒Flattener (Окно⇒
Предварительный просмотр 
вывода⇒Сведение). Пос-
кольку данное средство про-
граммы очень ресурсоемкое, 
по умолчанию оно отключе-
но. Выберите различные варианты из раскрывающегося списка Highlight (Выделить) в верхней части палитры 
Flattener Pieview (Просмотр результатов сведения), чтобы увидеть, какие объекты в документе содержат про-
зрачность и, что наиболее важно, каково влияние прозрачности на объекты, расположенные на странице. За-
вершив просмотр различных объектов в документе, не забудьте выбрать из раскрывающегося списка Highlight 
(Выделить) значение None (Нет).
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ИЗМЕНЕНИЕ ПАРАМЕТРОВ СВЕДЕНИЯ ДЛЯ ОТДЕЛЬНЫХ
РАЗВОРОТОВ

Если вы работаете с до-
кументом, в котором при-
сутствуют изображения 
как высокого, так и низкого 
разрешения, тогда использо-
вания одного стиля сведения 
может оказаться недоста-
точно. В том случае, когда 
в документе присутствуют 
преимущественно изображе-
ния высокого разрешения, 
перейдите к развороту, на ко-
тором используются изобра-
жения низкого разрешения, 
и выберите команду Spread 
Flattening⇒Custom (Сведение 
разворота⇒Другое) из меню 
палитры Pages (Страницы). В 
результате вам будет предо-
ставлена возможность опре-
делить параметры сведения 
для определенного разворо-
та.
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Как вы и могли предположить, сущес-
твует целый ряд очень полезных сове-
тов, которые, тем не менее, к какой-то 
определенной категории отнести прос-
то невозможно. Они не имеют никакого 
отношения к макетированию и навигации по

УМЕНИЕ ПРОИЗВЕСТИ ВПЕЧАТЛЕНИЕ
Профессиональные приемы работы

документу. Это советы, знанием которых можно пох-
вастаться перед знакомыми. Они не просто полезны 
— они ошеломляют. Зная эти приемы, вы сможете 
решать самые сложные задачи Данные советы откры-
вают перед вами огромные возможности, поэтому их 
следует применять, чтобы привлечь внимание к своим 
работам и, быть может, завоевать звание “короля” 
InDesign. Запомните, подобные советы могут касаться 
всех аспектов работы с программой: настройки пара-
метров текста, макетирования и выполнения цветоде-
ления CMYK. Человек, применяющий подобные сове-
ты, всегда оказывается в выигрышной ситуации.
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КАК УМЕНЬШИТЬ РАЗМЕРЫ ФАЙЛА INDESIGN
Если вы когда-нибудь обращали внимание на размеры файлов своих документов 
InDesign, то наверняка заметили, что они очень быстро увеличиваются. Как пра-
вило, особых проблем это не создает, однако ситуация изменяется, как только 
перед вами возникает задача отправить документ по электронной почте (напри-
мер, нам это приходится делать регулярно). Этот небольшой совет позволит вам 
уменьшить размеры непомерно “раздувшегося” документа InDesign. Откройте 
документ в InDesign, после чего внести какие-то изменения. Любые. Например, 
просто перетащите направляющую или добавьте пробел. После этого просто 
сохранить документ недостаточно. Выберите команду File⇒Save As (Файл⇒
Сохранить как) и сохраните файл под старым именем. По какой-то причине при 
этом размеры файла значительно уменьшаются. Вот такие чудеса.

КОПИРОВАНИЕ ТЕНЕЙ С ПОМОЩЬЮ ИНСТРУМЕНТА 
EYEDROPPER

Добавить падающую тень к изображению или тек-
сту несложно (для этого при активном инструменте 
Selection (Выделение) следует выбрать команду 
Object⇒Drop Shadow (Объект⇒Падающая тень)). 
Однако после того, как вы потратите определенное 
время на настройку параметров тени, вы можете 
решить применить такую же тень к другим объек-
там в документе. Падающие тени – это атрибуты 
блока, а значит, можно использовать инструмент 
Eyedropper (Пипетка) для применения тени к другим 
объектам. Сначала при нажатой клавише <Shift> 
выделите все необходимые блоки с помощью инс-
трумента Selection (Выделение), после чего выбери-
те инструмент Eyedropper (Пипетка) и щелкните на границе блока, к которому добавлена тень. В результате 
тень будет добавлена к выделенным блокам. Данный совет позволяет намного быстрее достичь необходимых 
результатов, если щелкнуть чуть правее от границ блока.
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ИСПОЛЬЗОВАНИЕ НЕСКОЛЬКИХ ПРЕДСТАВЛЕНИЙ 
ОДНОГО ДОКУМЕНТА

Иногда возникает необходимость одновременно 
увидеть увеличенный и уменьшенный варианты 
изображения. Для открытия копии окна документа 
выберите команду Window⇒Arrange⇒New Window 
(Окно⇒Упорядочить⇒Создать окно). Разместив 
окна подходящим образом, для каждого из них 
задайте необходимый масштаб.

ХОТИТЕ УСКОРИТЬ INDESIGN?
ОТКЛЮЧИТЕ НЕНУЖНЫЕ ДОПОЛНИТЕЛЬНЫЕ МОДУЛИ

InDesign - приложение с модульной архитектурой, 
ориентированное на работу с различными допол-
нительными модулями. Это позволяет компании 
Adobe намного быстрее выпускать новые версии 
InDesign, поскольку функциональные возможности 
программы можно расширять с помощью дополни-
тельных модулей. Однако в любом случае InDesign 
поддерживает такое количество функций, что 
некоторые из них вообще не нужны. Таким обра-
зом, работу программы можно ускорить, отключив 
загрузку ненужных модулей. Для этого выберите 
команду Configure Plug-ins (Настроить дополнитель-
ные модули) из меню Edit (Правка) (на платформе 
Macintosh это меню InDesign), затем щелкните на 
кнопке Duplicate (Создать копию). Отключите не-
нужные дополнительные модули, сбросив флажки 
напротив их названий (например, в данном случае 
мы отключили загрузку модуля Hypeilinks Panel 

(Панель гиперссылок)), после чего щелкните на кнопке ОК. Чтобы изменения вступили в силу, вам придется 
закрыть, а затем повторно запустить InDesign.
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ВЫВОД ИЗОБРАЖЕНИЙ ВЫСОКОГО КАЧЕСТВА
Наверняка у вас возникал вопрос, почему изоб-
ражения не всегда выглядят так, как вам того 
хотелось бы, поскольку в InDesign по умолчанию 
используется представление Typical Display (Ти-
пичное отображение), характерное для настоль-
ных издательских систем какого-нибудь 1986 
года. Однако вам совсем не обязательно с этим 
мириться. Щелкните правой кнопкой (комбинация 
<Сntrol+щелчок> при активном инструменте Selec-
tion (Выделение)). В результате будет отображено 
контекстное меню, из которого следует выбрать 
команду Display Performance⇒High Quality Display 
(Быстродействие экрана⇒Высококачественное 
отображение). Данный прием можно использовать 
при работе в InDesign с изображениями любого типа, 
однако наилучших результатов вы достигнете при 
работе с изображениями в собственном формате 
программы Illustrator (EPS), а также с документами 
PDF, вставленными в документ InDesign.

НАСТРОЙКА БЫСТРОДЕЙСТВИЯ ЭКРАНА
Как уже отмечалось в предыдущем совете, пара-
метры быстродействия отображения можно за-
давать отдельно для каждого блока. Однако это 
еще не все. Вам предоставляется возможность 
задать параметры для трех режимов отображения 
– Optimized (Оптимизированное), Typical (Типич-
ное) и High Quality (Высокое качество). Перейдите 
на вкладку Display Performance (Быстродействие 
отображения) диалогового окна Preferences (Ус-
тановки), для отображения которого необходимо 
выбрать команду Preferences (Установки) из меню 
Edit (Правка) (на платформе Macintosh это меню 
InDesign). Затем в группе параметров Adjust View 
Settings (Настройка параметров отображения) вы-
берите необходимый переключатель.
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СОЗДАНИЕ ОБРЕЗОВ И РЕГЛЕТОВ БЕЗ 
ИСПОЛЬЗОВАНИЯ СТРАНИЦ УВЕЛИЧЕННОГО РАЗМЕРА

Вы все еще используете увеличенные страницы 
для представления сведений об обрезах и регле-
тах? Теперь этого делать не придется. Диалого-
вое окно New Document (Создание документа) 
программы InDesign CS позволяет создавать 
дополнительное пространство вокруг страницы 
документа для размещения сведений об обрезах и 
реглетах. Чтобы отобразить две дополнительные 
группы параметров в нижней части диалогового 
окна, достаточно щелкнуть на кнопке More Options 
(Больше параметров). Размеры можно задать как 
для обрезов, так и для реглетов. В результате вы 
создадите документы необходимого размера, и 
при этом также будете иметь пространство для 
размещения дополнительных сведений. Необхо-
димость печати обрезов или реглетов задается на 
вкладке Marks and Bleed (Отметки и обрез) диало-
гового окна Print (Печать).

ПРОСМОТР ОБРЕЗОВ И РЕГЛЕТОВ
В РЕЖИМЕ ПРЕДВАРИТЕЛЬНОГО ПРОСМОТРА

Как создать дополнительное пространство вокруг документа для пред-
ставления обрезов или реглетов, вы знаете, но как насчет просмотра 
этих сведений? Кроме того, как скрыть это пространство, когда в нем 
нет особой необходимости? В дополнение к режимам Normal View Mode 
(Обычный режим просмотра) и Preview Mode (Режим предварительно-
го просмотра) InDesign CS также предлагает такие режимы, как Bleed 
Mode (Режим обрезов) и Slug Mode (Режим реглетов). Доступ к ним вы 
получите, щелкнув на значке Preview Mode (Режим предварительного 
просмотра) в нижней части палитры инструментов для отображения 
меню, из которого можно выбрать необходимый режим отображения. 
Если же значки в палитре инструментов расположены в один столбец, 
для отображения соответствующего меню достаточно щелкнуть на 
значке Normal View Mode (Обычный режим просмотра).
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ИСПОЛЬЗОВАНИЕ ПАЛИТРЫ PATHFINDER ДЛЯ 
ОБЪЕДИНЕНИЯ ГЕОМЕТРИЧЕСКИХ ФИГУР

Нарисовать блоки неправильной формы с помощью 
инструментов Реn (Перо) или Polygon (Многоуголь-
ник) несложно, однако зачастую гораздо проще сна-
чала создать две фигуры, а затем объединить их. 
Нарисуйте две пересекающиеся фигуры с помощью 
соответствующих инструментов InDesign. Затем, 
удерживая нажатой клавишу <Shift>, с помощью 
инструмента Selection (Выделение) выделите обе 
фигуры. Теперь из меню Window (Окно) выберите 
команду Pathfinder (Исследователь). Как только па-
литра Pathfinder (Исследователь) будет отображена 
на экране, щелкните на соответствующем значке 
для объединения объектов.

УКАЗАНИЕ ЗНАЧЕНИЙ С ИСПОЛЬЗОВАНИЕМ 
НЕОБХОДИМЫХ ЕДИНИЦ ИЗМЕРЕНИЯ

Каждый пользователь имеет предпочтения в 
выборе единиц измерения. Для большинства 
американских пользователей это дюймы. Однако 
иногда в диалоговых окнах приходится задавать 
значения в пунктах, пиках и т.д. Не изменяя пара-
метры в диалоговом окне Preferences (Установки), 
можно просто ввести значение, а затем – условное 
обозначение единиц измерения. Например, чтобы 
задать значение 400 пунктов, в текстовом поле 
диалогового окна следует ввести 400 pt.
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КАК СКРЫТЬ ШАБЛОННЫЕ ЭЛЕМЕНТЫ НА ОТДЕЛЬНЫХ 
СТРАНИЦАХ

Никому не нравится, когда на первой странице отображается номер 1, однако 
как от него избавиться? Как правило, пользователи задают автоматическую 
нумерацию страниц для шаблонной страницы, после чего создают отдельные 
шаблоны для страниц без нумерации. Существует и более простой способ. При 
работе с подобными страницами достаточно выбрать команду Hide Master Items 
(Скрыть шаблонные элементы) из меню View (Вид). При работе с разворотами 
соответствующие элементы будут скрыты сразу на двух страницах.

ИСПОЛЬЗОВАНИЕ СРЕДСТВА STORY EDITOR ДЛЯ 
РЕДАКТИРОВАНИЯ ТЕКСТА

В первых версиях программы отсутствовало средс-
тво, к которому мы привыкли еще в PageMaker. Как 
вы могли догадаться, речь идет о средстве Story 
Editor (Редактор статей). Однако теперь оно снова 
появилось в программе. Средство Sto/y Editor (Ре-
дактор статей) позволяет вводить текст, а также 
вносить изменения и правки в документы InDesign 
в привычном для пользователей текстовых процес-
соров стиле. Наведите указатель мыши на любое 
место текстового блока, после чего выберите ко-
манду Edit in Stoiy Editoi (Правка в редакторе ста-
тей) из меню Edit (Правка). Теперь внесите все не-
обходимые изменения, независимо от того, сколько 
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КАК ОТРЫТЬ В INDESIGN ДОКУМЕНТЫ QUARKXPRESS
Примите поздравления, друзья мои! InDesign CS 
замечательно справляется с открытием докумен-
тов QuarkXPress. InDesign обеспечивает полную 
поддержку документов, созданных с помощью 
QuarkXPress (версий 3.3-4.1). Выберите команду 
File⇒Open (Файл⇒Открыть). Найдите документ 
QuarkXPress, который вам необходим, после чего 
щелкните на кнопке Open (Открыть). Через мгно-
вение документ QuarkXPress будет открыт вместе 
со всеми главными страницами, таблицами стилей 
и содержимым.

КАК ОТРЫТЬ В INDESIGN ДОКУМЕНТЫ PAGEMAKER
InDesign может открывать не только документы 
QuarkXPress. InDesign CS также замечательно 
справляется с такими задачами, как открытие до-
кументов, созданных в PageMaker 6.5 и PageMaker 
7.01. Если вы работаете в InDesign CS PageMaker 
Edition, то сможете открывать и документы 
PageMaker 6.0.
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ИСПОЛЬЗОВАНИЕ ПАЛИТРЫ INFO
ДЛЯ ПОЛУЧЕНИЯ СВЕДЕНИЙ ОБ ИЗОБРАЖЕНИИ

Итак, уже 4 часа 45 минут, а документ необходи-
мо напечатать к 5:00 утра. Однако вы не помните, 
выполняли преобразование изображений в режим 
CMYK или нет. Благодаря новой палитре Info (Све-
дения) можно просто щелкнуть на изображении, 
чтобы получить такую информацию о нем, как 
разрешение и цветовой режим Если подобные све-
дения в палитре Info (Сведения) не отображаются, 
выберите из меню палитры команду Show Options 
(Показать параметры).

ИСПОЛЬЗОВАНИЕ ИНСТРУМЕНТА MEASURE
ВМЕСТО ЛИНЕЕК

Предположим, что на странице документа содер-
жится фотография человека. Вам необходимо 
задать для всех изображений на странице такие 
же размеры, какие имеет изображение человека. 
Однако при этом возникает один закономерный 
вопрос. Каковы размеры изображения человека? 
Используя новый инструмент Measure (Измери-
тель) (в палитре инструментов он занимает одну 
ячейку с инструментом Eyedropper (Пипетка)), 
можно щелкнуть с одной стороны изображения 
человека и перетащить инструмент до другой 
стороны. При этом размеры изображения будут 
указаны в палитре Info (Сведения).
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ОТКЛЮЧИТЕ ВНЕДРЕННУЮ ГРАФИКУ, ЧТОБЫ 
УПРОСТИТЬ ПРОЦЕСС ПЕЧАТИ

Внедренные изображения категорически запре-
щено использовать при работе с определенными 
моделями принтеров, а также при сотрудничестве 
с определенными работниками типографии. Если 
не верите, позвоните в типографию и поинтересуй-
тесь, можно ли внедрять изображении в задание 
печати, готовящееся в InDesign. Вы наверняка 
услышите отрицательный ответ. К счастью, если 
вы или кто-то другой внедрили изображение в 
документ, ситуацию легко исправить. Выделив 
изображение, перейдите к палитре Links (Связи) 
(для ее отображения достаточно выбрать одно-
именную команду из меню Window (Окно)), после 
чего из меню палитры выберите команду Unembed 
File (Извлечь внедренный файл). InDesign CS поз-
волит сохранить файл в отдельной папке, создав 
при этом связь с изображением.

КАК ОТОБРАЗИТЬ ТОЛЬКО ОДИН СЛОЙ
При необходимости отобразить только один слой не обязательно пос-
ледовательно щелкать на значке в виде глаза напротив всех осталь-
ных слоев в палитре Layers (Слои). Удерживая нажатой клавишу <Alt> 
(<0ption>), щелкните на значке в виде глаза напротив того слоя, который 
должен быть видимым. В результате все остальные слои будут автома-
тически скрыты.
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ПЕРЕТАСКИВАНИЕ ДЛЯ ОТОБРАЖЕНИЯ
ИЛИ БЛОКИРОВКИ СЛОЕВ

В InDesign можно перетаскивать атрибуты видимости и блокировки сло-
ев. Перейдите к палитре Layers (Слои), затем щелкните мышью и пере-
тащите указатель по столбцу, в котором отображаются значки в виде 
глаза или карандаша, напротив соответствующих слоев, чтобы сразу 
изменить соответствующие атрибуты.
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Существуют ли такие средства InDesign 
CS, о которых вам еще ничего не извес-
тно? Конечно же, да. Еспи бы это было 
не так, зачем бы мы посвящали крытым 
средствам программы отдельную гла-
ву? На самом деле, представляя

СКРЫТЫЕ СОКРОВИЩА
Малоизвестные инструменты программы

новую версию InDesign, Adobe предлагает список из 
10 наиболее значимых новых функций программы, 
о которых потом трубят все средства массовой ин-
формации. В данном случае речь идет о вложенных 
стилях или палитре Separation Preview. Как правило, 
в СМИ представлена только та информация, которая 
была предложена компанией-разработчиком. Однако 
в каждой новой версии программы, как вы прекрасно 
понимаете, далеко не 10 или 12 новых функций, о 
которых пишут в журналах или в Internet. Появляется 
несколько десятков, а то и сотен улучшений, о кото-
рых по какой-то причине забывают упомянуть обозре-
ватели. В результате многие программные средства 
оказываются малоизвестными, хотя порой они очень 
полезны. Восполнить данный пробел в освещении 
функциональных возможностей программы — вот 
основная цепь. которую мы ставили перед собой, ра-
ботая над материалом настоящей главы.



InDesign CS
Советы знатоков

184 Глава 8 • Малоизвестные инструменты программы

ОТОБРАЖЕНИЕ СПИСКА КОМАНД МЕНЮ ПО АЛФАВИТУ
Сколько раз вам приходилось искать необходимую команду в меню? Вчера вы 
ее находили сразу, а сегодня она “пропала”. Вы точно знаете название команды, 
однако не можете ее найти. Если вы уже в отчаянии решили обратиться к руко-
водству пользователя, попробуйте пойти более простым путем и воспользуйтесь 
данным советом. Раскройте меню, предварительно нажав комбинацию клавиш 
<Shift+Alt+Ctrl> (<Shift+Option+�>). Теперь все команды будут упорядочены по 
алфавиту.

КАК БЫСТРО УКАЗАТЬ НЕОБХОДИМЫЕ ЕДИНИЦЫ 
ИЗМЕРЕНИЯ

Целый ряд приложений (в том числе Photoshop и Illustrator) позволяют ввести значение, а затем еще и ука-
зать необходимые единицы измерения. (Например, чтобы указать значение 72 пункта, введите 72 pt, а чтобы 
указать значение 3 дюйма - введите значение 3 in.). Однако InDesign CS позволяет вводить непосредственно 
единицы измерения. Например, чтобы задать значение в дюймах, можно ввести значение дюйма. (Например, 
чтобы ввести значение 7,3 дюйма, достаточно ввести 7,3”.) InDesign CS - это единственная программа, которая 
предоставляет подобную возможность.
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ИЗМЕНЕНИЕ ФОРМЫ БЛОКОВ С ПОМОЩЬЮ 
ИНСТРУМЕНТА PENCIL

Данным советом мы пользуемся практически каж-
дый день. Окружающий нас мир состоит не только 
из прямоугольников (если только вы не живете в 
мире игры Tetris). Изменить форму текстовых и гра-
фических блоков можно, перетащив их границы с 
помощью инструмента Pencil (Карандаш). Сначала 
выделите блок с помощью инструмента Selection 
(Выделение), после чего выберите инструмент 
Pencil (Карандаш) (для этого достаточно нажать 
клавишу <N>), затем переместите соответствую-
щие границы блока.

ПРОСТОЙ СПОСОБ СОЗДАНИЯ ГРАДИЕНТОВ
Создание градиентов в 
InDesign раньше требовало 
от пользователя дополни-
тельного внимания. Однако с 
выходом InDesign CS ситуация 
изменилась. Просто перемес-
тите необходимые образцы 
цвета на полосу градиентов 
в нижней части палитры 
Gradient (Градиент). Создав 
подходящий градиент, его 
можно перетащить из палитры 
Gradient (Градиент) в палитру 
Swatches (Образцы).



InDesign CS
Советы знатоков

186 Глава 8 • Малоизвестные инструменты программы

РАБОТА С ДИАЛОГОВЫМ ОКНОМ CORNER EFFECTS
Вы ищете инструмент Rectangle with Rounded 
Corners (Прямоугольник со скругленными углами)? 
Можете этого не делать, так как подобного инс-
трумента просто не существует. Сначала создайте 
прямоугольник с помощью обычного инструмента 
Rectangle (Прямоугольник), после чего выберите 
команду Corner Effects (Угловые эффекты) из меню 
Object (Объект). В появившемся диалоговом окне 
Corner Effects (Угловые эффекты) из раскрываю-
щегося списка Effect (Эффект) выберите значение 
Rounded (Скругление), затем задайте необходимую 
степень округления в текстовом поле Size (Размер). 
Обязательно установите флажок Preview (Предва-
рительный просмотр), чтобы сразу увидеть получен-
ные результаты. Для изменения значения параметра Size (Размер) можно использовать клавши <↑> и <↓>. 
Чтобы изменить значение параметра с большим шагом, в комбинации с этими клавишами следует использо-
вать клавишу <Shift>.

ВОССТАНОВЛЕНИЕ НУЛЕВОЙ ТОЧКИ
Вам уже наверняка известно, что если щелкнуть в точке пересечения 
линеек и перетащить ее, вы измените положение нулевой точки (т.е. 
точки, от которой отсчитываются значения на линейках. Многие ди-
зайнеры находят такую возможность очень полезной, поскольку бла-
годаря ей можно определить точные размеры объектов). Однако вос-
становить исходное положение нулевой точки непросто. К счастью, 
данный совет может оказать вам помощь. Для восстановления исход-
ного положения нулевой точки достаточно дважды на нем щелкнуть.
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ИЗМЕНЕНИЕ АТРИБУТОВ С ИСПОЛЬЗОВАНИЕМ 
ПРОЦЕНТНЫХ ЗНАЧЕНИЙ

Некоторые люди очень любят оперировать значениями, выраженными в процентах. Они выражают свои по-
желания в следующей форме: размеры необходимо увеличить на 33%. Если перед вами будет поставлена 
подобная задача, не нужно сразу тянуться к калькулятору. Просто выделите соответствующее текстовое поле 
в палитре Control (Управление), после чего введите необходимое значение параметра, выраженное в процен-
тах. Например, если вам необходимо увеличить значение параметра на 50%, введите 150%. Затем нажмите 
клавишу <Тab>, чтобы применить новое значение и “покинуть” поле.

КАК ПОЛУЧИТЬ СРЕДСТВА PAGEMAKER В INDESIGN CS
Поскольку компания Adobe официально прекра-
тила разработку и поддержку PageMaker в нача-
ле 2004 года, многим пользователям PageMaker 
не осталось ничего другого, как переходить на 
InDesign CS. Если вы относитесь к данной катего-
рии пользователей, вам имеет смысл приобрести 
за 49 долларов загружаемый с Web-узла компании 
Adobe дополнительный модуль, который добавляет 
некоторые функции PageMaker в InDesign (благо-
даря этому вам будет проще разобраться с новой 
программой). Этот дополнительный модуль назы-
вается Adobe PageMaker Plug-in Pack и предлагает 
восемь наиболее популярных средств PageMaker, в 
том числе панель инструментов, нумерованные и 
маркированные списки, шаблоны PageMaker, а так-
же сведения, упрощающие переход на InDesign CS. 
Подробные сведения представлены на Web-узле 
компании Adobe.
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КАК УВИДЕТЬ СТРАНИЦЫ ЕЩЕ ДО ОТКРЫТИЯ
Разве это не прекрасно – оце-
нить внешний вид документа 
lnDesign еще до его открытия? 
Однако для этого вам следует 
изменить установки InDesign. 
Перейдите на вкладку File 
Handling (Работа с файлами) 
диалогового окна Preferences 
(Установки). Теперь в группе 
параметров Saving InDesign 
Files (Сохранение файлов 
InDesign) установите флажок 
Save Document Preview Image 
(Сохранять изображение предварительного просмотра документа). Как только вы это сделаете, миниатюры 
документов InDesign будут отображены в диалоговом окне Open A File (Открытие файла).

УДАЛЕНИЕ ЛИШНИХ ОБЪЕКТОВ
Это один из тех советов, которым следует воспользоваться в том случае, 
когда кто-то наблюдает за вами (например, пользователь QuarkXPress 
наблюдает за вашей работой в InDesign). Щелкните на объекте, который 
решили удалить в InDesign, и перетащите его на значок мусорной кор-
зины на рабочем столе операционной системы. Особо полезным этот 
совет назвать тяжело, однако он позволит вам произвести впечатление 
на пользователей QuarkXPress.
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ПЕРЕТАСКИВАНИЕ ИЗОБРАЖЕНИЙ ИЗ ОКНА IРНОТО
Если вы работаете на платформе Macintosh, очень 
вероятно, что несколько изображений находятся в 
библиотеке iPhoto. Вам необходимо использовать 
их в InDesign? He экспортируйте, а просто перета-
щите их! Откройте документ InDesign, после чего 
запустите iPhoto. Теперь переместите необходи-
мые изображения на страницу документа.

ПЕРЕТАСКИВАНИЕ ИЗОБРАЖЕНИЙ ИЗ PHOTOSHOP CS
Средство File Browser (Брау-
зер) программы Photoshop CS 
чрезвычайно удобно. Оно поз-
воляет просматривать сотни 
фотографий в папке. Было бы 
прекрасно, если бы у вас была 
подобная возможность и при 
работе с InDesign, не так ли? 
И это действительно возмож-
но! Откройте окно File Browser 
(Браузер файлов) и найдите 
изображение. Создайте или 
откройте документ InDesign и 
перетащите в него изображе-
ние из окна File Browser (Бра-
узер файлов).
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СОЗДАНИЕ БЛОКА ОПРЕДЕЛЕННОГО РАЗМЕРА
ОДНИМ ЩЕЛЧКОМ МЫШИ

Итак, вам необходимо создать блок размерами точно 2,3х4,7 дюйма, и вы пы-
таетесь сделать это вручную? Не нужно этого делать! Выберите инструмент 
для создания блоков и один раз щелкните в документе. Теперь задайте необ-
ходимые значения параметров в появившемся диалоговом окне и щелкните на 
кнопке ОК.

СОЗДАНИЕ ДУПЛЕКСНЫХ ИЗОБРАЖЕНИЙ В INDESIGN
Итак, ваш бюджет ограничен, и вы можете позволить себе только 
двухцветную печать. Если текст может быть любого цвета, то как 
быть с изображениями? Кого сейчас можно привлечь изображени-
ями в оттенках серого? Конечно, можно раскрасить изображения 
TIFF, однако данный совет позволит повысить ваше мастерство. 
Выделив вставленное изображение TIFF или Photoshop с помощью 
инструмента Selection (Выделение), перетащите образец цвета из 
палитры Swatches (Образцы) на изображение, чтобы раскрасить 
тени в изображении. Таким образом вы сымитировали дуплексное 
изображение, не запуская Photoshop. Однако это еще не все! Теперь 
щелкните на другом образце (перетаскивать не нужно!). В результа-
те будут раскрашены яркие оттенки.



InDesign CS
Советы знатоков

191Глава 8 • Малоизвестные инструменты программы

ДОБАВЛЕНИЕ ГИПЕРССЫЛОК ИЛИ ЗАКЛАДОК
К ЛЮБОМУ ОБЪЕКТУ

Чаще всего полученные документы мы или пе-
чатаем, или размещаем в Web; но как быть, если 
необходимо и то, и другое? В подобных ситуациях 
мы создаем документы PDF на основе документов 
InDesign, однако данный совет позволит сделать до-
кументы PDF намного привлекательнее. Выделите 
любое изображение на странице с помощью инс-
трумента Selection (Выделение), после чего отобра-
зите контекстное меню (для этого щелкните правой 
кнопкой мыши (комбинация <Сontrol+щелчок>)), 
из которого выберите команду Interactive⇒New 
Нурerlink (Интерактивность⇒Создать гиперссылку). 
Теперь можно создать ссылку на страницу или адрес 

URL. Если пользователь щелкнет на изображении в документе PDF, он может перейти к указанной странице 
документа или же загрузить соответствующую Web-страницу.

ЭФФЕКТИВНАЯ ПРОКРУТКА
Итак, вы относитесь к той категории людей, ко-
торые предпочитают иметь дело с мышью, осна-
щенной не только колесиком, но и большим коли-
чеством кнопок. Иногда у вас возникают мысли о 
приобретении беспроводного устройства. Попро-
буйте воспользоваться данным советом. Вместо 
того чтобы прокручивать страницы сверху вниз, 
нажмите клавишу <Shift> и прокручивайте их сле-
ва направо.
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ИЗМЕНЕНИЕ МАСШТАБА ВЫДЕЛЕННЫХ ОБЪЕКТОВ
БЕЗ ИХ ГРУППИРОВКИ

Вы только что завершили раз-
работку макета, ваш заказчик 
(художественный директор, 
супруга... данный список можно 
продолжать до бесконечности) 
неожиданно изменил свое 
мнение. Теперь ваша работа 
будет представлять собой не 
плакат, а открытку. Выделите 
все объекты макета (в том чис-
ле текст), нажав комбинацию 
клавиш <Ctrl+A> (<�+A->), пос-
ле чего перейдите к палитре 
Control (Управление) и укажите 
новое значение масштаба в 
соответствующих текстовых 
полях.
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ИСПОЛЬЗОВАНИЕ ОБВОДКИ
Всем нам уже надоели старые 
стили: сплошная линия, толс-
тая линия, пунктирная линия... 
Эти стили используются на 
протяжении многих лет, а их 
активное применение указы-
вает на то, что ваши пред-
ставления о правилах дизайна 
сформировались очень давно. 
Поэтому давайте подумаем о 
том, чтобы нарушить устояв-
шиеся традиции. Вам необхо-
димо использовать какие-то 
уникальные стили линий в 
своих макетах. Отобразите па-
литру Stroke (Обводка), выбрав 
одноименную команду из меню 
Window (Окно), после чего в 
меню палитры перейдите к 
команде Stroke Styles (Стили 
обводки). Щелкните на кнопке 
New (Создать), затем выбери-
те необходимый стиль линии 
из раскрывающегося списка 

Type (Тип) и откорректируйте его, используя параметры, расположенные ниже. Подобрав стиль линии, сохра-
ните его. Укажите подходящее название и щелкните на кнопке ОК.
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ЧЕТЫРЕХЦВЕТНАЯ ПЕЧАТЬ ПРИ ОГРАНИЧЕННОМ 
БЮДЖЕТЕ

Вы разработали замечатель-
ный макет, однако ваш за-
казчик может позволить себе 
только двухцветную печать. 
Данный совет позволит вам сэ-
кономить целый рабочий день! 
Смешайте красители! Создай-
те два образца, представля-
ющие технологические цвета. 
Для этого выберите команду 
New Color Swatch (Создать об-
разец цвета) из меню палитры 
Swatches (Образцы). В раскры-
вающемся списке Color Type 
(Тип цвета) укажите значение 
Spot (Технологический), с по-
мощью ползунков выберите 
необходимый цвет, после чего 
щелкните на кнопке ОК. Выпол-
ните эти же действия для опре-
деления второго цвета. Теперь 
в меню палитры Swatches (Об-
разцы) перейдите к команде 
New Mixed Ink Group (Создать 
группу смешанных красителей). На экране будет отображено диалоговое окно, в котором, помимо четырех 
основных цветов (голубой, пурпурный, желтый и черный), также будут представлены два созданных вами 
технологических цвета Щелкните на небольшом пустом поле напротив образцов технологических цветов. При 
этом вам придется заняться математикой. Для каждого красителя вам следует задать исходное значение (оно 
может быть нулевым). После этого укажите количество шагов и величину приращения. В конечном итоге, 
вам ни в коем случае нельзя превысить значение 100%. Поэтому если вы начали с нулевого значения, то при 
использовании пяти шагов величина приращения должна составить 20%, а при использовании десяти шагов 
– 10%. Повторим еще раз: ни в коем случае не должно быть превышено значение 100%. Однако если это и про-
изойдет, ничего страшного; InDesign отобразит предостережение и уменьшит полученное значение до 100%. 
Выполнив подобные действия для каждого образца, щелкните на кнопке Preview Swatches (Предварительный 
просмотр). В результате появится список образцов, которые можно использовать при работе. Сколько бы 
образцов не было доступно, для печати можно будет обойтись несколькими из них.
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КАК ИЗМЕНИТЬ ТЕХНОЛОГИЧЕСКИЙ ЦВЕТ?
В самый последний момент заказчик позвонил и 
попросил изменить один из технологических цве-
тов. Что же делать? На самом деле все далеко 
не так плохо, как могло показаться на первый 
взгляд. Перейдите к палитре Swatches (Образцы) 
и дважды щелкните на образце смешанного кра-
сителя, созданном при выполнении предыдущего 
совета. В появившемся диалоговом окне Mixed 
Ink Group Options (Параметры группы смешанных 
красителей) выберите из раскрывающегося спис-
ка цвет, который вам необходимо заменить, после 
чего щелкните на более подходящем образце. Как 
только вы это сделаете, цвета соответствующих 

объектов будут обновлены! Не забудьте потребовать у заказчика оплатить несколько дополнительных часов 
работы (ведь ему о данном совете ничего не известно!).

НАЗАД В БУДУЩЕЕ
Вы услышали безумный крик в соседней комнате? Им что, отключили электри-
чество7 Их компьютер завис? Нет, они просто щелкнули на кнопке Save (Сохра-
нить), а не Save As (Сохранить как). При этом они просто уничтожили преды-
дущую копию документа. Однако вы-то знаете, как им помочь. Несколько раз 
нажмите комбинацию клавиш <Ctrl+Z> (<�+Z>) (она соответствует команде Undo 
(Отменить)), чтобы восстановить исходный вариант документа, после чего выбе-
рите команду Save As (Сохранить как) из меню File (Файл). Благодаря вам ваши 
сотрудники спасены.
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ЧТО-ТО ПОШЛО НЕ ТАК? УДАЛИТЕ ФАЙЛ УСТАНОВОК
Если по какой-то причине 
InDesign CS ведет себя как-то 
не так, и вы решили восстано-
вить исходные параметры про-
граммы, вместо того, чтобы 
пытаться вспомнить значения 
параметров, заставьте InDesign 
сделать это автоматически. 
Закройте программу, после 
чего нажмите комбинацию 
клавиш <Shift+Ctrl+Alt> (<Shift+�+Option>) и запустите InDesign повторно. На экране будет отображено 
диалоговое окно, в котором вам следует подтвердить удаление файла установок InDesign. Щелкните на кнопке 
Yes (Да), чюбы программа удалила текущий файл настроек и создала новый (со стандартными значениями 
параметров). (Примечание: если вы запускаете InDesign из панели Dock на платформе Mac OS X, сначала 
щелкните на значке InDesign, а только потом немедленно нажмите комбинацию клавиш.)

ВСЕ ДОСТУПНЫЕ КОМБИНАЦИИ КЛАВИШ
ЗАПОМИНАТЬ СОВСЕМ НЕ ОБЯЗАТЕЛЬНО

Несмотря на то, что комбинации 
клавиш в некоторых ситуациях 
оказываются очень кстати, за-
поминать их все нет никакой на-
добности. Чаще всего намного 
удобнее использовать контекс-
тные меню. Попробуйте вос-
пользоваться данным советом. 
Вместо того, чтобы пытаться 
найти какую-то команду в меню, 
которую следует применить к 
определенному объекту, щел-
кните на этом объекте правой 
кнопкой мыши (<комбинация 
<Соntrol+щелчок>). В результа-
те будет отображено контекс-
тное меню, в котором перечис-
ляются наиболее часто используемые команды, применяемые к объектам данного типа.
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КАК БЫСТРО ОТОБРАЗИТЬ ВКЛАДКУ
UNITS & INCREMENTS

При работе с текстом одни пользователи (как правило, работники типографиифии) отдают предпочтение пунк-
там, а другие (Web-дизайнеры) - пикселям. Если после выбора инструмента Type (Текст) вам потребуется быс-
тро отобразить вкладку Units & Increments (Единицы измерения и приращения) диалогового окна Preferences 
(Установки), дважды щелкните на значке Kerning (Кернинг) в палитре Control (Управление) при нажатой кла-
више <Alt> (<0ption>). Как видите, к меню Edit (Правка) (меню InDesign на платформе Macintosh) обращаться 
необязательно.

КАК БЫСТРО ОТОБРАЗИТЬ ДИАЛОГОВОЕ ОКНО MOVE
Чтобы быстро переместить какой-то объект, ис-
пользуя диалоговое окно Move (Перемещение), 
щелкните на объекте, который необходимо пере-
местить. После этого при нажатой клавише <Alt> 
(<0ption>) щелкните на значке координаты Х или Y 
в палитре Control (Управление). В результате диало-
говое окно Move (Перемещение) немедленно будет 
отображено на экране. Вряд ли есть способ сделать 
это быстрее.
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БЫСТРОЕ ИЗМЕНЕНИЕ МАСШТАБА
Итак, вам уже известно, как отображать диалоговое окно Move (Перемещение), однако для изменения масш-
таба объектов вам не обойтись без диалогового окна Scale (Масштаб). Щелкнув на объекте, масштаб которого 
необходимо изменить, при нажатой клавише <Alt> (<0ption>) щелкните на значке Horizontal Scale (Масштаб 
по горизонтали) или Vertical Scale (Масштаб по вертикали) в палитре Control (Управление). В результате 
диалоговое окно Scale (Масштаб) появится на экране.
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Это достаточно большая глава. Почему? 
Да потому, что она посвящена работе 
со страницами макета, добавлению и 
редактированию страниц, добавлению 
к ним нумерации, созданию шаблонных 
страниц, а также многим другим темам.

ПЕРЕЛИСТЫВАЕМ СТРАНИЦЫ
Работа со страницами

Если вы работаете только с однострочными докумен-
тами, нужно пи вам читать материал настоящей гла-
вы7 Конечно да! Потому что в ее последних разделах 
представлены советы, которые окажутся полезными 
независимо от того, с документами какого размера вам 
приходится работать. С какими бы докуменпчами вы ни 
имели бы депо, материал настоящей главы будет для 
вас очень полезным.
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КАК ПОМЕСТИТЬ ВИДЕОРОЛИК В ДОКУМЕНТ
Как правило, напечатанные документы и видеороли-
ки QuickTime не имеют ничего общего друг с другом. 
В конце концов, в случае напечатанного документа 
мы имеем дело со статическими изображениями и 
цветовой моделью CMYK, а в случае видеороли-
ков QuickTime – динамическими изображениями 
и цветовой моделью RGB. Зачем же вам может 
понадобиться размещать видеоролик QuickTime в 
документе InDesign? Это очень кстати при созда-
нии документов PDF или размещении документов 
в Web. Выполните команду Place (Разместить) в 
меню File (Файл), после чего выберите видеоролик 
QuickTime. Конечно, в напечатанном документе вы 
увидите только статическое изображение, однако 
при экспорте в PDF или упаковке для GoUve вы по-
лучите полнофункциональный ролик QuickTime.

ВЫБОР ДРУГОЙ РАМКИ ПОСТЕРА
Большинство роликов QuickTime “проявляются” 
из черного фона. Однако черный прямоугольник 
в напечатанном документе – это наверняка не-
сколько не то, что вы хотели бы увидеть. Поэтому 
чтобы избежать получения непривлекательного 
напечатанного документа, документа PDF или Web-
узла, в диалоговом окне Movie Options (Параметры 
видеоролика) (для отображения которого доста-
точно дважды щелкнуть на значке видеоролика 
QuickTime) выберите из раскрывающегося списка 
Poster (Постер) значение Choose an Image as Poster 
(Выбрать изображение в качестве постера). Щелк-
ните на кнопке Browse (Обзор) и найдите подходя-
щее изображение CMYK в формате Photoshop или 
изображение в формате TIFF. Подобное изображе-
ние следует создать с помощью Photoshop заранее, 
чтобы его размеры точно соответствовали разме-
рам кадра видеоролика.
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ИМПОРТ ЗВУКОВЫХ ФАЙЛОВ
Размещение видеороликов – это, вне всякого 
сомнения, очень интересно, но как насчет раз-
мещения звуков? Предположим, что вам необхо-
димо оставить для заказчика какие-то звуковые 
комментарии. Можно записать свои замечания 
с помощью любой программы для записи звука, 
после чего сохранить в подходящем формате и 
разместить в документе InDesign. Теперь при про-
смотре документа PDF будет воспроизводиться 
соответствующий звуковой файл. Изучив другие 
советы из настоящей главы, вы сможете создать 
в документе кнопки, щелкнув на которых начнете 
воспроизведение звукового файла.

ИСПОЛЬЗОВАНИЕ АНИМАЦИИ FLASH
И наконец, документы PDF, создаваемые с помо-
щью InDesign, можно оживить, используя в них 
анимацию Flash (.SWF). Для размещения файлов 
.SWF достаточно выполнить те же действия, что 
и для размещения видеороликов. Однако после 
двойного щелчка на значке файла .SWF вам обя-
зательно необходимо установить флажок Play on 
Page Turn (Воспроизведение при переходе между 
страницами) в диалоговом окне Movie Options (Па-
раметры видеоролика). Это обеспечит воспроизве-
дение анимации при открытии документа PDF.
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ВНЕДРЕНИЕ МУЛЬТИМЕДИЙНЫХ ФАЙЛОВ
В документах PDF на протяже-
нии уже достаточно долгого 
времени можно использовать 
такие мультимедийные файлы, 
как видеоролики QuickTime. 
Однако при этом на самом деле 
в документе содержались толь-
ко ссылки на файлы, а значит, 
их приходилось отправлять 
заказчику отдельно. Если вам 
необходимо, чтобы все эле-
менты сохранялись именно в 
документе PDF, перейдите на 
вкладку General (Общие) диало-
гового окна Expoit PDF (Экспорт 
в PDF). В группе параметров 
Options (Параметры) выберите 
из раскрывающегося списка 
Compatibility (Совместимость) 
значение Acrobat 6 (PDF 1.5), 
а из раскрывающегося спис-
ка Multimedia (Мультимедиа) 
– значение Embed All (Внедрять 
все). Недостаток данного подхода состоит в том, что для просмотра полученного документа PDF потребуется 
Acrobat Reader 6 или полная версия Acrobat 6.
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СОЗДАНИЕ ИНТЕРАКТИВНЫХ КНОПОК
Файлы PDF могут быть интерактивными, а вы сможете использовать данный совет для создания кнопок, вы-
полняющих определенные функции в экспортированных документах PDF. Например, если вы разместили в 
файле PDF видеоролик QuickTime, можно добавить кнопки для управления воспроизведением видеоролика. 
Разместив в документе подходящее изображение, нарисуйте вокруг него кнопку с помощью инструмента Button 
(Кнопка), Затем выберите инструмент Selection (Выделение) и дважды щелкните на кнопке. В результате на 
экране будет отображено диалоговое окно Button Options (Параметры кнопки). Перейдите на вкладку Behaviors 
(Поведения), чтобы создать поведение, отвечающее за воспроизведение видеоролика при наведении указа-
теля мыши. Из раскрывающегося списка Event (Событие) выберите значение Mouse Up (Наведение мыши). В 
раскрывающемся списке Behavior (Поведение) перейдите к значению Movie (Видеоролик). В результате станут 
доступны еще два раскрывающихся списка: один для выбора видеоролика, который необходимо воспроизво-
дить, а другой – для выбора параметров воспроизведения. Задав все необходимые параметры, щелкните на 
кнопке Add (Добавить), а затем - на кнопке ОК.
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ЕСЛИ СТАТИЧЕСКОЙ КНОПКИ НЕДОСТАТОЧНО
Давайте расширим функции интерактивной кнопки. Создание кнопки - это одно дело (см. предыдущий совет), 
однако создание эффекта ролловера - это совершенно другое. Например, при наведении на кнопку указателя 
мыши может отображаться другое изображение. Вам понадобится не только само изображение, но и кнопка, 
которая станет видимой при наведении указателя мыши.

1. Выделите изображение, которое должно появ-
ляться при наведении указателя мыши, после 
чего выберите команду Convert to Button (Преоб-
разовать в кнопку) из меню Object⇒Interactive 
(Объект⇒Интерактивные элементы).

2. Дважды щелкните на только что созданной 
кнопке при активном инструменте Selection 
(Выделение), после чего в появившемся диало-
говом окне Button Options (Параметры кнопки) 
укажите название over image (над изображе-
нием). Из раскрывающегося списка Visibility in 
PDF (Отображение в PDF) выберите значение 
Hidden (Скрыта) и щелкните на кнопке ОК.
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3. При активном инструменте Selection (Выделе-
ние) дважды щелкните на исходной кнопке, 
после чего на вкладке Behaviors (Поведения) оп-
ределите два поведения. Первое из них называ-
ется Mouse Enter (Наведение указателя мыши) 
и отвечает за отображения изображение при 
наведении указателя мыши на кнопку. Поэтому 
из раскрывающегося списка Event (Событие) 
выберите значение Mouse Enter (Наведение 
указателя мыши), а из раскрывающегося списка 
Behavior (Поведение) - значение Show/Hide Fields 
(Показать/Скрыть поля). Щелкните напротив 
пункта over image (над изображением), чтобы 
добавить значок в виде глаза, затем щелкните 
на кнопке Add (Добавить).

4. Второе действие называется Mouse Exit (Сме-
щение указателя мыши), оно отвечает за 
сокрытие изображения. Выберите из раскры-
вающегося списка Event (Событие) значение 
Mouse Exit (Смещение указателя мыши), после 
чего пощелкайте напротив пункта over image 
(над изображением), пока не будет отображен 
перечеркнутый значок в виде глаза. Щелкните 
на кнопке Add (Добавить), а затем – на кнопке 
ОК. После создания документа PDF в нем будет 
присутствовать кнопка с эффектом ролловера.
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ОПРЕДЕЛЕНИЕ СТИЛЯ ЭКСПОРТА В ФОРМАТ PDF
Задав значения параметров экспорта в формат 
PDF, воспользуйтесь данным советом для того, что-
бы избежать необходимости каждый раз с самого 
начала устанавливать параметры экспорта. Выбе-
рите команду Export (Экспорт) из меню File (Файл), 
затем щелкните на кнопке Save (Сохранить). В по-
явившемся диалоговом окне Export PDF (Экспорт в 
PDF) задайте необходимые параметры. После этого 
щелкните вначале на кнопке Save Preset (Сохранить 
набор параметров), потом – на кнопке ОК. Новый 
набор параметров станет доступным в раскрываю-
щемся списке Preset (Стандартные установки) в вер-
хней части диалогового окна Export PDF (Экспорт в 
PDF).

ИСПОЛЬЗОВАНИЕ СТИЛЕЙ ЭКСПОРТА PDF
Как только вы определите стиль экспорта PDF, 
для создания документов PDF достаточно будет 
выбрать данный стиль из меню File⇒PDF Export 
Presets (Файл⇒Стандартные установки экспорта 
PDF). На экране появится диалоговое окно Export 
PDF (Экспорт в PDF), в котором сразу будут зада-
ны все необходимые значения параметров.
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ДОБАВЛЕНИЕ ССЫЛКИ НА WEB-УЗЕЛ
Если вы намереваетесь экспортировать документ 
в формат PDF, InDesign может добавить интерак-
тивные гиперссылки, которые будут активны и в 
документах PDF. Если вы ввели действительный 
адрес URL в документ, выделите адрес, после 
чего отобразите палитру Hyperlinks (Гиперссылки), 
выбрав одноименную команду из меню Window⇒ 
Interactive (Окно⇒Интерактивные элементы). За-
тем из меню палитры Hyperlinks (Гиперссылки) вы-
берите команду New Hyperlink From URL (Создать 
гиперссылку на основе адреса URL). Гиперссылка 
будет отображена в палитре Hyperlinks (Гипер-
ссылки); она остается активной и после экспорта 
документа в формат PDF.

СОЗДАНИЕ ДИНАМИЧЕСКОЙ ССЫЛКИ
НА ДРУГУЮ СТРАНИЦУ

Итак, вы уже знаете, как создать гиперссылку на 
Web-страницу, но ведь вам может понадобиться 
создать ссылку на другую страницу того же доку-
мента PDF. К счастью, InDesign позволяет делать 
это автоматически при использовании средства 
Table of Contents (Содержание). Но как быть, 
если вам необходимо создать ссылку вручную? 
В данном случае воспользуйтесь следующим со-
ветом. Переидите к странице, на которой должен 
осуществляться переход при щелчке на ссылке. 

Выберите команду New Hyperlink Destination (Создать гиперссылку назначения) из меню палитры Hyperlinks 
(Гиперссылки). Из раскрывающегося списка Type (Тип) выберите значение Page (Страница), а также укажите 
номер страницы, который будет использован в ссылке. Щелкните на кнопке ОК, после чего перейдите к стра-
нице, на которой должна располагаться ссылка, и выберите команду New Hyperlink (Создать гиперссылку) 
из меню палитры Hyperlinks (Гиперссылки). В диалоговом окне New Hyperlink (Создание гиперссылки) укажи-
те подходящее название, а также выберите только что указанную страницу назначения из раскрывающего 
списка Name (Имя). При экспорте документа в формат PDF все ссылки остаются активными. Обязательно 
установите флажок Hyperlinks (Гиперссылки) в группе параметров Include (Включать) вкладки General (Общие) 
диалогового окна Export PDF (Экспорт в PDF).
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АВТОМАТИЧЕСКОЕ ПРЕОБРАЗОВАНИЕ ССЫЛОК В 
ДОКУМЕНТАХ WORD

Вы сможете сэкономить время и усилия, если для 
подготовки текста, в конечном итоге применяемо-
го в InDesign, используется текстовый процессор 
Microsoft Word. Если вы точно уверены в том, что в 
документе PDF будут использованы гиперссылки, их 
можно подготовить непосредственно в Word. Допус-
тимые форматы гиперссылок имеют следующий вид: 
http://www.yoursite.whatever, http://yoursite. whatever, 
www.yoursite.whatever и somebody@soinedoniain.
whatever. Если вы зададите в документе Word ги-
перссылки именно в таких форматах, InDesign авто-
матически выполнит их преобразование.

КАК ИЗБАВИТЬСЯ ОТ РАМОК ВОКРУГ ССЫЛОК
Один из “побочных” эффектов работы с файлами 
Word, содержащими ссылки на адреса URL, состоит 
в том, что при печати ссылки отображаются в чер-
ных рамках. Это связано с тем, что по умолчанию 
InDesign отображает гиперссылки на фоне прямо-
угольника. Чтобы избежать этого, обратитесь к па-
литре Hyperlinks (Гиперссылки), выбрав одноимен-
ную команду из меню Window⇒Interactive (Окно⇒
Интерактивные элементы). Дважды щелкните на 
одной из импортированных ссылок. Гиперссылкам 
соответствуют названия Hyperlink 1 (Гиперссылка 
1), Hyperlink 2 (Гиперссылка 2) и т.д. В диалоговом 
окне Hyperlink Options (Параметры гиперссылки) в 
группе параметров Appearance (Внешний вид) из 
раскрывающегося списка Type (Тип) выберите значение Invisible Rectangle (Невидимый прямоугольник). Дан-
ные действия необходимо выполнить для каждой импортированной гиперссылки.
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ИСПОЛЬЗОВАНИЕ СЛОЕВ С ЦЕЛЬЮ ПРЕДОСТАВЛЕНИЯ 
ВОЗМОЖНОСТИ ВЫБОРА

Если вы решили произвести на заказчика сильное 
впечатление, предоставьте ему возможность вы-
брать один из возможных вариантов оформления 
документа. Данный совет позволит вам создать 
документ PDF, содержащий несколько вариантов 
оформления документа. Для этого достаточно 
использовать слои! Создайте три слоя и назовите 
их Design 1, Design 2 и Design 3. Теперь назначьте 
каждому слою определенный макет документа. За-
тем скройте слои Design 2 и Design 3, щелкнув на 
значке в виде глаза напротив их названий в палит-
ре Layers (Слои). Из меню File⇒PDF Export Presets 
(Файл⇒Стандартные установки экспорта PDF) 
выберите команду [Acrobat 6 Layered) (Acrobat 6 со 
слоями). Укажите название документа, щелкните 
на кнопке Save (Сохранить), после чего щелкните 
на кнопке Export (Экспорт) диалогового окна Export 
PDF (Экспорт в PDF). В результате будет создан 
документ со слоями, совместимый с форматом 
Acrobat 6 (PDF 1.5). Если у вас есть Acrobat Reader 
6 или полная версия Acrobat б, вы сможете легко 
отображать и скрывать слои документа.

СОЗДАНИЕ ЗАКЛАДОК ДЛЯ ПЕРЕМЕЩЕНИЯ
ПО ДОКУМЕНТУ

Закладки в документах PDF используются достаточно дав-
но. Однако при работе с полной версией Acrobat закладки 
приходится создавать вручную. Данный совет позволит со-
здавать закладки непосредственно в InDesign CS. Отобразите па-
литру Bookmarks (Закладки), выбрав одноименную команду из меню 
Window⇒Interactive (Окно⇒Интерактивные элементы). Перейдите к 
странице, для которой необходимо создать закладку (мы рекоменду-
ем перемещаться по документу от его начала до конца), после чего 
щелкните на значке Create new bookmark (Создать новую закладку) в 
нижней части палитры Bookmarks (Закладки). В результате будет со-
здана закладка Bookmark. Она выделена, поэтому при необходимости 

ее можно переименовать. Выполните эти действия для каждой страницы, к которой необходимо добавить 
закладку.
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СОЗДАНИЕ ГРУПП ЗАКЛАДОК
Если вы создали несколько закладок, которые можно объединить под 
одним заголовком (например, закладки на страницы одной главы), 
перед экспортом документа в формат PDF их можно сгруппировать. 
Для этого достаточно перетащить закладки друг на друга. Как только 
закладка, которую вы перетаскиваете, станет выделенной, можете от-
пустить кнопку мыши.

НИКОМУ НЕЛЬЗЯ ВЕРИТЬ – ЗАЩИТА ДОКУМЕНТА 
ПАРОЛЕМ

Совсем необязательно быть Джеймсом Бондом, 
чтобы нуждаться в хорошей защите докумен-
тов. Если вы передаете важные сведения через 
Internet, защита документов PDF, как говорится, 
поможет вам крепче спать. Перейдите на вкладку 
Security (Безопасность) диалогового окна Export 
PDF (Экспорт в PDF). Установите флажок Require a 
password to open the document (Запрашивать пароль 
при открытии документа). Затем в текстовом поле 
Document Open Password (Пароль для открытия 
документа) введите пароль, который согласовали 
с получателем, например, во время телефонного 
разговора. При экспорте документа в формат PDF 
InDesign CS предложит вам подтвердить знание 
пароля.
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КАК ЗАПРЕТИТЬ ПЕЧАТЬ ДОКУМЕНТА
Если вы хотите показать заказчику документ в 
электронной форме, это вовсе не означает, что вы 
должны рисковать своей работой. Отправляйте 
документ PDF в такой форме, которая не позволит 
напечатать его. На вкладке Security (Безопасность) 
диалогового окна Export PDF (Экспорт в PDF) при-
сутствует флажок Use a password to restrict printing, 
editing and other tasks (Использовать пароль для ог-
раничения печати, редактирования и выполнения 
других задач). Установите этот флажок, чтобы 
активизировать раскрывающийся список Printing 
Allowed (Разрешить печать), из которого можно 
выбрать следующие значения: None (Нет), Low 
Resolution (150 dpi) (Низкое разрешение (150 dpi)) 
и High Resolution (Высокое разрешение). (Приме-
чание: вариант Low Resolution (150 dpi) (Низкое 
разрешение (150 dpi)) будет недоступен, если для 

документов PDF задана совместимость с Acrobat 4. Прежде чем выполнять экспорт документа в PDF, выбери-
те значение None (Нет), после чего в текстовом поле Permissions Password (Пароль на разрешение) введите 
подходящий пароль. Получатель сможет открыть документ PDF, однако не сможет отправить его на печать.)
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КАК ЗАПРЕТИТЬ РЕДАКТИРОВАНИЕ ДОКУМЕНТА
Еще один способ защитить документ PDF, особенно 
в том случае, если он будет размещаться на Web-
узле, – запрет на его редактирование. Это особенно 
важно для документов таких типов, как контракт, 
пресс-релиз или годовой отчет. Установите фла-
жок Use a password to restrict printing, editing and 
other tasks (Использовать пароль для ограничения 
печати, редактирования и выполнения других за-
дач) на вкладке Security (Безопасность) диалого-
вого окна Export PDF (Экспорт в PDF). Выберите 
значение None (Нет) из раскрывающегося списка 
Changes Allowed (Разрешить внесение изменений). 
Прежде чем выполнять экспорт документа в PDF, 
в текстовом поле Peimissions Password (Пароль на 
разрешение) введите подходящий пароль.

СОВМЕСТИМОСТЬ С ПРЕДЫДУЩИМИ ВЕРСИЯМИ 
ACROBAT

Далеко не все пользователи переходят на использо-
вание новых версий программ сразу после их выхо-
да. Если вам необходимо отправить документ PDF 
другому человеку, и вы не уверены, какую именно 
версию Acrobat он использует, на вкладке General 
(Общие) диалогового окна Export PDF (Экспорт 
по PDF) из раскрывающегося списка Compatibility 
(Совместимость) выберите значение Acrobat 4 (PDF 
1.3).
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ИСПОЛЬЗОВАНИЕ РАЗВОРОТОВ
Если вы использовали в документе развороты, 
скорее всего, вы захотите увидеть их и после эк-
спорта в PDF. Для этого достаточно установить 
флажок Spreads (Разворот) в диалоговом окне 
Export PDF (Экспорт в PDF). Теперь в документах 
PDF будут содержаться все развороты, которые 
присутствовали в исходном документе InDesign.

A ЧTO ЖE TAKOE PDF/X?
PDF/X – это подмножество PDF, предназначенное 
для печати. Данный формат совершенно не под-
держивает мультимедиа, гиперссылки и другие 
не имеющие отношения к печати функции PDF. 
Существует две версии формата PDF/X: PDF/X-1a 
и PDF/X-3. Формат PDF/X-1а предназначен только 
для печати CMYK {и печати с использованием тех-
нологических цветов); формат PDF/X-3 поддержи-
вает управление цветом, в том числе и RGB. Для 
создания наиболее подходящего для печати доку-
мента PDF в InDesign выберите значение PDF/X-1а 
из раскрывающегося списка Standard (Стандарт) 
диалогового окна Export PDF (Экспорт в PDF).



InDesign CS
Советы знатоков

216 Глава 9 • Создание документов PDF

ОБЕСПЕЧЕНИЕ МАЛОГО РАЗМЕРА И ПРИЕМЛЕМОГО 
КАЧЕСТВА

Все мы хотим получать файлы PDF как можно 
меньшего размера, особенно в том случае, если их 
необходимо размещать в Web или отправлять по 
электронной почте. Однако заданные в InDesign по 
умолчанию настройки приводят к тому, что файлы 
PDF оказываются недостаточно качественными, 
что становится особенно заметным при увеличении 
масштаба документа. Если требуется обеспечить 
малый размер файла и приемлемое качество до-
кумента PDF, попробуйте воспользоваться дан-
ным советом. Начните с выбора значения Screen 
(Экран) из раскрывающегося списка Preset (Уста-
новки) в диалоговом окне Export РDF (Экспорт в 
PDF), после чего в группе параметров Compression 
(Сжатие) увеличьте разрешение с 72 ppi до 150 ppi. 
Это приведет к небольшому увеличению размеров 
файла PDF, однако фотографии будут выглядеть 
намного лучше.

ИСПОЛЬЗОВАНИЕ ПРОЗРАЧНОСТИ В ДОКУМЕНТАХ PDF
Если вы использовали эффекты прозрачности в 
InDesign или поместили файлы Photoshop с прозрач-
ностью, при создании документов PDF вам придет-
ся выбирать дополнительные параметры. Можно 
создать сведенный документ PDF, а можно создать 
документ PDF с поддержкой прозрачности. Создав 
документ PDF, совместимый с Acrobat 4 (PDF 1,3), 
вам придется выполнить сведение прозрачности са-
мостоятельно. Однако если необходимо сохранить 
прозрачность в документе PDF, то воспользуйтесь 
форматом Acrobat 5 или Acrobat 6 – обе эти версии 
обеспечивают полную поддержку прозрачности. 
Сведение выполняется непосредственно при печа-
ти.
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ВСТАВКА СТРАНИЦ INDESIGN В ФОРМАТЕ PDF В ДРУГИЕ 
ДОКУМЕНТЫ INDESIGN

Если вам необходимо вставить предва-
рительно созданную страницу InDesign 
(например, форму или рекламу) в новый 
документ InDesign, сначала экспортируйте стра-
ницу в формат PDF, воспользовавшись командой 
File⇒Export (Файл⇒Экспорт), а затем размес-
тите полученный документ в новом документе, 
воспользовавшись командой File⇒Place (Файл⇒
Разместить).
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Если вы готовы к серьезным испытани-
ям, если вы готовы сдерживать в себе 
порывы ярости из-за мелких неудач, 
можно приступать к работе с таблица-
ми. Это действительно серьезная тема. 
Умение задавать параметры сложных

СТОЛБЦЫ И ЯЧЕЙКИ
Работа с таблицами

таблиц в InDesign CS, а также запивать цветом отде-
льные ячейки позволит вам принять участие в гораздо 
более сложных и престижных проектах, чем в том 
случае, если бы вы умели только вставлять таблицу из 
Excel. Как вы уже догадались, в настоящей главе мы 
поговорим о настройке параметров таблиц в InDesign 
CS.
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РАЗМЕЩЕНИЕ ГРАФИЧЕСКИХ ИЗОБРАЖЕНИЙ
В ТАБЛИЦЕ

Итак, вы уже научились ис-
пользовать текст в таблицах 
и решили заполнить таблицу 
графикой. Возможно, вам 
необходимо добавить в нее 
сравнительную диаграмму или 
страницу из каталога, на кото-
рой представлены фотографии 
товаров с их описанием. Не-
смотря на то, что в InDesign как 
таковое понятие графической 
ячейки отсутствует, изображе-
ния все же можно вставлять в 
ячейки как внутристрочную графику. Просто при активном инструменте Type (Текст) расположите курсор над 
ячейкой таблицы и выберите Place (Разместить) из меню File (Файл), после чего найдите необходимый графи-
ческий файл. Как только вы разместите изображение, InDesign автоматически создаст для него блок. Кроме 
того, можно копировать (вырезать) блоки из существующих страниц и вставлять в ячейки таблицы. Для этого 
выделите блоки при активном инструменте Type (Текст), выберите команду Edit⇒Cut (Правка⇒Вырезать) 
(или команду Edit⇒Copy (Правка⇒Копировать)), а затем (щелкнув в ячейке таблицы) выполните команду 
Edit⇒Paste (Правка⇒Вставить).

ИСПОЛЬЗОВАНИЕ АЛЬТЕРНАТИВНОЙ ЗАЛИВКИ
Постарайтесь оживить таб-
лицу, используя в ней цвет. 
Однако вместо того, чтобы 
заливать все таблицы одним 
цветом, попробуйте применить 
несколько оттенков. Сначала 
выделите все ячейки таблицы 
при активном инструменте Type 
(Текст). Затем выберите ко-
манду Table⇒Table Options⇒
Alternating Fills (Таблица⇒
Параметры таблицы⇒Альтер-
нативные заливки). В появив-
шемся диалоговом окне Table 
Options (Параметры таблицы) 
укажите подходящий вариант в раскрывающемся списке Alternating Pattern (Альтернативный узор), после чего 
задайте подходящие цвета. (В данном случае мы выбрали вариант Every Other Row (Каждая следующая стро-
ка) при использовании синего и белого).
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ПОВОРОТ НАДПИСЕЙ В ТАБЛИЦЕ
Один из самых эффектных способов 
в работе с таблицей – поворачивание 
текста, что имеет смысл при работе 
с заголовками столбцов. Поместив 
курсор в ячейку, текст в которой 
необходимо повернуть, отобразите 
палитру Table (Таблица) - для это-
го выберите одноименную команду 
из меню Window⇒Type & Tables 
(Окно⇒Текст и таблицы). Теперь 

щелкните на значке “Т”, соответствующем необходимой вам ори-
ентации текста. Имейте в виду, что при этом вам может понадо-
биться увеличить высоту строки.

ЗАЛИВКА ЦВЕТОМ ОТДЕЛЬНЫХ ЯЧЕЕК
Иногда может потребоваться запить отдельную ячейку цветом и дать 
ей название. Альтернативные заливки оказываются кстати далеко не 
всегда. Просто перетащите цвет из палитры Swatches (Образцы) на 
соответствующую ячейку.
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ВЫДЕЛЕНИЕ СТРОК И СТОЛБЦОВ
Одна из наименее очевид-
ных функций InDesign - вы-
деление строк и столбцов. 
Выберите инструмент Type 
(Текст) и разместите его 
у левой границы таблицы 
(или у верхней границы при 
необходимости выделить 
столбец). Как только вы 
увидите стрелку “вправо” 
или “вниз”, щелкните инс-
трументом для выделения 
строки или столбца, на ко-
торый указывает стрелка. 
Для выделения сразу не-
скольких строк или столбцов достаточно щелкнуть и перетащить инструмент.

ВЫДЕЛЕНИЕ ЦЕЛОЙ ТАБЛИЦЫ
Иногда вам может понадо-
биться выделить всю табли-
цу целиком с целью измене-
ния ее параметров. Данный 
совет позволит сделать это 
одним щелчком мыши. Под-
ведите курсор инструмента 
Type (Текст) к верхнему 
левому углу таблицы. Как 
только курсор примет фор-
му диагональной стрелки, 
щелкните, чтобы выделить 
всю таблицу целиком, не-
зависимо от того, как много 
страниц она занимает.
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ИЗМЕНЕНИЕ РАЗМЕРОВ СТРОК И СТОЛБЦОВ
Один из самых быстрых спо-
собов изменить размер строки 
или столбца состоит в следу-
ющем. Выберите инструмент 
Type (Текст) и наведите его 
на линию, разделяющую две 
строки или два столбца. При 
этом курсор примет форму 
двунаправленной стрелки. 
Теперь перетащите его влево 
или вправо для изменения 
размера столбца или вверх 
или вниз для изменения раз-
мера строки.

ДОБАВЛЕНИЕ ВЕРХНИХ И НИЖНИХ КОЛОНТИТУЛОВ
Заголовки над каждым столбцом таблицы позволяют читателю легко 
идентифицировать содержимое того или иного столбца. Однако если 
вы разделили таблицу на несколько частей, даже расположенных 
на одной странице, заголовки не очень-то и помогут. Данный совет 
позволит вам значительно облегчить свою жизнь. При активном инс-
трументе Type (Текст) выделите строку (или даже несколько строк), 
в которой должны отображаться заголовки. Теперь щелкните в таб-
лице правой кнопкой мыши (комбинация <Сontrol+щелчок>), после 
чего из контекстного меню выберите команду Convert to Header Rows 
(Преобразовать в верхний колонтитул). В результате заголовки будут 
отображены над каждой частью таблицы. Настоящий совет применим 
и при работе с нижними строками, однако в данном случае следует 
выбирать команду Convert to Footer Rows (Преобразовать в нижний 
колонтитул).
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РАЗМЕЩЕНИЕ ТАБЛИЦ WORD И EXCEL
Дизайнерам очень нравится 
получать от своих сотрудников 
файл, созданный в Microsoft 
Office. Особенно мы приходим 
в восторг при необходимости 
перенести в настольную изда-
тельскую систему документы 
Microsoft Excel. Действительно, 
в этом нет ничего сложного. 
Выберите команду Place (Раз-
местить) из меню File (Файл), 
после чего в диалоговом окне 
Place (Размещение) выберите 
документ Excel или Word, со-
держащий таблицу, и щелкни-
те на кнопке Open (Открыть). В 
диалоговом окне Import Options 
(Параметры импорта) выбе-
рите необходимые параметры импорта; например, можно указать, должно ли сохраняться форматирование, 
используемое в таблице, или нет. Как только вы щелкнете на кнопке ОК, InDesign автоматически преобразует 
таблицу в собственный формат. После этого вам останется должным образом ее подкорректировать.

ПРЕОБРАЗОВАНИЕ ТЕКСТА В ТАБЛИЦУ
Очень часто приходится работать с текстом, полу-
ченным из базы данных. А поскольку базы данных 
разрабатывались достаточно давно, их тяжело 
отнести к типам документов, дружественным по от-
ношению к пользователю. Как правило, в подобных 
ситуациях вы будете работать с текстом, имеющим 
разделители-табуляции. Однако в этом нет ничего 
страшного. Выделив подобный текст при активном 
инструменте Type (Текст), выберите из меню Table (Таблица) команду Convert Text to Table (Преобразовать 
текст в таблицу). В результате вы получите таблицу, с которой можно выполнить намного больше интересных 
операций, чем при работе с простым необработанным текстом.
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ВЛОЖЕННЫЕ ТАБЛИЦЫ
Иногда создания таблиц и объединения ячеек для достижения необходимого результата оказывается явно 
недостаточно. Поэтому, когда вам в следующий раз потребуется создать сложную таблицу, попробуйте вос-
пользоваться таким советом. В данном случае речь идет о вложенных таблицах. При активном инструменте 
Type (Текст) щелкните в ячейке таблицы, после чего из меню Table (Таблица) выберите команду Insert Table 
(Вставить таблицу). В появившемся диалоговом окне Insert Table (Вставка таблицы) задайте необходимое ко-
личество строк и столбцов.

ОБЪЕДИНЕНИЕ ЭЛЕМЕНТОВ ТАБЛИЦ
Вместо того чтобы пытаться уместить в небольшой ячейке таблицы 
большое изображение или много текста, попробуйте воспользовать-
ся данным советом. При активном инструменте Type (Текст) выде-
лите несколько смежных ячеек, после чего из меню Table (Таблица) 
выберите команду Merge Cells (Объединить ячейки).
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ПРИШЛО ВРЕМЯ РАЗДЕЛЯТЬ ЯЧЕЙКИ
Итак, вам необходимо увеличить количество ячеек в таблице. Так же, 
как ячейки можно объединить, при необходимости их можно и разде-
лить. Выделив несколько ячеек, из меню Table (Таблица) выберите ко-
манду Split Cell Horizontally (Разделить ячейку по горизонтали) или Split 
Cell Vertically (Разделить ячейку по вертикали).

УДАЛЕНИЕ ОБВОДКИ ЯЧЕЕК ТАБЛИЦЫ
После создания таблицы у мно-
гих пользователей возникает 
желание удалить обводку ее 
ячеек. И это оказывается на-
много проще, чем вы могли по-
думать. В InDesign при обводке 
ячеек таблиц используются те 
же элементы управления, что 
и при обводке других объектов. 
Чтобы убрать обводку, выдели-
те соответствующие строки и 
столбцы, после чего в палитре 
Color (Цвет) или Stroke (Обводка) задайте значение None (Нет) для цвета и толщины линии обводки.
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ВСТАВКА СТРОКИ В КОНЦЕ ТАБЛИЦЫ С ПОМОЩЬЮ 
КЛАВИШИ <ТАВ>

Вам необходимо добавить еще одну строку в конце таблицы, потому что кто-то до вас удалил “лишний эле-
мент”? Это элементарно! При активном инструменте Type (Текст) щелкните в последней ячейке таблицы и 
нажмите клавишу <Тab>. В результате к таблице будет добавлена еще одна строка.

ВСТАВКА СТРОК И СТОЛБЦОВ
Создание таблицы, состоящей из восьми строк и четырех стол-
бцов, - это конечно хорошо, но как быть, если к таблице необ-
ходимо добавить еще несколько строк или столбцов? В таком 
случае вам следует воспользоваться данным советом. При 
активном инструменте Type (Текст) щелкните в строке, над или под 
которой необходимо вставить дополнительные строки. Теперь из 
меню Table (Таблица) выберите команду Insert⇒Row (Вставить⇒

Строка). На экране будет отображено диалоговое окно, в котором необходимо задать необходимое ко-
личество строк, а также их положение относительно текущей строки. Данный совет применим также 
и при необходимости вставить столбцы. На этот раз из меню Table (Таблица) следует выбрать команду 
Insert⇒Column (Вставить⇒Столбец).
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ПОРА НАВЕСТИ ПОРЯДОК В ТАБЛИЦЕ!
Вам надоело перетаскивать границы отдельных строк и столбцов и вы 
решили их равномерно распределить? Данный совет позволит вам очень 
быстро навести порядок в таблице. Воспользуйтесь инструментом Type 
(Текст) для выделения строк или столбцов, которые вам необходимо 
равномерно распределить. Теперь из меню Table (Таблица) выберите 
команду Distribute Rows Evenly (Равномерно распределить строки) или 
Distribute Columns Evenly (Равномерно распределить столбцы). Как по 
мановению волшебной палочки, строки и столбцы таблицы будут рав-
номерно распределены.

ВЫРАВНИВАНИЕ ТЕКСТА В ЯЧЕЙКАХ
Изданном этапе вы уже настоящий профессионал по вставке текста в 
ячейки таблицы. Однако как этот текст выровнять? Самое удивительное, 
что вы можете использовать те же методы, что и при работе с обычным 
текстом. Выделите соответствующие ячейки при активном инструменте 
Type (Текст), после чего задайте необходимые значения параметров в 
палитре Control (Управление) или Paragraph (Абзац). Но если вы решили 
разместить текст по центру ячейки таблицы, вам следует обратиться к 
палитре Table (Таблица) (для отображения которой выберите команду 
Window⇒Type & Tables⇒Table (Окно⇒Текст и таблицы⇒Таблица)).
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СОЗДАНИЕ ДИАГОНАЛЬНЫХ ЛИНИЙ
Я не очень понимаю, зачем это нужно, но иногда 
вам может потребоваться разместить в ячейках 
таблицы диагональные линии. Вместо того чтобы 
пытаться рисовать их одну за другой, используй-
те для этого соответствующие функции InDesign 
CS. Выделив необходимые ячейки, выберите 
команду Diagonal Lines (Диагональные линии) из 
меню Table⇒Cell Options (Таблица⇒Параметры 
ячейки). Можно выбрать линию, направленную 
вниз, слева направо, справа налево, а также две 
пересекающиеся диагональные линии. Как восхи-
тительно! Если бы компания Adobe предоставила 
еще и возможность размещать текст под углом, 
вы были бы намного счастливее!

СОЗДАНИЕ НАКЛОННОГО ТЕКСТА
Если вам понадобится разместить надпись под углом, вы будете обескуражены, поскольку в 
чистом виде подобная функция в программе отсутствует. Однако ее можно сымитировать, 
сначала наклонив текст, а затем вставив его в ячейку. С помощью инструмента Type (Текст) 
нарисуйте небольшой текстовый блок, введите в него текст, после чего поверните на необ-
ходимый угол с помощью инструмента Rotate (Поворот). Затем выделите блок с помощью 
инструмента Selection (Выделение) и вырежьте его, нажав комбинацию клавиш <Ctrl+X> 

(<�+Х>). Теперь при активном инструменте Type (Текст) щелкните в необходимой ячейке и вставьте в нее 
надпись, нажав комбинацию клавиш <Ctrl+V> (<�+V>). Данный метод далеко не безупречен, но он работает!
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ЕСЛИ ТЕКСТ НЕ ПОМЕЩАЕТСЯ В ТАБЛИЦЕ
Это просто ужасно! Как же 
быть? Текст не помещается 
в таблице, а никто не хочет 
читать надписи с размером 
шрифта 4 пункта. Однако вы-
ход из подобных ситуаций все 
же есть. И не нужно пытаться 
поместить огромную табли-
цу у нижнего края страницы! 
Разместите ее в подходящем 
месте, после чего сверните 
нижнюю часть блока, щелкнув 
на его нижнем центральном 
маркере. При активном инстру-
менте Selection (Выделение) 
перетаскивайте маркер вверх 
до тех пор, пока таблица не 
уместится на странице. При 
этом у нижнего правого угла 
таблицы должен появиться 
знак “плюс”. Щелкните на этом значке, после чего продолжайте работу с таблицей на следующей странице. В 
результате ваши читатели будут чувствовать себя намного лучше.
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Почему же советы, имеющие отноше-
ние к печати и работе с другими при-
ложениями из состава Creative Suite. 
объединены в одной главе? Вы хотите 
получить уклончивый ответ или правди-
вый? Все очень просто. У нас очень много советов

СТИЛЬНЫЕ ОТПЕЧАТКИ
Печать и Creative Suite

по печати, однако относительно советов, касающихся 
работы с приложениями из состава Creative Suite, к 
сожалению, такого сказать нельзя. Хотя изначально 
мы планировали написать отельную главу «Работа 
с Creative Suite», нам просто не удалось подготовить 
соответствующий материал в достаточном объеме. 
Поэтому нам пришлось добавлять подобные советы 
в главу, посвященную другой теме. Кроме того, под-
готовленные советы очень полезны и заслуживают 
того, чтобы их включили в материал последней главы 
книги. Что тут еще сказать? Вы хотели узнать правду? 
Вы ее узнали. А правда, как известно, далеко не всег-
да оказывается такой приятной, как нам того хотелось 
бы.
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КАК ПРОСТО ПЕЧАТАТЬ НА РАЗНЫХ ПРИНТЕРАХ
Многие пользователи имеют в своем распоряжении несколько принтеров. Каждый принтер, как вы и могли 
предположить, поддерживает какие-то особые параметры печати. Вместо того, чтобы запоминать параметры, 
доступные для того или иного принтера, используйте предварительно сохраненные стандартные установки 
печати. Выберите команду File⇒Print Presets⇒Define (Файл⇒Стандартные установки печати⇒Определить), 
после чего щелкните на кнопке New (Создать) диалогового окна Print Presets (Стандартные установки печати). 
Теперь можно выбрать принтер и задать все необходимые параметры. Укажите для полученного набора па-
раметров подходящее название и щелкните на кнопке ОК. Когда вам потребуется в следующий раз печатать 
на данном принтере, выберите соответствующие установки печати из меню File⇒Print Presets (Файл⇒Стан-
дартные установки печати). На экране появится диалоговое окно Print (Печать), в котором будут заданы все 
необходимые значения параметров – вам останется только щелкнуть на кнопке Print (Печать).
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КАК ПРИ ПЕЧАТИ ИЗБЕЖАТЬ НЕОЖИДАННОСТЕЙ, 
СВЯЗАННЫХ С ЦВЕТОДЕЛЕНИЕМ

Если вы работаете в InDesign над документом, для которого в дальней-
шем планируете выполнять цветоделение, данный совет поможет вам 
оценить результаты, перед тем как вы будете выводить цветоделен-
ные копии на пленку или пластины. Благодаря этому вам удастся из-
бежать неприятных неожиданностей при печати. Выполните команду 
Window⇒Output Preview⇒Separations (Окно⇒Предварительный про-
смотр вывода⇒Цветоделение). Затем выберите значение Separations 
(Цветоделенные копии) из раскрывающегося списка View (Просмотр) 
в верхней части палитры Separations Preview (Предварительный про-
смотр цветоделения). В результате будет отображен список плашек, 
которые используются при печати документа. Просмотрите содержи-
мое отдельных плашек, временно скрывая остальные (для этого до-

статочно щелкнуть на значке в виде глаза напротив названия плашки – точно так же, как вы делаете это при 
работе со слоями в палитре Layers (Слои)).

СКОЛЬКО ПЛАШЕК ВАМ ДЕЙСТВИТЕЛЬНО 
НЕОБХОДИМО?

Следует признать, что иногда мы создаем документы, для печати 
которых используется больше плашек, чем требуется на самом деле. 
Для решения подобных проблем попробуйте воспользоваться данным 
советом. Выберите команду Window⇒Output Preview⇒Separations 
(Окно⇒Предваритпльный просмотр вывода⇒Цветоделение). Затем, 
как и в предыдущем совете, выберите значение Separations (Цветоде-
ленные копии) из раскрывающегося списка View (Просмотр) в верхней 
части палитры Separations Preview (Предварительны и просмотр цвето-
деления). В результате будет отображен список плашек, которые ис-
пользуются при печати документа. Скройте лишние плашки, щелкнув 
на значке глаза напротив их названий.
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ИСПОЛЬЗОВАНИЕ СРЕДСТВА INK MANAGER ДЛЯ 
УДАЛЕНИЯ ЛИШНИХ ПЛАШЕК

Иногда в проекте могут появиться лишние плашки, 
что связано с цветами, используемыми во встав-
ленных изображениях. Очень часто один и тот же 
цвет упоминается под разными названиями. Для 
устранения подобных проблем воспользуйтесь 
средством Ink Manager (Диспетчер красителей). До-
ступ к нему можно получить или из меню палитры 
Separations Preview (Предварительный просмотр 
цветоделения), или же на вкладке Output (Вкладка) 
диалогового окна Print (Печать). Выберите цвет, 
сопоставляемый с другим цветом, который, в свою 
очередь, необходимо выбрать из раскрывающегося 
списка Ink Alias (Подстановочный краситель). В ре-
зультате объекты, для которых указан тот или иной 
цвет, будут размещены на одной плашке, соответствующей подстановочному красителю.

ПРЕДОТВРАЩЕНИЕ НАИБОЛЕЕ РАСПРОСТРАНЕННЫХ 
ПРОБЛЕМ

Прежде чем записывать документы на компакт-диск 
или размещать их на FTP, постарайтесь убедиться 
в отсутствии наиболее распространенных проблем. 
Выберите команду Preflight (Предварительный ана-
лиз) из меню File (Файл), чтобы In Design CS авто-
матически проанализировала документ на предмет 
отсутствующих шрифтов, нарушенных связей, 
отсутствующих шрифтов во вставленных изобра-
жениях, использования лишних плашек, а также 
наличия в документе изображений RGB.
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ИСПОЛЬЗОВАНИЕ КОМАНДЫ PREFLIGHT ДЛЯ 
ВЫЯВЛЕНИЯ ПРОБЛЕМ

Изучая результаты, полученные с помощью коман-
ды Preflight (Предварительный анализ), я обращаю 
внимание только на проблемы! На каждой из вкла-
док диалогового окна Preflight (Предварительный 
анализ) можно увидеть флажок Show Problems 
Only (Показывать только проблемы). Если его ус-
тановить, то на соответствующих вкладках диало-
гового окна Preflight (Предварительный анализ) бу-
дут перечислены только выявленные проблемы.

УПАКОВКА ДОКУМЕНТОВ
Большинство пользователей в последнее вре-
мя активно используют формат PDF, однако 
существует еще немало принтеров, которые 
поддерживают работу только с файлами в собс-
твенном формате. Вы размещаете в документах 
графические изображения, которые хранятся 
на жестком диске, а также используете немало 
шрифтов, но не испытываете ни малейшего же-
лания самостоятельно собирать в одной папке 
все используемые изображения и шрифты. Ре-
шение подобных проблем существует. Выберите 
команду Package (Упаковать) из меню File (Файл). 
При этом также автоматически будет выполнена 
и команда Preflight (Предварительный анализ), 
поэтому вам не потребуется запускать ее вруч-
ную. В результате применения команды Package 
(Упаковать) все графические файлы и шрифты, 
используемые в документе InDesign CS, будут 
сохранены в указанной вами папке. После этого 
можно выполнять с файлами любые действия 
– архивировать, размещать на FTP, записывать 
на компакт-диск и т.д.
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КАК НАПЕЧАТАТЬ НЕПЕЧАТАЕМЫЕ ОБЪЕКТЫ
Итак, вы определили некоторые объекты в доку-
менте как непечатаемые, однако у вас возникла 
необходимость все же вывести их на печать. Вмес-
то того чтобы последовательно изменять атрибуты 
объектов, установите флажок Print Non-Printing 
Objects (Печатать непечатаемые объекты) в группе 
параметров Options (Параметры) диалогового окна 
Print (Печать). Благодаря этому вам не потребуется 
повторно задавать для объектов атрибут “непеча-
таемый”.

ПРОСМОТР ПАРАМЕТРОВ ПЕЧАТИ
Предварительного просмотра печати не существу-
ет, однако кое-чем мы вас порадуем. При необхо-
димости оценить результаты применения текущих 
установок печати щелкните на большой букве “Р” 
в нижнем левом углу диалогового окна Print (Пе-
чать). В результате вместо этой буквы вы увидите 
текущие значение параметров печати.
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КАК БЫСТРО ВЫБРАТЬ ДРУГОЙ ПРИНТЕР
Пользователи Macintosh! Сообщаем вам о том, 
что средство Chooser теперь в Mac OS отсутству-
ет. Однако все не так плохо, поскольку принтеры 
можно выбирать непосредственно в диалоговом 
окне Print (Печать) любого приложения, обладаю-
щего полной поддержкой Mac OS X. В диалоговом 
окне Print (Печать) программы InDesign присутс-
твует параметр, который вы могли не заметить. 
Это раскрывающийся список Print Preset (Стан-
дартные установки печати). Поэтому если вы со-
здали набор установок печати, но вместо него из 
меню File (Файл) выбрали команду Print (Печать), 
необходимые установки можно выбрать и из рас-
крывающегося списка Print Preset (Стандартные 
установки печати).

КАК УСКОРИТЬ ПРОЦЕСС ПЕЧАТИ
При работе в InDesign вы хотите печатать до-
кументы не только качественно, но и быстро, не 
так ли? Для того чтобы ускорить процесс печати, 
перейдите на вкладку Graphics (Графика) диало-
гового окна Print (Печать) и убедитесь в том, что 
из раскрывающегося списка Send Data (Отправка 
данных) выбрано значение Optimized Subsampling 
(Оптимизированная подвыборка). В результате на 
принтер будет отправляться такой объем данных, 
какой он способен обработать. Например, если 
изображение обладает разрешением 1200 dpi, а 
принтер поддерживает только разрешение 600 
dpi, отправка на печать изображения с разреше-
нием 1200 dpi окажется пустой тратой времени.
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ПЕРЕМЕЩЕНИЕ МЕЖДУ ВКЛАДКАМИ
ДИАЛОГОВОГО ОКНА PRINT

В диалоговом окне Print (Печать) доступно не-
сколько вкладок, на которых задаются разные 
параметры печати. Данный совет позволит вам 
перемещаться между вкладками диалогового окна 
Print (Печать) намного быстрее. Для перемещения 
между вкладками диалогового окна Print (Печать) 
достаточно нажать клавиши <↑> и <↓>.

ИЗМЕНЕНИЕ ЛИНИАТУРЫ ПРИ МОНОХРОМНОЙ ПЕЧАТИ
Мало кто может себе позволить четырехцветную 
печать. Многие пользователи до сих пор исполь-
зуют монохромные принтеры. При этом пластины 
создаются на основе отпечатков, полученных с 
помощью лазерного принтера или даже копира. 
Вы имеете возможность изменить линиатуру, 
используемую принтером. Перейдите на вкладку 
Output (Вывод) диалогового окна Print (Печать) и 
из раскрывающегося списка Color (Цвет) выберите 
значение Composite Gray (Композитный серый), а 
из раскрывающегося списка Screening (Растриро-
вание) – значение Custom (Другое). При этом у вас 
появится возможность задать значение парамет-
ров Frequency (Частота), а также Angle (Угол) (в 
большинстве случаев неплохих результатов можно 
достичь при значении 45’).
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ПРОФЕССИОНАЛЬНАЯ ПЕЧАТЬ ЦВЕТОДЕЛЕННЫХ 
КОПИЙ

По умолчанию InDesign печатает цветные доку-
менты в композитном режиме. Если вы имеете в 
своем распоряжении цветной принтер, это именно 
то, что вам необходимо. Однако, если вы печатаете 
на фотонаборном устройстве, вам потребуются от-
дельные пластины для каждого цвета. Перейдите 
на вкладку Output (Вывод) диалогового окна Print 
(Печать) и из раскрывающегося списка Color (Цвет) 
выберите значение Separations (Цветоделенные ко-
пии). В группе параметров Inks (Чернила) можно ак-
тивизировать печать пластин необходимого цвета.

ПЕЧАТЬ РЕГЛЕТОВ
При создании документа в InDesign CS вам предо-
ставляется возможность создания реглета. Как 
правило, данная область используется рекламны-
ми агентствами и дизайнерами для размещения 
сведений о задаче и настройках печати. На вклад-
ке Marks and Bleed (Отметки и обрез) диалогового 
окна Print (Печать) в группе параметров Bleed and 
Slug (Обрез и реглет) установите флажок Include 
Slug Area (Включить область реглета) при печати 
документа. По умолчанию этот флажок сброшен.
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ДОСТУП К ПАРАМЕТРАМ ПРИНТЕРА
К сожалению, в диалоговом окне Print (Печать) про-
граммы InDesign доступны далеко не все парамет-
ры, которые поддерживает ваш принтер. Например, 
наш принтер Tektionix Phaser 850DP поддерживает 
двухстороннюю печать, а соответствующие пара-
метры в диалоговом окне Print (Печать) программы 
InDesign не доступны. Если вы хотите использовать 
все параметры печати, поддерживаемые принте-
ром, щелкните на кнопке Printer (Принтер) в нижней 
части диалогового окна Print (Печать). Это позволит 
получить доступ к настройкам драйвера принтера 
операционной системы, отсутствующим в InDesign.

ЗАГРУЗКА ШРИФТОВ PPD
Вы использовали в документе шрифт Times Roman, 
а при печати получили Courier. С чем же это может 
быть связано? Шрифт Times Roman содержится в 
памяти принтера. Если вы используете встроенные 
шрифты принтера, однако на печать они выводятся 
некорректно, перейдите на вкладку Graphics (Гра-
фика) диалогового окна Print (Печать) (я уверен, 
вы знали, что именно к ней и следует обращаться 
с самого начала). После этого в группе параметров 
Fonts (Шрифты) установите флажок Download 
PPD Fonts (Загружать шрифты PPD). В результате 
InDesign будет загружать даже те шрифты, кото-
рые должны содержаться в памяти принтера.
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МАСШТАБИРОВАНИЕ СТРАНИЦ
Если у вас есть документ, масштаб страниц которо-
го задавался из расчета одних требований, однако 
в конечном итоге вам необходимо выводить его 
на носители (например, листы бумаги) меньшего 
размера, данный совет позволит вам сэкономить 
немало времени. Не пытайтесь изменить масштаб 
всех элементов на странице просто выберите пе-
реключатель Scale To Fit (Масштабировать по раз-
мерам) на вкладке Setup (Параметры) диалогового 
окна Print (Печать).

ЕСЛИ В ТИПОГРАФИИ НЕ ПРИНИМАЮТ ФАЙЛ INDESIGN
Если в типографии не принимают файл InDesign 
(или же его не хочет печатать принтер), попро-
буйте найти выход из подобной ситуации. Данную 
проблему можно решить, преобразовав документ 
в формат PDF. Кроме того, документ постранично 
можно сохранить в формате EPS. Если и в этом 
случае возникнут сложности с типографией, мы 
рекомендуем поискать другого исполнителя ва-
шего заказа.
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ИСПОЛЬЗОВАНИЕ АВТОМАТИЧЕСКОГО ОБНОВЛЕНИЯ
Если компания Adobe предлагает бесплатные об-
новления для InDesign CS, то это означает, что по 
какой-то причине она хочет, чтобы пользователи 
обязательно их установили. Поэтому в программе 
присутствует специальное средство, которое ав-
томатически подключается к Web-узлу компании 
Adobe и проверяет наличие обновлений. Данное 
средство очень удобно, поскольку благодаря ею 
использованию вы регулярно получаете обновле-
ния, исправляющие выявленные ошибки в работе 
приложения. Многим пользователям не нравится, когда программы без их ведома обращаются к Internet. Если 
вы относитесь к данной категории, перейдите на вкладку Updates (Обновления) диалогового окна Preferences 
(Установки), для отображения которого необходимо выбрать одноименную команду из меню Edit (Правка) 
(меню InDesign на платформе Macintosh). В группе параметров Options (Параметры) из раскрывающегося 
списка Check for Updates (Проверять обновления) выберите значение Never (Никогда). После этого проверять 
наличие обновлений на Web-узле компании Adobe вы сможете только вручную.

РАЗМЕЩЕНИЕ ФАЙЛОВ PHOTOSHOP
Несмотря на то, что файлы TIFF все считают при-
емлемым вариантом, однако наиболее удачным 
вариантом их назвать сложно. Ведь наверняка, 
работая над изображением в Photoshop, вы со-
здаете слой. При создании файла TIFF вы, скорее 
всего, используете команду Save As (Сохранить 
как) для сохранения сведенной копии изображения. 
Вместо того, чтобы создавать файлы TIFF, разме-
щайте в документе InDesign файлы в собственном 
формате Photoshop, используя для этого команду 
File=>Place [Файл=>Разместить}. При печати доку-
мента InDesign выполнит сведение изображений 
автоматически.
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РАЗМЕЩЕНИЕ ФАЙЛОВ ILLUSTRATOR
InDesign поддерживает два способа работы с 
файлами Illustrator. Вы можете копировать век-
торные изображения в Illustrator и вставлять их 
в InDesign, а можете размещать файлы Illustrator 
в документе, используя для этого команду 
File⇒Place (Файл⇒Разместить). Преимущество 
копирования и вставки векторных контуров состо-
ит в том, что они автоматически преобразуются 
в контуры InDesign, а значит, их можно редакти-
ровать непосредственно в InDesign. Недостаток 
же состоит в том, что при этом теряется связь с 
исходным файлом Illustrator. Преимущество раз-
мещения файлов Illustrator состоит в том, что при 
этом сохраняются все эффекты и прозрачность, 
используемые в исходном файле Adobe Illustrator. 
Однако внести изменения в изображения непос-
редственно в InDesign будет невозможно.

ИСПОЛЬЗОВАНИЕ СРЕДСТВА FILE BROWSER 
ПРОГРАММЫ PHOTOSHOP

Средство File Browser (Бра-
узер файлов) программы 
Photoshop замечательно под-
ходит для просмотра целых 
папок изображений, однако, 
к огромному сожалению, в 
InDesign средство File Biowser 
(Браузер файлов) отсутству-
ет. В данном случае вы мо-
жете использовать средство 
File Browser (Браузер фай-
лов) программы Photoshop. 
Открыв в окне File Browser 
(Браузер файлов) папку с 
изображениями, которые 
решили использовать в до-
кументе, просто перетащите 

необходимые изображения из окна File Browser (Браузер файлов) на страницу документа InDesign. InDesign 
разместит изображения, автоматически добавит к ним рамки, а также свяжет их с исходными файлами.
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СОВМЕСТНОЕ ИСПОЛЬЗОВАНИЕ НАСТРОЕК ЦВЕТА С 
PHOTOSHOP И ILLUSTRATOR

В InDesign, Photoshop и 
Illustrator используются одни и 
те же установки управления 
цветом. Поэтому если вы 
потратили некоторое время на 
подбор подходящих установок 
в Photoshop, в InDesign их 
также можно использовать. 
Выберите команду Соlоr Set-
tings (Установки цвета) из меню 
Edit (Правка). Обязательно 
установите флажок Enable 
Color Management (Разрешить 
управление цветом). Теперь 
из раскрывающегося списка 
Settings (Настройки) выберите 
предварительно сохраненные 
в Photoshop установки. Если 
вы собственный вариант 
установок цвета не сохраняли, 
убедитесь в том, что во 
всех трех программах задан 
один и тот же наиболее вам 
подходящий вариант.
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РЕДАКТИРОВАНИЕ И АВТОМАТИЧЕСКОЕ ОБНОВЛЕНИЕ 
ГРАФИЧЕСКИХ ИЗОБРАЖЕНИЙ

Если вы работаете со вставленными изображениями, созданными 
в Adobe Photoshop CS или Adobe Illustrator CS (а мы думаем, что так 
оно и есть), их можно редактировать непосредственно в программе, 
для чего достаточно дважды щелкнуть на изображении при нажатой 
клавише <Alt> (<0ption>). В результате изображение будет открыто в 
окне программы, с помощью которой оно было создано (Photoshop или 
Illustrator), после чего в него можно вносить изменения. (Кроме того, 
можно щелкнуть на изображении правой кнопкой мыши (комбинация 
<Соп(го1+щелчок>), а затем из контекстного меню выбрать коман-
ду Graphics ‘=> Edit Original (Изображение ^Изменить оригинал), как 
и показано на рисунке.) После того как вы сохраните изображение и 
вернетесь в InDesign, оно будут автоматически обновлено в документе 
InDesign CS. Удивительно, не так ли?

РАЗМЕЩЕНИЕ ДОКУМЕНТА В WEB
Если к вам с утра подошел начальник и сказал, что брошюра настоль-
ко хороша, что необходимо подготовить ее вариант для размещения в 
Internet, у вас есть два варианта. Документ можно преобразовать в фор-
мат PDF (что в большинстве случаев окажется правильным решением) 
или же в настоящую страницу HTML. Если для создания Web-страниц 
вы используете Adobe GoLive CS, InDesign CS может значительно уп-
ростить преобразование. Выберите команду File⇒Package For GoLive 
(Файл⇒Упаковать для GoLive). Несмотря на то, что InDesign позволяет 
сохранять пакеты в любой папке, предпочтение все же лучше отдавать 
папке InDesignPackages, вложенной в папку с данными узла GoLive CS. 
После того как вы выберете папку для сохранения “пакета”, на экране 
появится диалоговое окно, в котором можно задать параметры сжатия, 
причем отдельно для файлов GIF и JPEG. Щелкните на кнопке Package 
(Упаковать), а затем откройте полученный файл и соответствующие 
изображения в GoLive.
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ИСПОЛЬЗОВАНИЕ СРЕДСТВА VERSION CUE
Для того чтобы средство 
Version Cue стало активным, 
его следует активизировать, 
причем дважды. Вначале его 
необходимо активизировать 
в окне Control Panel (Панель 
управления) Windows (на 
платформе Macintosh это окно 
System Preferences (Системные 
установки)), а затем в каждом 
приложении из состава набора 
Creative Suite на вкладке File 
Handling (Работа с файлами) 
диалогового окна Preferences 
(Установки). Для отображе-
ния этой вкладки необходи-
мо выбрать команду Edit⇒
Preferences⇒File Handling 
(Правка⇒Установки⇒Рабо-
та с файлами) (на платфор-
ме Macintosh это команда 
lnDesign⇒Preferences⇒File 
Handling). Как только средство 
Version Cue будет активизиро-
вано, вы сможете сохранять версии файлов: выберите команду Save As (Сохранить как), после чего щелкните 
на кнопке Version Cue в диалоговом окне Save As (Сохранить как). Сначала вам необходимо создать проект, а 
затем сохранить в нем документ. Если в дальнейшем вам придется использовать в InDesign самую последнюю 
из нескольких версий документов Photoshop, сохраните документ Photoshop как одну из версий в предвари-
тельно созданном проекте. Запустив InDesign CS, разместите документ Photoshop, воспользовавшись коман-
дой File⇒Place (Файл⇒Разместить). Теперь, когда вы будете сохранять в Photoshop новую версию докумен-
та, выбирая команду Save a Version (Сохранить версию) из меню File (Файл), InDesign будет автоматически 
обновлять версию изображения в своем документе.
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